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THE ENCLOSED SOFTWARE PROGRAMS ARE LICENSED BY IVEX TO CUSTOMERS FOR THEIR NON-EXCLUSIVE USE ON A COMPUTER SYSTEM PER THE TERMS SET FORTH BELOW.

DEFINITIONS: "Ivex" shall mean Ivex Design International, Inc., which is the owner of the copyright and author of this program. "Licensee" shall mean the end user of this Ivex Software. This Software Package consists of a disk(s) with copyrighted computer software and copyrighted user guide ("User Guide") from Ivex.

LICENSE: We grant licensee a limited, non-exclusive license (i) to load a copy of the Software from the disk into the memory of a single (one) computer as necessary to use the Program, and (ii) to make one (1) backup or archival copy of the Software for the use with the same computer. The archival copy and original copy of the Software are subject to the restrictions in this Agreement and both must be destroyed if your continued possession or use of the original copy ceases or this Agreement is terminated.

RESTRICTIONS: Licensee may not sub license, rent, lease, sell, pledge or otherwise transfer or distribute the original copy or archival copy of the Program or the User Guide. You agree not to translate, modify, disassemble, decompile, reverse engineer, or create derivative works based on the Software or any portion thereof. Licensee also may not copy the User Guide. The Agreement automatically terminates without notice if any provision of this Agreement is breached by Licensee.

LIMITED WARRANTY: Ivex warrants that it has the right to license the Software to licensee.

Ivex warrants that the media on which the Software is furnished will be free from defects in materials and workmanship under normal use for a period of ninety (90) days from the date of purchase. Ivex's entire liability and your exclusive remedy shall be the replacement of the Software if the media on which the Software is furnished proves to be defective. This warranty is void if the media defect has resulted from accident, abuse, or misapplication.

DISCLAIMER: Except as provided above, the Software is provided "AS IS" without warranty of any kind.

LIMITATION OF LIABILITY: THE ABOVE WARRANTIES ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. NEITHER Ivex, NOR ITS VENDORS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF USE, INTERRUPTION OF BUSINESS, NOR FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND WHETHER UNDER THIS AGREEMENT OR OTHERWISE.

EXPORT: This Software is subject to U.S. Commerce Department export restrictions, and is intended for use in the country into which Ivex sold it. 

TERMINATION: Ivex may terminate this license at any time if licensee is in breach of any of its terms or conditions. Upon termination, licensee will immediately destroy the Software or return all copies of the Software to Ivex along with any copies licensee has made.

APPLICABLE LAWS: This Agreement is governed by the laws of the state of Oregon in the United States of America, including patent and copyright laws. The prevailing party in any action or proceeding brought in connection with an alleged breach of this Agreement shall be awarded reasonable attorneys' fees to be paid by the other party. This Agreement will govern any upgrades, if any, to the program that you receive and contains the entire understanding between the parties and supersedes any proposal or prior agreement regarding the subject matter hereof. 
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This Ivex Users Manual contains detailed reference information about using this product.  

For information on getting started with this product, please refer the separate Getting Started Guide & Tutorial.  The Getting Started Guide contains the following information:

Introduction.

Installation� XE "Installation" � and registration.

Minimum requirements.

How to reach Ivex and technical support� XE "technical support" �.

Getting started using the program.

Tutorial� XE "Tutorial" �.

Netlist information and how to go from schematic to PCB layout.



Registration and Pin Capacity

All Ivex product disks are manufactured with a 100 pin capacity.  Each user is assigned a “personal” registration number.  The user must enter their personal registration number into the program to “enable” the pin capacity� XE "pin capacity" � purchased.  Go to Help | Registration� XE "Registration" � menu in the program and enter your personal registration number, name and company in the space provided.  If you are installing from a CD, the registration process is part of the installation.

Usually the personal registration number is located on the printed manual, the CD jewel case or on the back side of disk number one.  For more detailed instructions, please refer to the Getting Started Guide.



Win32s

WinDraft is a 32 bit application.  If you use WinDraft with Microsoft 3.1 or 3.11 these are 16 bit operating systems, therefore you must use the Microsoft program Win32s in order to run 32 bit software applications such as WinDraft.  You may get Win32s directly from Microsoft, or hundreds of other Web sites including the Ivex Internet Web site.  You must install Win32s before installing WinDraft.

If you are using Microsoft Windows NT or Windows 95, these are 32 bit operating systems, therefore Win32s is NOT necessary to run WinDraft.



Thank you for choosing Ivex.  We hope you enjoy using this product.  Please remember to register your name, address, and e-mail number with Ivex so that we can notify you of news and upgrades.  News bulletins, tips and notices of minor upgrades are sent electronically by e-mail and you may not receive these unless you provide your e-mail address.��Chapter 1:  Using WinDraft

Summary of Objects

Schematics are made up of a variety of objects.  You can include any of the following objects in your schematic designs:

Parts

Wires

Buses

Junctions

Power Objects

Net

Module Port

Text

Sheet symbols

No connect symbols

Title Block

Net Properties

Book Mark

Line

Circle

Box

Following is a brief example and description of each of these objects followed by the menu command used to invoke the command.  For a complete detailed description refer to the Reference chapter in the manual.

Parts

��Parts are graphic objects you place on the schematic worksheet to represent the electronic devices in your design.  WinDraft includes several libraries of parts and a library editor is included to make new parts.

To place a Part on a sheet, use the Place | Part menu command or the icon � on the toolbar.��Wires

��Place Wires on the schematic worksheet to represent connections between objects such as pins of parts and power objects.

To place a Wire on a sheet, use the Place | Wire menu command, or the icon � on the toolbar, and draw the wire from pin to pin.��Buses

��Buses are used to represent an array of signals as a single unit on a worksheet.

To place a Bus on a sheet, use the Place | Bus menu command, or the icon � on the toolbar,  and draw the bus.��Junctions

��Junctions indicate a physical connection between wires.  You may choose among three Junction shapes (Square, Circle and Diamond) and three sizes (small, medium and large).

To place a Junction on a sheet, use the Place | Junction menu command, or the  � icon on the toolbar, and click the left mouse button to place the junction at the desired location.  WinDraft will automatically place a Junction where a wire ends on another wire (not where wires  cross).��Power Objects

��Power Objects indicate a connection to a power source.  WinDraft has several types of Power Objects, such as the circle shown with VCC in the example.

To place a Power Object on a sheet, use the Place | Power menu command, or the icon � on the toolbar, then select the Power type, enter a name, and place the power object using the mouse.��Net Symbol

��Net Symbols are used to indicate a connection to a module port on a hierarchical sub-sheet.  

To place a Net within a Sheet Symbol, use the Place | Net menu command, or the icon � on the toolbar, select the type (input, output, I/O, or unspecified ) and place the net symbol.��Port

��Ports (also called Module Ports) are used within a sheet or across multiple sheets within a project to electrically connect signals between sheets.

To place a Module Port on a sheet, use the Place | Port menu command, or the icon � on the toolbar, select the style type (input, output, I/O, or unspecified ) and place the port symbol.��Text

��Text is used to include information, labels, comments and link commands on the worksheet.  Comment Text is descriptive and is used for general documentation purposes and for Link Statements.  Label Text is used to assign Net Names to a wire or bus.

To place Text on a sheet, use the Place | Text menu command or the icon �  on the toolbar.  Choose the type (Comment or Label), enter the desired text in the text entry box, and place the text using the mouse.��Sheet Symbol

��Sheet Symbols are block-shaped symbols representing a sub-sheet in a hierarchy.  Each sheet symbol represents one subsheet.

To place a Sheet, use the Place | Sheet menu command, name the sheet and place it.

��No Connect Symbol

��No Connect Symbols identify pins on a device that are to be left unconnected. This symbol makes the ERC tool ignore pins with that are not otherwise connected when reporting unconnected pins.

To place a No Connect, use the Place | No Connect menu command, or the icon �  on the floating toolbar, and place the symbol on the end of the desired pin.��Title Block

��A Title Block is used to identify certain kinds of information on your worksheets.  It contains information such as company name and address, drawing title, number, size and revision.

To place a Title Block, use the Place | Title Block menu command, select the desired title block from the available files, and place the Title Block on the worksheet.��Net Properties

��Net Properties places a graphical symbol next to the desired wire and contains the track and via width, isolation, and other characteristics for PCB layout.  Note that the arrow on the NP symbol must touch the wire for the properties to take effect.

To place a Net Properties symbol, use the Place | Net Properties menu command, and place the NP symbol so that the arrow touches the wire that you desire to associate with the net characteristics.��Book Mark

�The Bookmarks set invisible locations on the schematic sheet.  These may be used to Jump to different locations specified by the bookmark.  You may specify five different bookmarks on a sheet. To place a Book Mark, use the Place | Book Mark menu command,��Line

��Lines are placed on the schematic worksheet for drawing purposes.  These may be used for drawing purposes other than electrical connections.

To place a Line on a sheet, use the Place | Line menu command, or the icon � on the toolbar, and draw the line.  Lines may be either dashed or solid.��Circle

��Circles are placed on the schematic worksheet for drawing purposes  and mechanical purposes other than electrical connections.

To place a Circle on a sheet, use the Place | Circle menu command, or the icon � on the toolbar, and draw the Circle.  Circles may be either dashed or solid.��Box

��Boxes are placed on the schematic worksheet for drawing purposes  and mechanical purposes other than electrical connections.

To place a Box on a sheet, use the Place | Box menu command, or the icon � on the toolbar, and draw the box.  Boxes may be either dashed or solid.��Keyboard Commands

Ivex programs use several Keyboard commands (also known as Keyboard Shortcuts) to assist in the use of the programs.  These keyboard commands� XE "Keyboard Commands" � are in addition to the menu, toolbar icons, mouse and Windows Accelerator keys (Alt-keys).

So you have a choice of several ways to implement a command.  The keyboard commands are designed to help speed the use of the design process.  A complete list of these commands is in Appendix A.  Following, are some important Keyboard Commands that are used throughout the program:



( (�The Cursor arrow keys are used to Rotate objects such as parts.  When an object is selected, or before placement just press the arrow keys. ��+ -�The plus and minus keys are found on the Ten-Key pad.  These are used to increase or decrease the size (or number) of various objects such as parts, junctions, or the number of wires.��x�The “X” key is used extensively on all Ivex products to “Toggle” through a variety of style selections. 

For Drawing objects, wires, and buses use the X key to toggle geometry: 45(�xe "45"�, 90(�xe "90"�, arc�xe "arc"�, and any angle�xe "any angle"�.  Also, toggles through styles for:  Junctions�xe "Junctions"�, Module Port�xe "Module Port"�, Net type�xe "Net type"�, and Part type�xe "Part type"�.��(�Use the Tab key to selected the desired single object.  Continually pressing the Tab key will toggle through all of the selected items.  For more information, refer to the use of the Tab key in Chapter 3:  Editing (Selecting individual objects from a group).��

(

(�Like all Windows applications, Ivex programs have menu and toolbar icons to change the View� XE "View" \t "See Zoom" � or Zoom level.   However, no CAD or drawing program is complete without hotkeys to Zoom in and Zoom out.  

Use the Home key to Zoom� XE "Zoom" � in�xe "Zoom in"� with the current pointer location as the center of the screen.

Use the End key to Zoom out�xe "Zoom in"� with the current pointer location as the center of the screen.��(�NOTE: Choose Help | Shortcuts from the main menu for a dialog box listing the keyboard commands.  Remember, Appendix A lists all of the keyboard shortcut keys.  This can also be found in the on-line help.  ��The Design Process

WinDraft is a schematic design tool.  This “drafting” tool is analogous to familiar tools such as a drafting board, pencil, sheets of paper, standard logic symbols and templates.  It is designed to support the complete design process from concepts to the final sets of detailed diagrams.

The computer screen represents the drafting table.  The pointer used with the cursor keys or mouse does what a pencil does.  WinDraft calls the sheets of paper on which the schematics are drawn worksheets.  Worksheets appear on the computer screen as a rectangular area in which you can place parts and draw wires.

The Save command stores the information on the computer’s disk as a data file, using the worksheet name as the file name.  If you have a printer, worksheets may be printed onto actual paper and scaled to fit the paper size using the Print command.

Design Structures

Some designs are small enough to be represented entirely on a single schematic worksheet.  WinDraft’s sheet size correspond to the five standard sheet sizes for printers:  A through E for Imperial, and A4 through A0 for Metric.  You can also customize each of the page sizes in the Setup dialog box.

Larger designs may not fit on a single sheet of paper, and even if it could there may be good reasons for dividing it up:

To organize the design by functional parts.

To develop using a top-down approach.

Multiple sheet designs may be handled by two methods:

Flat designs.

Hierarchical designs.

Flat Designs�xe "Flat Designs"�

This process is well suited for small to medium sized designs.  The flat-file process connects the output signals laterally from one sheet to the input signals of another.

�EMBED CorelDRAW.Graphic.6���

Figure 1-1: Flat File Design Structure.

Flat designs are linked together by adding a brief text notation to the main schematic of the design.  The main sheet of the design is the schematic that has the same name as the design.  For example:  main sheet A is named PROJECT.SCH and sheet B is OTHER.SCH.  The link statement format uses the form:

&Proj:   <flatsheet1>, <flatsheet2>, etc.

therefore to link the two sheets mentioned above the link statement is:

&Proj:   other.sch

Notice that the main sheet is not named in the link statement, only the names of the sheets it is linked to.  The comment text for the above link statement may be placed anywhere on the main sheet using the internal font. 

A Module Port is used to connect the electrical signals from one sheet to another.  Module Ports that have identical names on both sheets are considered electrically connected.

�      �

Figure 1-2: Module Port used to connect two sheets.

In the example above, the output module port Clock in the main sheet Project.sch connects to the input module port Clock in Other.sch.

Hierarchical Designs

Instead of using a flat design, you can draw schematics that contain symbols representing other schematics.  These symbols are called sheet symbols.  The layered arrangement created by placing schematics inside other schematics is called a hierarchy.

The sheet the top of a hierarchy, which directly or indirectly references all other sheets in the design, is called the root sheet.  In the following example, Sheet A is the root sheet, sheets B to E are sub-sheets:

�EMBED CorelDRAW.Graphic.6���

Figure 1-3: Hierarchical Design Structure.



A sheet symbol represents a subsheet in a hierarchy�xe "hierarchy"�. Each sheet symbol contains net connectors that connect signals between the sheets in the hierarchy.  Any schematic sheet may contain sheet symbols that reference other sub-sheets.  A sheet symbol is placed in the schematic using the Place | Sheet command.



Just as signals are conducted between sheets through module ports in a flat file design, they are conducted into and out of sheet symbols through sheet nets in a hierarchy.  These are the small shapes shown on the borders of the sheet symbols.  A sheet net is placed using the Place | Net command.

The sheet nets on a sheet symbol correspond to module ports on the associated sub-sheet.  To associate a particular sheet net with a particular module port, give them the same name.

Signals may not be connected between sheets that are peers in a hierarchy.  Connections may only be made between a child sheet and its’ parent.  To connect a signal between sheets “D” and “E”, first make a connection from sheet “D” to “C” and then from “C” to “E”.

�

Figure 1-4: Two Sheet symbols connected with sheet nets.

The bracketed notation shown on the module ports and nets designates the number of signals being carried by a bus.  So [0..31] indicates 32 signals, 0 through 31.  The same notation is on the actual bus indicating the signals the bus carries.

At the top of the sheet symbol is the description of the subsheet.  The name at the bottom of the sheet symbol represents the filename of the subsheet.  

To open a subsheet, select File | Open Subsheet and then click on the Sheet Symbol in the schematic, or double-click on the subsheet symbol and click on the Open button in the dialog box.

For more information and examples on hierarchy, please refer to Chapter 5:  Hierarchy.

�Chapter 2:  Schematic Editor Reference�xe "Using Schematic Editor"�

This chapter describes the WinDraft schematic editor menus and toolbar buttons. Menus are listed in the order they display when WinDraft is running. Menu commands are organized in order which they appear in WinDraft Menu.  Descriptions of the toolbar buttons are organized alphabetically.

Menus

WinDraft Schematic editor uses eight pull-down menus: File, Edit, Place, Tools, Utilities, Properties, Window and Help. This section explains how each menu works.

File�xe "File menu"�

��When you are opening a single schematic file, File contains the menu selections shown in the file pull-down menu at left.

New is used to open a new sheet, library, or title block.  ��To start a new schematic, follow these steps:�xe "New schematic file"�

1.	Click with the left mouse button on the File menu.  The File pull-down menu displays.

2.	Click on New.  The New dialog box displays.

3.	Click on the Sheet radio button to create a new sheet file.

�

		       Figure 2-1: The New dialog box.

4.	Click in the Name text entry box and enter the name of the new sheet filename. The filename is limited to twenty-one characters (use a maximum of eight characters for Windows 3.1)�xe "file name limitations"�. Use the three character file extension ".SCH"�xe ".SCH extension"� for all WinDraft sheet files.  You may also leave the name entry box blank and enter the filename later when you save the file.

5.	Select OK to close the dialog box and open the new sheet.

To create a new library, follow these steps:�xe "New library file"�

1.	Click with the left mouse button on the File menu.  The File pull-down menu displays.

2.	Click on New.  The New dialog box displays.

3.	Click on the Library radio button to create a new library.

4.	Click in the Name text entry box and enter the name of the new library filename. 

5.	Select OK to close the dialog box and open the library editor.  For more information on using the Library Editor, please refer to Chapter 6.

To create a new title block, follow these steps:�xe "New title block file"�

1.	Click with the left mouse button on the File menu.  The File pull-down menu displays.

2.	Click on New.  The New dialog box displays.

3.	Click on the Title Block radio button to create a new Title Block.

4.	Click in the Name text entry box and enter the name of the new Title Block. 

5.	Select OK to close the dialog box and open the Title Block editor.  For more information on Title blocks, please refer to Chapter 7.

��When you already have at least one sheet (window) open, the File menu contains the menu selections shown in the File pull-down menu at left.  

Use Load to open an existing sheet, library, or title block.

To load an existing schematic, follow these steps:

Click with the left mouse button on the File menu. The File pull-down menu displays.��2.	Click on Load. The Open File dialog box displays.

�

Figure 2-2: The File to Open dialog box.

3.	Select Schematic (*.SCH) in the List Files of Type list box: all the schematic file names display in the Filename list box. 

4.	Select a schematic filename.

5.	Click on OK with the left mouse button to load the schematic file.



(�NOTE: To load a library select *.clb in the list of files. For information on using the library editor refer to Chapter 6.   To load a Title block select *.tbl in the list of files.  For information on editing Title Blocks refer to Chapter 7.

��Open Subsheet�xe "Open Subsheet"�

This command is available only if sheet symbol is represented in the currently selected schematic. Use this command to view a schematic represented by a sheet symbol in a hierarchical design. Select Open Subsheet and click on a sheet symbol of a the schematic nested inside the one you are working on.  For more information on hierarchy and subsheets, please refer to Chapters 1 and 5.

(�NOTE: If only ONE sheet symbol is represented in your schematic design, the Open Subsheet selection automatically opens the nested schematic.��Save�xe "Save"� 

Select Save to save the current WinDraft schematic, library, or title block.  Save works similarly to the save option in other Windows-based applications.

Save As�xe "Save As"�

Select Save As to give the current WinDraft schematic, library, or title block file a new name while saving it. Save As works similarly to the Save As option in other Windows-based applications.

Print�xe "Print"�

��WinDraft uses the standard printer and plotter drivers available for Windows. Unless you specify otherwise, WinDraft prints to the currently selected printer:��1.	Select Print from the File menu. The Print Options dialog box opens as shown  below:



�

Figure 2-3: The Print Options dialog box.



The Print Options dialog box is used for selecting what to print or plot.

��Select All to print all objects.����Select None to clear all object selections.��

¨	Check any object you want to print by activating the check box associated with the item.  Each type of object that is checked will then be printed.  

¨	Click on any item in the Fields list box you want to print. The selected items are highlighted.  In the example above, the Part Reference and Part Value associated with each part on the schematic will be printed, but it will not print the Module Name (for PCB layout) associated with each part because it has not been selected.

Specify the print or plot scale in the Scale entry box. WinDraft printing and plotting default scale is 1.00�xe "Printing, scale"�, this will print at a 1 to 1 scale.  A setting of 0.80 would print at 80 percent of full scale.

Use the Auto Fit check box to automatically fit the design to the paper size.  This selection will gray out the Scale and X, Y offset buttons so they are deactivated.

¨	Use the X Offset and Y Offset boxes to adjust the margins on the printed sheet.  Each 1000 entered into the appropriate Offset entry box will adjust the printer margin by 1/10 inches.  Therefore, to move the X margin 1 inch to the right, enter 10000 into the X Offset entry box.  Enter negative numbers to shift the margins left or upward.

¨	Activate the Descend Hierarchy�xe "Descend into Hierarchy"� check box to print all the subsheets associated with the main current design sheet.

(�NOTE: The print options are saved in the Ivex.ini configuration file when you change them.����Select Setup to change printers and control printing options on the selected printer. These options are handled similarly to other Windows based applications.����Click on OK to accept the changes in the Print Options dialog box and start the printing.��Print Preview

Use Print Preview to view the current window on the selected paper size.

Save All

Use Save All to save all open sheets.  This is useful when you are working on a hierarchical design with several sheets open.

Close All

Use Close All to close all open sheets. This is useful when you are working on a hierarchical design with several sheets open and you want to close all the sheets.

Exit�xe "Exit"�

The Exit command quits WinDraft similarly to other Windows-based applications.

Most Recently Used Files�xe "Most Recently Used Files"� List

The files listed at the end of the File menu represent the most recently used files. This list provides quick access to recently used files without requiring the user to navigate through a set of menus and dialog boxes to specify the location of the files. The maximum number of files in the list is five.



Example:  If the last sheet you work on is named mysheet.sch it will be at the top of the MRI list in the File menu.



Before				After

New��New��Load��Load��Save Config��Save Config��Exit��Exit��sheet1.sch��mysheet.sch��sheet2.sch��sheet1.sch��sheet3.sch��sheet2.sch����sheet3.sch��

Edit�xe "Edit menu"�

��Edit contains the menu selections in the Edit pull-down menu shown at left.

To cut or copy all objects, select the objects and click with the left mouse button on one of the Edit menu commands.  You may also use the Windows hot keys identified in the menu:  Ctrl  X to Cut, Ctrl C to Copy and Ctrl V to Paste.  For more details on editing and selecting objects, refer to Chapter 3: Editing Features.��Undo�xe "Undo"�

��The Undo command is used to cancel the last operation. For example, you can use Undo to undelete objects or undo moves.��Cut�xe "Cut"�

��To cut or delete an object, follow these steps:�xe "Delete an object"�

Click with the left mouse button on the object to be deleted.  The object should become highlighted. ��2.	Select the Edit | Cut command. The selected object is deleted.

Objects can be deleted in three  ways :

by clicking on the object with the left mouse button and selecting the Cut command or DEL Key�xe "DEL Key"�.

by surrounding an object or a group of objects with a block (marquee), then selecting the Cut command or click on the DEL key. 

by clicking an object while holding down the Ctrl key�xe "Ctrl key"�. This enables you to select more than one object at a time. Then use  the Cut command or the DEL key to delete all the chosen objects. 

Copy�xe "Copy"�

��To copy an object, follow these steps :

 ��1.	Select the object.

2.	Click on the Copy button with the left mouse button.

Objects can be copied in three ways :�xe "Copying an object"�

by clicking on the object with the left mouse button and selecting the Copy command.

by surrounding an object or a group of object with a block (marquee), then selecting the Copy command.

by clicking an object while holding down the Ctrl key�xe "Ctrl key"�. This enables you to select more than one object at the time. Then select the Copy command to copy all the chosen objects. 

Paste�xe "Paste"�

��To paste, an �xe "Pasting an object"�object must have already been copied to the clipboard with the Cut or Copy command.  Follow these steps to paste:

1.��1.	Select Edit | Paste or click on the Paste button shown above. The objects are highlighted with the hand cursor on the objects.

2.	To drag the objects, move the cursor to the new location. The objects will drag with the cursor as you move it. 

3.	Click on the left mouse button to place the object(s). 

Select All

Use Select All to select all items on the window.  This can be used to easily select an entire worksheet without drawing a Windows marquee box.

Find�xe "Find"�

��Locates a string of text characters anywhere in a sheet and places the cursor at the object containing the search string.  To find a string of text characters, follow these steps :��1.	Select Edit | Find or click on the Find button shown above. The Find Text dialog box displays.

		�

	  Figure 2-4: The Find Text dialog box.

2.	Type the string of characters in the Text to Search entry box. 

¨	The string of text can be case-sensitive if the Case Sensitive check box is selected in the Find Text dialog box.

¨	Use Wildcards Allowed search for a string of text.  The wildcards ("*", "?") are allowed. A wildcard may be used to replace any character in the string.

If you enter a "?" it will replace one character, and if you enter a "*" it will replace a string of characters.  For example: enter *C51 to find anything that ends with C51, enter ?C51 to find anything that has one character before the C51 string.  

The "?" may be used more than once, each use will replace one character.  For example use ?0?51 to find 80C51.

3.	Click on Find to jump to the object containing the matched characters string.

If the character string exists more than once in the sheet : 

��click on the right arrow button (Next�xe "Next"�) to jump to the next string found.����click in the left arrow button (Previous�xe "Previous"�) to return to the previous string found.��Jump�xe "Jump"�

This command quickly moves the cursor to a specific location on the sheet. The location can be the origin�xe "origin"� (left top corner) of the sheet, bookmarks or (X,Y) coordinates.�xe "Origin, jump to"��xe "Bookmark, jump to"��xe "Coordinates, jump to"�

In the Edit menu, select Jump.

¨	Select Origin to jump to point (0,0). The origin is located on the left top corner of the sheet.

¨	Select XY Pos to jump to a specific coordinate.  The following dialog box opens:

			�

			  Figure 2-5: The Jump XY Position  box.

1.	Enter the X coordinate in the X Position entry box and the Y coordinate in the Y Position entry box. 

2.	Click on Jump. The cursor jumps to the specific location.

3.	Select one of the A,B,C... bookmarks to jump to the specified bookmark on the sheet. The bookmark must have been previously set with the Book Mark command.

Place�xe "Place menu"�

��Place contains the menu selections shown in the Place pull-down menu at left.

After you click OK in any tool dialog box, WinDraft enters autopan mode.  This means that the view on the screen pans as you move the pointer.  To stop panning while in the autopan mode, hold down the Ctrl key or deselect autopan in the Setup | Misc. dialog box.

To escape from the Place mode, press Esc or click the right mouse button once.��Part�xe "Part"��xe "Placing parts"�

�  ��The Place Part and Part Palette� XE "Part Palette" � commands is used to retrieve parts from a selected library in the database, and to place them on the sheet.  Place Part is available from the icon shown at left, or the Place | Part menu. To place a part on  a sheet, follow these steps :��

� EMBED CorelDRAW.Graphic.6  ����CAUTION: Before you place an object on the worksheet, be sure that the Displacement Grid is set to Pin.  The Grid selection is located on the second toolbar.  The program will automatically snap-to-pin and make an electrical connection when wiring to parts that are On Grid.    It may be difficult to connect to off grid parts and the program will not snap-to-pin unless the Grid is set to Pin. ��Load Part

1.	Select Part from the Place menu or click on the Part button located on the toolbar and the floating tools menu. The Load Part dialog box displays. 

�

Figure 2-6: The Load Part dialog box.

The Part dialog box contains two tabs:  Load Part and Part Palette.  Click on Load Part.

Select the library in the Libraries list box. All the parts stored in this library display in the Parts list box

Click on the chosen part in the Parts list box. The part will display in the view box.

Click on OK to place the part on the sheet. The main screen displays.  

Point on the desired location for the part, and click on the left mouse button to place the part.  Continue to place the same part as many times as needed by clicking the mouse at the desired location.

After placing the part, click on the right mouse button (or press Esc.) to exit the part placement mode.



Part Placement and Rotation

Before  placing a part on the screen, you can rotate, mirror or scale the part.  While the part is still attached to the cursor, but before you click to place it, just use the arrow keys to rotate or mirror the part as follows:

( (�Rotate� XE "Part:Rotate" � the part by hitting the right arrow or left arrow key on the keyboard.��( (�Mirror� XE "Part:Mirror" � the part by hitting the up arrow (Mirror -X axis) and down arrow (Mirror -Y axis).��+ -�Scale� XE "Part:Scale" � the part by pressing the + key on the 10 key pad to increase the size, or press the - key to decrease the size. The part has five levels of scale.��� EMBED CorelDRAW.Graphic.6  ����CAUTION: Scaling parts will make some or all pins on a part go “off grid”.  This makes it very difficult to make an electrical connection between a wire and a pin.  It is recommended that you do not use the scale function if you intend to use the schematic to create a netlist.��

Libraries

The Libraries section of the Load Part dialog box lists all libraries in the directory.  The default directory path is c:\ivex\windraft\library.  To change the directory, enter the Properties | Setup dialog box and select File Locations.  Enter the path for the libraries in the area marked Current Library Path.  WinDraft will store several library directory paths in this dialog box, so it is easy to store different libraries in different directories for various projects.  Only one library sub directory can be active at any given time.



Part

Once a library has been selected in the Libraries list box, the parts associated with the library will display in the area marked Parts.  Use the scroll bars to scroll through the various parts in the library.  Click on a part to view it in the view box.

DeMorgan Equivalent

When a library is selected and displays in the view box, click DeMorgan Equivalent to change to the DeMorgan� XE "Part:DeMorgan" � conversion.  Not all parts have a DeMorgan Equivalent.  For example, try the TTL1 library and select a 7400, notice the part converts each time you click the DeMorgan Equivalent box.

�

	Figure 2-7:  Normal TTL 7400 left, DeMorgan equivalent on the right.

Visible Power

Use Visible Power�xe "Visable Power"� to show the power pins on the part. Check the Visible Power� XE "Part:Visable Power" � box to display the power pins, de-select the box so that the power pins do not display.  On the following example, the 7400 on the left displays the power pins, the one on the right has the power turned off

�

	Figure 2-8:  Visible Power on the left 7400, power turned off on the right.





Find Part and Search

Use the Find Part� XE "Part:Find Part" �� XE "Part:Search" �� XE "Part:Wildcards" � to search for a desired part or series of parts.  Wildcards may be used to assist or help sort by categories of parts.  The following table lists the available search wildcards:



Wildcard�Purpose��*�Enter a "*" to replace a string of characters. For example:  enter 74* to find a string of all parts starting with “74” such as a 7400.��?�Enter a "?" to replace one character. For example: enter ?C51 to find anything that has one character before the C51 string.

The "?" may be use more than once, each use will replace one character.  For example use ?0?51 to find 80C51.��Use the Search button to initiate the search process.  For example:

Enter the part name in the Find Part entry box and click on the Search button.  You can use the wildcards�xe "wildcards"� ("*" and "?") to replace any character(s) in the search part name.

WinDraft will search the existing libraries in the selected path.  When the part or parts are found, they will be listed in the Parts list box.  The name of the library will be listed in the Library column and the associated part will be in the Parts column.



Editing a placed part

The power pins may be turned on or off for display purposes after the part has been placed by double clicking on the part, and selecting  Visible Power in the dialog box.

(�NOTE:  Power pins that are turned off  still count as pins on the part.  In the example of the 7400 above, the part has 5 pins whether the power is visible or not.��Refer to the Editing� XE "Part:editing" � section for an example of the Edit Part dialog box.



Part Palette

Press the Part Palette tab in the Part dialog box to configure the parts palette� XE "Part:palette" �.  The palette is used to store frequently used parts so they can be easily selected while you are working on a sheet.

�

			Figure 2-9:  The Part Palette dialog box

The Part Palette dialog box works similar to the Load Part dialog box, except after selecting the desired part you Add it to a Palette that contains a list of up to 20 frequently used parts.

Add a part

In the Part Palette dialog box, click on a library such as Device.  The parts associated with the selected library are displayed in the Parts list box.

Click on a part in the Parts list box.  It is displayed in the view box.

Click the Add button.  This adds the selected part to the Part Palette.

Repeat the above process to add more parts to the palate. 

Delete a part

Parts in the palette can be removed by using the Delete button.

In the Part Palette dialog box, click on a part to remove in the Part Palette list box.

Click the Delete button to remove the part from the list.

Repeat the above process to remove more parts from the palette.

DeMorgan Equivalent

To use the DeMorgan equivalent of a part, check this box before adding the part to the Part Palette.  

Part Palette list

The Part Palette list box contains three columns.  These indicate the Library, the Part name, and the DeMorgan conversion status.  The “C” indicates the part is converted to its DeMorgan equivalent.  An “N” indicates the part is shown in the Normal view.

Sort�The Sort arrows are used to arrange the parts in the palette.  Select the part in the Parts Palette list and press the appropriate button to move the part up or down in the list.  The table below indicates the sort procedure:



Sort Button�Description����Press the Up arrow to move the selected part in the palette up one position.  Continue to press the up arrow until the part is at the desired position.  It will stop when the part is at the top of the parts list.����Press the Down arrow to move the selected part in the palette down one position.  Continue to press the down arrow until the part is at the desired position.  It will stop at the bottom of the parts list.��Use the OK button to save the selections in the Load Part and Part Palette dialog box.

Use Cancel to exit the dialog box without making changes.

Use Help to initiate on-line help for the topic.

Using the Part Palette

��To use the Part Palette, press the Toolbar button shown at left, or select the menu item Properties | Palette on/off.��When the palette is selected, it displays on the right side of the WinDraft screen. The palette consists of several boxes, the actual number will depend on screen resolution you have selected.  A typical 1024 X 768 resolution should display six boxes.  Each box displays a graphical representation of a part with a text description below it as in the following example:

�

	Figure 2-10:  WinDraft screen with Part Palette.



To use the palette you must first have a schematic worksheet open.  Then follow these steps:

Click in one of the boxes with the desired part, this will select the part.

Move the cursor to the desired area on the sheet and click to place the part.  Each time you click another part will be placed on the sheet.

Click on another box to select another part.  Use the scroll bar next to the palette to scroll through other parts in the palette.

Click the right mouse button or press the Esc. key to stop placing parts.

Wire�xe "Wire"�

��The Wire command is used to place electrical wire connections on the schematic.  The wires represent electrical connections between parts.  To place a wire, follow these steps:��Select Pin Grid in the Displacement Grid� XE "Wire:grid" � selector on the secondary toolbar.

Select Wire in the Place menu or click on the Wire icon shown above.

Place the cursor at the location you want the wire to begin.  Click on the left mouse button. 

Move the cursor to where you want the next vertex, then click on the left mouse button. 

Continue placing the wire as in the above step until you come to the location where you want the wire to end. 

Click once on the right mouse button to stop placing the current wire.



+ -�Hotkeys� XE "Wire:Hotkeys" �� XE "Wire:Multi-wire" �:  To place multi-wires�xe "mutli-wires"� hit the +  or - keys while in the wiring mode.�xe "+ key"��xe "- key"����EMBED Paint.Picture  \* MERGEFORMAT \s����WinDraft remains in the Wiring Mode�xe "Wiring Mode"� (as displayed on the Status Bar) so you can continue wiring.  When placing a wire, the cursor will have a white W above an Arrow.  When in the wire mode but not placing a wire, the cursor will have a black W in a box above an Arrow.    See examples at left.

To exit Wiring Mode, press on Esc or click on the right mouse button.��������Before placing  wires, you can change the wire geometry� XE "Wire:geometry" � by selecting Geometry�xe "Geometry"� from the Place menu, or by pressing the Geometry icon shown at left.  The shape inside the icon will change to correspond to the chosen style.  Notice the four style shapes for this one icon.��x�Hotkeys: Use the X key�xe "X key"� at any time while you place wires to toggle between: 45 Degree, 90 Degree, Arc, and Any Angle..�xe "+ key"��xe "- key"���Multiwire Function

When in the Place | Wire mode, each time you press the + key WinDraft will add a wire.  This allows you to draw multiple wires at one time.  Press the - key to decrease the number of wires.

When using the Multiwire function, use the left and right cursor arrow keys to change angle so that the wires line up properly according to the orientation of the device to which you are connecting (see examples below).   Make sure that you are wiring at 90 degrees.

�

Example 1 : Start the wire on the top pin and press the + key to add a wire for the other pins in the sequence.





�

Example 2 : The added wires in  Example 1 do not align and connect to the pins.  Press the right and left arrow keys on the keyboard to properly align the wires so that they all connect as seen in above.

Target Mode

Use the WinDraft Target Mode�xe "Target Mode"� to connect distant objects, such as ones on the opposite side of the schematic worksheet.  Target Mode� XE "Wire:Target Mode" � works like a ratsnest for PCB layout, it creates a guide to follow from the start to the final ending point.

To use Target Mode follow these steps:

Select Place | Wire to enter the wire mode.

Click once on the first object.

Move the mouse to the pin on the second object that you want to connect to and press the M key to enter Target Mode, see Target example 1.

Return the wiring cursor to the originating pin and start placing wire segments.  Each time you click on the left mouse button you create a new vertex in the wire.

Follow the Target guide wire back to the second object placing wire segments in the desired location, see Target example 2.

When you have returned to the ending pin, click to place the final wire segment and end the Target Mode, see Target example 3.

�

Target example 1: Establish Target Mode beginning and ending points. 



�

Target example 2: Return to starting point and place wire segments.  Notice the non-orthogonal Target Guide wire from the wire segment to the ending pin.

�

Target example 3: Ending the wire segment on the destination pin.

Repeat Mode

�Use the Repeat mode� XE "Wire:Repeat mode" ��xe "Repeat mode"� to duplicate wires.  This is useful for repetitive bus entries or for repeating wires from a large part.  Draw the first wire segment and press the Esc key once, while still in the wire mode press the R key.  Each time the R key is pressed, another wire segment of the same length is added on the next pin grid.��r ��Hotkeys:  Use the R key on the keyboard to Repeat.

Also use the Repeat Icon (shown at left) on the floating icon menu.��

�  �

Figure 2-11: The Repeat Mode used to add several wires to a part.

Again Mode

Use the Again mode� XE "Wire:Again mode" ��xe "Again mode"� to duplicate wires at the point of the cursor.  This is useful to repeat wires with the exact same length on a device with inconsistent pin spacing.

�EMBED CorelDRAW.Graphic.6���

Figure 2-12: The Again Command used to add wires to a part

In the example above, notice that the pins are not all spaced at the same distance.  Draw the first wire at the desired length and press the Esc key once.  While still in the wire mode move the cursor to the next pin location to place the next wire and then press the A key.  This will place a wire segment the exact same length as the previous segment starting at the cursor location.

a�Hotkeys:  Use the A key on the keyboard for the Again command.��Electrical Connections

To make electrical connections� XE "Wire:electrical connections" ��xe "electrical connections"� to a wire, see the sections relating to Place | Text, Place | Module Port, and Place | Net.

Bus�xe "Bus"�

�

�The Bus command is used to place a graphical Bus on the current schematic.  The Bus line is used to represent a collection of signals on the schematic.  To place a Bus, follow these steps:��1.	Select Bus in the Place menu or click on the Bus icon shown above.

2.	Place the cursor at the location you want the bus to begin. Click on the left mouse button. 

3.	Move the cursor to where you want the next vertex, then click on the left mouse button. 

4.	Continue placing the bus as in the above step until you come to the location where you want the bus to end. 

5.	Click once on the right mouse button to stop placing the current bus.



��WinDraft remains in the Bus Drawing mode�xe "Bus Drawing Mode"� (as displayed on the Status Bar) so you can continue drawing.  When placing a bus, the cursor will have a white B above an Arrow.  When in the bus mode, not placing a bus the cursor will have a black B in a box above an Arrow.    See examples at left.



To exit Bus drawing mode, press Esc or click the right mouse button.���

Figure 2-13 : Bus with wire entries.

������Before placing  a bus, you can change the geometry by selecting Geometry�xe "Geometry"� from the Place menu, or by pressing the Geometry icon shown at left.  The shape inside the icon will change to correspond to the chosen style.  Notice the four style shapes for this one icon.��x�Hotkeys: Use the X key�xe "X key"� at any time while you place a bus to toggle between: 45 Degree, 90 Degree, Arc, Any Angle.�xe "+ key"��xe "- key"����Junction�xe "Junction"�

��Many wires and busses on the schematic can cross each other. Junctions are placed on a schematic to distinguish a connection from a cross-over.  To place a Junction, follow these steps:��(�NOTE: If you don't place a junction at an intersection of wires, the ERC and Create Netlist tools interpret the intersection as a cross-over with no electrical connection.��1.	Select Place | Junction.

2.	Use the +,- keys �xe "+ key"��xe "- key"�to scale the junction size (Small, Medium and Large) and the x key�xe "x key"� to change its style (Circle, Square or Diamond).

3.	Position the cursor where you want the junction to be placed.

4.	Click on the left mouse button to place the junction.

WinDraft remains in the Place Junction Mode�xe "Place Junction Mode"� until you press Esc key or you click the right mouse button.

j�Hotkey: During wire placement, you can press the J  key�xe "J key"� to place a junction at a wire end position. ��Set the default junction styles and sizes using the Properties | Setup | Drawing parameters.  Refer to Properties Menu section in this chapter.

Junction examples

Following are examples of proper and improper junctions:

�

Example 1: The wire on the left is a correct junction that makes an electrical connection.  In the example on the right, the wires DO NOT make an electrical connection.

�

Example 2: Do Not place a junction to connect a wire to a pin, or a wire to a bus.  In the example above, both junctions are incorrect.  A wire will connect automatically to a pin placed on-grid, and wires are connected to a bus using a label.

Power�xe "Power"�

��Power symbols are used to tie signals or pins to a power or a ground net.  To place a Power symbol on a sheet, follow these steps:��1.	Select Power in the Place menu or click on the Power icon as shown above. The Add/Edit Power dialog box displays.

�

Figure 2-14: The Add/Edit Power dialog box.

2.	Enter the power name (net name) in the Power Name entry box.  When the Power Name On check box is activated, the power name will display next to the power symbol placed on the sheet.

3.	Select the power style in the Power Style list box :

�xe "Styles, power"�

Circle�Arrow�Bar�Wave����������������Gnd (1)�Gnd (2)�Earth�Big Ar. (arrow)�����������

(�NOTE: The power object style is only a graphical representation, and does not influence the ERC or the Create Netlist tools. ��4.	Select the power orientation in the Orientation list box.�xe "Orientation, power"�

5.	Click on the Add button.  Position the cursor at the location you want the power to be placed and click on the left mouse button. You can place a power as many times as needed.

6.	Click on the right mouse button to return to the Add/Edit Power dialog box. 

7.	Click on Cancel to terminate.



 �EMBED Word.Picture.8����To place a GND symbol, click on the GND button�xe "GND button"�.  This button is only in the floating icon menu.  When you place this symbol, the net to which it is connected will automatically receive the name GND.��Sheet Net�xe "Net"�

��A Sheet Net�xe "Sheet Net"� is used to connect wires or buses in subsheets.  To place a Sheet Net, follow these steps:��(�NOTE: A sheet net can only be placed in a subsheet symbol.  Refer to the Place | Sheet command for the subsheet creation.��1.	Select Net from the Place menu.

2.	Enter the net name in the Net Name entry box.  See Appendix E for valid netname characters.

�

Figure 2-15: The Add/Edit Net dialog box.

3.	Select the net style in the Net Style list box : �xe "Styles, net"�



Input�Bidir.�Output�Unspec���(bi-directional)��(unspecified)�����������

4.	Click on the Add button. Position the cursor on a subsheet in which you want the net to be placed. If necessary, use the x key�xe "x key"� to toggle through net styles. Click on the left mouse button, position the net on the perimeter of the Sheet Symbol and click on the left mouse button to place.

	You can place a net as many time as needed and it will automatically increment in value (input1, input2, input3, etc.). The net can only be placed on the left or right border of the sheet.

5.	Click on the right mouse button to return to the Add/Edit Net dialog box. 

6.	Click on Cancel to terminate.

Sheet Nets specifically connect to module ports on the corresponding sub-sheet.  In the following example, two sub-sheets are connected.  Notice the Sheet Net inside the sheet symbol with a name that corresponds to the bus label connecting the sub-sheet CPU to another sub-sheet called Memory.  The net name must also match up to a corresponding Module Port inside the sub-sheet.  

�

Figure 2-16:  Connecting two subsheets with Sheet Nets.



For more information on hierarchy, please refer to Chapter 1 and Chapter 5.

Port�xe "Port"��xe "Connections across sheet boundries"�

�

�Ports (also called Module Ports) are used within a sheet or across multiple sheets within a project to electrically interconnect signals, including wires and buses.  To place a Module Port on the current sheet, follow these steps:��1.	Select Port from the Place menu or click on the Port toolbar button shown above. The Add/Edit Port dialog box displays.

�

Figure 2-17: The Add/Edit Port dialog box

2.	Enter the name of the Port in the Port Name�xe "Name, port"� entry box. 

3.	Select the port style in the Port Style�xe "Style, port"� list box :



�Left�Right��Input������input/output

 (bi-directional)������Output������Unspecified������

Unspecified must be used to transfer isolated power from one sheet to another, or "don't care" signals. 

4.	Select the orientation in the Orientation�xe "Orientation, port"� pull-down list box:

5.	Click on the Add button. Position the cursor on the location you want the port to be placed inside a sheet.  If necessary, use the x key�xe "x key"� to toggle through port styles. Use the Click on the left mouse button. You can place a port as many times as needed.

6.	Click on the right mouse button to return to the Add/Edit Port dialog box. 

7.	Click on Cancel to terminate.

�

Figure 2-18 : Input Ports connecting to a bus in a sheet..

(�NOTE: All ports and labels with the same name are considered to be electrically connected. Signals remaining internal to the sheet should use labels and NOT module ports.

Ports and labels carrying the same name are electrically connected even though they are not physically connected on the sheet.

Text inside the port is automatically centered.

��Text�xe "Text"�

��Text is used to include information, labels, comments and link commands on the worksheet.  To place Text on a sheet, follow these steps:��1.	Select Place | Text. The Add/Edit Text dialog box displays.

�

Figure 2-19: The Add/Edit Text dialog box.

2.	Enter the string of characters in the Text entry box. 

3.	Click on Add and position the pointer on the desired location and click on the left mouse button.  Use the Auto Inc.�xe "Auto Inc."� option to automatically increment numbers such as when using text as labels (A0,A1,A2, etc.).

4.	You can place the same text as many times as needed. Click on the right mouse button to exit the text placement. 

Click on Cancel to exit the Add/Edit Text dialog box.

Type�xe "Text:Type"�

Choose either Comment Text or Label Text.

Use Comment�xe "Text:Comment"��xe "Comments"� text to place a comment or link statement on your worksheet.  Comment text has no impact on the design or netlist.  It is present only for the benefit of explanation.  Link statements are used to link multiple sheets together in a flat file arrangement (non-hierarchical).

To process and link a flat design�xe "flat design"�, the main sheet�xe "root sheet"� (first sheet) must contain a link statement�xe "link statement"� followed by the names of all the sheets connected to the root sheet. 

The link statement should be in the form of :

   &Proj:   <flatsheet1>, <flatsheet2>, <flatsheet3>, etc.

&Proj:�xe "Project"� followed by 3 spaces, begins the link statement and <flatsheet> is the name of the sheet file to be linked.  Place the link statement anywhere in the root sheet all in one line and use the internal font.  The name of the main sheet should not be included .

(�NOTE: The netlister accepts the link command ONLY if all the schematic flatsheets do not contain hierarchy. You can not mix flat designs and hierarchies.��A Label�xe "Text:Label"� is used to give a wire a name so that it can be identified in the netlist.  This allows the net  can to be recognized for PCB layout.  This is also used as an identifier placed on a schematic that connects signals together without actually drawing the wires connecting them.  See Physical Connectors in Chapter 4 for an example.

Text Options�xe "Text:settings"�

You can set the horizontal and vertical sizes of the Internal Font text using X Size and Y Size entry boxes.

Select the orientation of the text by clicking on the corresponding Orientation arrow button, or by pressing the left or right arrow keys on the keyboard while placing the text.�xe "Text:Orientation"�

The text can be X or Y mirrored by selecting either or both of these options :

¨	X Mirror 

¨	Y Mirror

The text can be enclosed in a rectangular frame. Click on the Boxed check box before clicking on Add.�xe "Text:Boxed"�

If the Auto Inc.�xe "Auto Inc."� (Increment) option is active, the numeric suffix of the next text is automatically incremented or decremented on the schematic. The numeric suffix is changed by the amount (positive or negative) specified in the label increment�xe "label increment"� entry box in the Properties | Setup | Drawing dialog box. 

If the Auto Scale option is selected, the text can be sized directly during its placement on the sheet. In that case, you do not need to enter the X and Y sizes.  To use Auto Scale, you must also check the box marked Internal Font.  Auto Scale will not work  with True Type Fonts.�xe "Text:Auto scale"�

1.	Enter the text in the Text entry box.

2.	Select Auto Scale and Internal Font, then click on Add to close the dialog box.

3.	Position the pointer on the desired location and click the left mouse button to anchor the text. Move the mouse up or down to change the Y size, move right or left to change the X size. Click the right mouse and reposition the text. Click twice on the left mouse button to place the text.



(�NOTE: If the text is declared as a Label and in order for ERC and Create Netlist to associate internal and bus labels with wires and buses, you must place labels in contact with the wires or buses.

Each label has a "hot point" which is located at the lower left point of the left-most character. To establish contact between the label and the wire or bus, the "hot point" must be placed on the wire or bus.��Font�xe "Font"�

To place True Type Fonts� XE "Text:True Type Fonts" ��xe "True Type Fonts"�, follow these instructions :

Press the Text icon, this opens the Text dialog box.

Enter the text in the Text entry box.

Make sure the Internal Font box is not checked.

Press the Font button, this opens the Font dialog box as follows :

�

		Figure 2-20: The Font dialog box.

Select the desired font, style and size then press OK.

Press the Add button, then place the text.

Placing labels correctly

In order for the Electrical Rules Check and Netlist Report to associate labels with wires and buses, you must place the label in contact with the wire or bus.  The lower left point of the leftmost character is the Hotpoint of a label.  The  Hotpoint must be on the wire or bus to establish contact.  The labels, wires and buses should also all be placed on the pin grid.

The following examples show the location of the label’s Hotpoint and examples of correct and incorrect label positions:

�

Figure 2-21: The Label’s Hotpoint, indicated by arrow.



�

Figure 2-22 : Correct label positions.



�

Figure 2-23 : Incorrect label positions.

In the example above, most of the label Hotpoints do not touch the wire, therefore no contact is established.  A potentially dangerous situation is indicated by the arrow:  The label’s Hotpoint actually makes contact with two separate wires that are not intended to be connected, therefore both wires will be assigned the same net name mistakenly creating a connection between them.

Repeat command

Use the Repeat�xe "Repeat"��xe "Text:Repeat"� command to automatically increment and repeat multiple labels.  Set the Label Increment in the Properties | Setup | Drawing dialog box in the area marked Repeat Increments.  

r�Hotkeys: Use the R  key�xe "X key"� to repeat.�xe "+ key"��xe "- key"���In the example below:

Place the first wire from pin 1 to the bus.

Press the R key 9 times to repeat the wire on all remaining pins.

Place the label text Add1 on the first wire.

Press the R key 9 times to repeat and increment the label on all 10 wires.

�

Figure 2-24 : Use the Repeat command for wires and labels.

Sheet Symbol

�Sheet Symbols�xe "Sheets Symbols"� are used on hierarchical designs.  Each sheet symbol represents a subsheet in a hierarchy. Each subsheet contains net connectors that connect signals between a sheet and its subsheets in the hierarchy�xe "hierarchy"�. 

Net connectors work the same way as Port works on a flat file design. ��How to place a sheet on the current schematic :�xe "Subsheet, placing"�

1.	Select Sheet from the Place menu. The Add/Edit dialog box displays. 

�

Figure 2-25: The Add/Edit Sheet dialog box.

2.	Enter a description name for the sub-sheet in the Sheet Name entry box.

3.	Enter the filename of the sheet represented by the sheet symbol.  This is the file name in which the sheet will be saved.  Use the Browse button to open the Windows File Selector.

4.	Click on Add. Position the cursor on the location you want the sheet symbol to be placed.  Click once on the left mouse button, re-size the sheet symbol by dragging the border in a selected direction then click the left mouse button.

�

Figure 2-26: The Sheet Symbol.

Press the Open SubSheet button to automatically open the selected subsheet for editing.  This is possible only if the subsheet already exists.

In the example above, the name of the sub-sheet is rs232.sch.  Nets are identified by the Net Symbols within the Sheet Symbol and are connected to wires and a bus connecting to the sheet symbol.

No Connect�xe "No Connect"�

��The No Connect "X" symbol identifies a pin on a device that is to be left intentionally unconnected. This symbol makes the ERC and Netlist Output Utilities ignore pins with No Connect symbols.��How to place a No Connect symbol on the schematic:�xe "No Connect, placing"�

1.	Select No Connect from the Place menu or click on the No Connect button shown above located in the floating toolbar. The "X" symbol is attached to the cursor. Position the symbol on the end of a desired device pin and click on the left mouse button. You can place as many "X" symbols as needed.

2.	Click on the right mouse button to terminate the session. 



(�NOTE: Place the No Connect symbol on pins only. No Connect should NOT be placed on buses, ports, power, bus entries or sheet nets.���

Figure 2-27:  Correct No Connect symbol on the left, Incorrect placement on the right.

Title Block�xe "Title Block"�

To place an existing title block created with the WinDraft Title Block editor, follow these following steps :�xe "Title Block:placing"�

Select Title Block from the Place menu. The Windows File Selector dialog box displays.

Select the Title Block file (.TBL) and click on OK.�xe ".TBL extension"�

Position the cursor on the desired location (usually at the right bottom side of the sheet) then click on the left mouse button.

(�NOTE: Only one title block can be placed on each sheet.��Refer to the Chapter 7: Title Block Editor on how to create a title block.



How to edit a title block:�xe "Title Block:editing"�

1.	Double click on a text Control placeholder on the title block.

2.	The Set Title Block Info dialog box opens.

	�

      Figure 2-28: The Set Title Block Info dialog box.

3.	Select the Control placeholder you want to modify from the Controls list.

4.	Type the new control value in the Control Value entry box.

5.	Click on OK to accept the changes.

The title block controls can be replaced automatically by loading comma separated, double quote delimited  ASCII file. Refer to the Appendix for more information on the title block ASCII file syntax.

How to load an ASCII text file inside the title block:�xe "Title Block:Load ASCII text"�

1.	Double click on any of the Title Block placeholders.

2.	The Set Title Block Info dialog box opens.

3.	Click on GET ASCII button, then select the ASCII file and click on OK.

All the Control placeholders in the title block will be changed to the values given in the delimited ASCII file.

How to generate a standard delimited ASCII file:�xe "Title Block:Save ASCII text"�

1.	Double click on any of the control item.

2.	The Set Title Block Info dialog box opens.

3.	Click on Save ASCII button, then type or select the ASCII file name and click on OK.

The Title Block control data is saved into an ASCII file.

Net Properties�xe "Net Properties"�

Some PCB layout programs such as WinBoard PCB Layout accept Net Property information directly from the schematic if it is entered.

Use Net Properties to enter track and via width, isolation, and other characteristics for PCB layout.  Select Net Properties in the Place pop down menu to open the dialog box shown below :

�

	Figure 2-29: The Add/Edit Net Properties dialog box.



Use Track Width�xe "Track Width"� to enter the width to use in PCB layout.

Use Isolation�xe "Isolation"� to enter the spacing distance to use for tracks to other tracks, pads or copper pours.

Use Via Size�xe "Via Size"� to enter the via diameter.

Use Via Drill Size to enter the drill diameter to use for vias.

Use Allowed Layers to select the layer pairs to route on.

Use Net Type�xe "Net Type"� to choose Tree or Chain.

The default measurement unit is mils.  You may specify another by entering mil, mm, or um after the numeric value for Track Width, Isolation, Via Size and Via Drill Size.  For example, enter 2mm in the Track Width entry box to specify a track width of 2 millimeters in the PCB layout.

How to use Net Properties :

Select Place | Net Properties.

Enter the values in the space provided.

Press Add, a small box marked "NP" with an arrow attached will appear as shown below :

�

Figure 5-30: The NP symbol.  The one on the left is incorrect.  The two on the right are correctly placed.

Place the arrow so that it touches the desired net (wire) as shown in the example (the two on the right are correct).  Do not touch two separate wires as shown by the NP symbol on the left in the above example.

Continue placing the "NP" box on nets with similar characteristics.  Click on the right mouse button or press Esc. to quit placing Net Properties.



To edit the Net Properties box, double click with the left mouse button.  This will open the dialog box.  Enter the desired characteristics in the dialog box and press Add to enter the changes.

Book Mark�xe "Book Mark"�

�The bookmarks set locations on the schematic that you want to remember. You may specify up to five different bookmarks on a sheet. ��How to set a book mark:�xe "Book Mark:placing"�

1.	Select Book Mark from the Place menu. The cascading bookmarks menu displays.

2.	Select one of the bookmarks from the list. Position the cursor to the desired location and click on the left mouse button to place the bookmark. The Set BookMark Name dialog box displays.

3.	To change the name of the bookmark, enter a string of character in the Bookmark Name entry box. Then click on OK to close the dialog box.�xe "Book Mark:change name"�

4.	Use the Jump command from the Edit menu when you want to jump to this bookmark location.�xe "Book Mark:jump to"� 

Select Clear from the Book Mark command to reset all the defined bookmarks.

Line�xe "Line"�

��This command is used to place a Line.  Refer to Place | Wire for line drawing instructions. This is used for drawing and has no electrical properties, therefore it will not make an electrical connection.

Use Line to draw geometric shapes which can be used for adding graphical reference information to a schematic, such as mechanical symbols.��Circle�xe "Circle"�

��This command is used to place a Circle.  Refer to Place Geometric Symbol below for instructions on drawing a circle. This is used for drawing and has no electrical properties.

Use Circle to draw geometric shapes which can be used for adding graphical reference information to a schematic, such as mechanical symbols.��Box�xe "Box"�

��This command is used to place a Box.  This is used for drawing and has no electrical properties.

Use Box to draw geometric shapes which can be used for adding graphical reference information to a schematic, such as mechanical symbols.��How to place a geometric symbol:�xe "Placing a geometric symbol"�

1.	Click on the icon (circle or box) with the left mouse button.

2.	Choose Dashed or Solid from the pop-down menu.

3.	Position the cursor on the location you want to place the symbol.

4.	Click on the left mouse button and hold it down while dragging the mouse to define the shape.

5.	Click again on the left mouse button to terminate it. While remaining in the Drawing Mode, you can place as many symbols as needed.

6.	Click on the right mouse button to leave the drawing session.



Image� XE "Image" �

Use the Place Image command to import a BMP graphic� XE "BMP graphic" � image onto your WinDraft worksheet.  Selecting the Image command will open a standard Windows Open File dialog box.  In this dialog box, select the BMP file name to import and press OK.  The BMP image is then placed on the sheet.  

To resize the image, click on the image to select it.  When the image is selected, you will see handles at each edge and corner.  Use these to drag the image and resize it.

To move the image, click on the image to select it.  Place the cursor within the image and it will look like a hand.  Hold down the left mouse button and drag the image to the desired location.

Geometry�xe "Geometry"�

������WinDraft has four Geometry styles to choose from:  45 degree, 90 degree, Arc, or Any angle.

Before placing  wires, buses, or lines you can change the geometry by selecting Geometry�xe "Geometry"� from the Place menu, or by pressing the Geometry icon shown at left.  The shape inside the icon will change to correspond to the chosen style.  Notice the four style shapes for this one icon.��x�Hotkeys: Use the X key�xe "X key"� at any time while you place wires, buses, or lines to toggle between: 45 Degree, 90 Degree, Arc, Any Angle.�xe "+ key"��xe "- key"����Style�xe "Style"��xe "Title Block:setting the style"��xe "Style:setting in title block"�

Before placing a  line, arc or circle drawing, you can change the style by selecting Style from the Place menu, then choosing one of these options :

¨	Dashed

¨	Solid

Tools�xe "Tools menu"�

�EMBED HJPRO  \* MERGEFORMAT \s����Tools contains the menu selection shown in the Tools pull-down menu shown at left.

WinDraft Tools menu includes the three following processors :��¨	The Annotate function is a processor that scans a design with all its subsheets and automatically updates the reference designators of all parts on the sheet.

¨	Back Annotate updates part reference designators in the schematic provided in a text file that lists old and new references.

¨	The Cleanup processor scans the current sheet and checks for wires, buses, junctions and other objects that are placed on top of each others and removes the overlaps.

Annotate�xe "Annotate"�

The Annotate function is a processor that scans a design with all its subsheets and automatically updates the reference designators of all parts on the sheet.  Annotate also updates all the pin numbers of the parts that have multiple devices in the package. Annotate can unconditionally overwrite all current references, or it can be used to increment the references that have not yet been annotated (those reference designators that still contain a "?"). 

� 

Figure 5-31: Before Annotation.

�

Figure 5-32: After Annotation.

The annotation should be executed before outputting a netlist, the ERC or the BOM report.  When you click on Annotate, the Annotate dialog box displays :



(�NOTE:  You must save a new sheet before running Annotate.  ��

�

Figure 5-33: The Annotate dialog box.

¨	Output File. Specifies the new sheet file name. If the output file name is not specified, the current sheet is annotated and automatically updated on the disk.

(�NOTE: If Descend into Hierarchy is selected, all the schematic subsheets will be referenced and overwritten automatically on the disk, even if the new file name has been specified in the Output File entry box.��¨	Search. Opens the file selection.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

¨	Descend Hierarchy�xe "Descend Hierarchy"�. References the current worksheet and its associated subsheets.  If un-selected, the Annotate processor references all the parts of the current sheet ONLY.   Refer to the Index for topics about Hierarchy and Flat Files.	

(�NOTE: Annotate accepts the link command ONLY if all the schematic flatsheets do not contain hierarchy. Flat files and hierarchy can not be mixed.��¨	Keep Device�xe "Keep Device"�. If selected, the Annotate WILL NOT update the corresponding pin numbers of a part with multiple devices in the package.�xe "Annotate:without update"�

¨	Unconditional. This option reannotates all parts, even if they have been previously annotated.�xe "Annotate:unconditional"� 

(�NOTE: The assigned parts of the multiple devices in a single package are updated if Keep Device is not selected.��If un-selected, all references are updated on the sheet.

¨	Fields Combine�xe "Fields Combine"�. The attributes� XE "Annotate:using attributes" � are used to group parts in devices that have multiple parts per package. If the parts have empty attribute fields and matching part values, Annotate assigns parts to the same package. If the parts have value in their attribute fields, Annotate assigns parts to the same package if the attributes match. 

	For more information, see the examples in Using Fields Combine, later in this section.

To run Annotate, save and close all sheets except the main sheet, only the main sheet should be open.  Configure the selections in the Annotate dialog box and click on Execute to launch the annotation process. During execution, WinDraft generates a log file that contains all the process steps. Restore this file to check if WinDraft has generated any warning or error messages during the process.

Using Fields Combine

��In the example below, nothing is selected in the Fields combine box. Although each of the NAND gates are 7400s, they are not all in the same type of package, due to physical or mechanical design requirements.��

�����

Running Annotate without combining the Module Name with the Part Value will result in an undesirable configuration of the components—you obviously cannot combine gates from a 14DIP300 with gates from a 14SOP150 into the same physical package, since they are mechanically different.

�      �

		14DIP300			14SOP150





��When the Part Value is combined with the ModuleName, the Annotator can correctly package parts together so that gates that are of the same type (i.e. 14SOP150 vs. 14DIP300) can be grouped with similar gates.�����������

This technique is also applicable to other attribute fields that are associated with parts on the schematic. Another application might be to add a tolerance attribute to multiple-parts-per-package resistors to combine similar resistors together into a physical package .

Back Annotate�xe "Back Annotate"�

Back Annotate updates part reference designators in the schematic provided in a text file that lists old and new references. This file can be created with a text editor, or generated by a layout program. This file must be defined before the execution of Back Annotate, and its default extension is .BAN.�xe ".BAN extension"�

When you select Back Annotate, the BackAnnotate dialog box displays :

�

Figure 2-34: The BackAnnotate dialog box.

¨	Output File. Specifies the new schematic file name. If the output file name is not specified, the current sheet is back-annotated and automatically updated on the disk.

¨	Search. Opens the file selection.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

¨	Descend Hierarchy�xe "Descend Hierarchy"�. Processes the current worksheet and its associated subsheets. If unselected, Back Annotate processes ONLY the current root sheet.  Refer to the Index for topics about Hierarchy and Flat Files.

(�NOTE: The Back Annotate accepts the link command ONLY if all the schematic flatsheets do not contain hierarchy. ��Click on Execute. The BackAnnotate File dialog box displays. Select or enter the .BAN text file. During execution, WinDraft generates a log file that contains all the process steps. Restore this file to check if WinDraft has generated any warning or error messages during the process.

Cleanup�xe "Cleanup"�

The Cleanup processor scans the current sheet and checks for wires, buses, junctions and other objects that are placed on top of each others and removes the overlaps. Cleanup removes bus and wire segments overlapping part pins�xe "overlapping part pins"�, module ports and power symbols.

(�NOTE: Use Cleanup anytime you are executing any of WinDraft Utilities to reduce errors and warnings.

Cleanup MUST be used prior to netlist execution.��Click on Cleanup in the Utilities menu to removes duplicates overlapping objects.  See also: Auto Cleanup in the Setup | Misc. dialog box.

Cleanup also removes ERC warning flags.

Utilities�xe "Utilities menu"�

��Utilities contains the menu selections shown in the Utilities pull-down menu at left.



WinDraft Utilities menu includes the eight following processors :��¨	The BOM (Bill of Materials) creates a summary list of all parts used in the design.

¨	The Netlist Output command is used to generate a netlist file.

¨	The ERC processor checks the design for conformity to basic electrical rules.

¨  The Statistics dialog box.  This contains statistics for all open sheets.

¨	The Archive Library scans the complete design and generates a single binary library file containing all the parts used in the design.

¨	Converters converts the OrCAD/SDT 16 or 32 bit binary schematic files.

¨	The Decompile Sheet decompiles the WinDraft binary file sheet into the equivalent ASCII file.

¨	The Compile Sheet compiles a WinDraft format ASCII file sheet into the equivalent binary file.

 

BOM�xe "BOM"�

The BOM (Bill of Material�xe "Bill of Material"�) creates a summary list of all parts used in the schematic.

When you select BOM, the Bill of Material dialog box displays :

�

Figure 2-35: The Bill of Material dialog box.

¨	Output File. Specifies the ASCII file name containing a summary of all parts used in the design.  If the output file name is not specified, the default BOM file name is <current sheet name>.BOM.

¨	Merge File.  Select a file to merge with BOM.  The merge file can contain additional information that you would like to have in your Bill of Materials.  This may be used to merge a stock number into the BOM list.  The merge file uses the Part Value to match the text in the merge file with the parts in the part list.  

	For more information, see the Using the Merge File later in this section.�xe ".BOM extension"�

¨	Search. Use to open the file selection for Output and Merge File.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

¨	Descend Hierarchy�xe "Descend Hierarchy"�. Processes the current worksheet and its associated subsheets. If unselected, BOM processes ONLY the current sheet. Refer to the Index for topics about Hierarchy and Flat Files.

¨	Page Width and Page Height.  Select the width and height (character and lines) of your report to match the format of your printer.

(�NOTE: The BOM accepts the link command ONLY if all the schematic flatsheets do not contain hierarchy. ��Click on Execute. During execution, WinDraft generates a log file and an ASCII BOM file. The log file contains all the process steps. Restore this file to check if WinDraft has generated any warning or error messages during the process.

Using the Merge File

Turn on the Use Merge File� XE "BOM:using Merge File" � option to append information from a text file to the Bill of Materials (BOM). The “merge file” is a simple ASCII database containing only a part value (with which to look up parts found on the schematic) and a line of extra information to append to the BOM report. Matches are made between the contents of the “Part Value” field of parts on the schematic and entries in the merge file.

�

PARTINFO.ASC

‘Merge File’�‘User Supplied Information’��‘2N3904’�‘NPN Transistor from eng. dept’��‘2N3906’�‘PNP Transistor from eng. dept’��‘4k7’�‘4.7k 5% Resistor’��‘5k1’�‘5.1k 5% Resistor’��‘10k’	�‘10.0k 5% Resistor’��	     Example of an appropriate “merge file”



Without “Use Merge File” activated, the BOM report would contain only the reference designators and the part values:



  Item     Qty  References                         Value  

----------------------------------------------------------

     1       1  R1                                   10k  

     2       1  Q1                                2N3904



With “Use Merge File” activated, the BOM report would include the information contained in the “Merge File”. Note that the data field of the first line in the merge file will be placed on the title line in the BOM report. This allows you to put some descriptive information� XE "BOM:descriptive information" � about each part into the report, as well as a title at the top of the page.



  Item     Qty  References    Value      User Supplied Information

---------------------------------------------------------------------

     1       1  R1            10k    	   10.0k 5% Resistor

     2       1  Q1            2N3904     NPN Transis. from eng. dept

Fields Combine

Fields Combine allows you to combine the Part Value with one or more attribute fields� XE "BOM:attribute fields" � when deciding how to group parts in the BOM report. For instance, if the schematic contains multiple resistors, each having the same value, they would ordinarily all appear on the same line of the BOM report. However, in practice, you may need a combination of large and small resistors to properly complete the design.

�

�

With no fields chosen to combine with the “Part Value”, parts will be grouped in the BOM report by only the part’s value:



  Item     Qty  References                         Value  

----------------------------------------------------------

     1       5  R1,R2,R3,R4,R5                       10k



�

If you specify that you want to combine the “ModuleName” with the “Part Value”, the BOM report will create a separate line for each unique combination of “Part Value” and “ModuleName”:



  Item     Qty  References                         Value  ModuleName  

----------------------------------------------------------------------

     1       2  R4,R5                                10k       R1206  

     2       3  R1,R2,R3                             10k        RC05



Netlist Output�xe "Netlist Output"�

The Netlist Output command is used to generate a netlist file in the format listed in the dialog box. The netlist file is used to go to WinBoard PCB Layout and exchange information with third party tools, with their own proprietary input format. The netlist file includes description of parts combined with pin connections that define each net. 

To generate other netlist outputs, refer to Appendix D: Netlist Converters.  This has information on how to convert WinBoard netlists into other formats.

(�NOTE: The Annotate and the ERC processors should be executed before starting the netlister.

All parts should be annotated to complete the netlist process. An error message displays if the sheet has not been properly annotated.��The WinDraft netlister automatically runs an Electrical Rules Check (ERC) on the current sheet before generating the netlist.

When you click on Netlist Output, the Netlist Formatter�xe "Netlist Formatter"� dialog box displays :

�

Figure 2-36: The Netlist Output dialog box.

¨	Output File. Specifies the new netlist ASCII file name. If the output file name is not specified, the default netlist file name is <current sheet name>.NET.�xe ".NET extension"�

¨	Search. Opens the file selection.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

¨	Descend Hierarchy�xe "Descend Hierarchy"�. Processes the current worksheet and its associated subsheets.  If unselected, the netlister processes ONLY the current sheet. Refer to the Index for topics about Hierarchy and Flat Files.

(�NOTE: The netlister accepts the link command ONLY if all the schematic flatsheets do not contain hierarchy. ��¨	Format. The netlist database is translated and formatted for use by other tools. Choose the needed netlist format by clicking in the Format list box.�xe "Netlist format"�

¨	Module. Adds the module footprint (package) or other selected attribute content in the netlist ASCII file. To select a module, click on the arrow to open the pull-down menu.  Select the desired attribute name from the pull down menu.  Refer to Properties | Setup | Attribute Names later in this chapter for more information on how to enter an attribute field.

Click on Execute to run the netlister. During execution, WinDraft generates a log file and an ASCII netlist file. 

The log file contains all the process steps. Restore this file to check if WinDraft has generated any warning or error messages during the process.

ERC�xe "ERC"��xe "Electrical Rules Check"�

�The ERC (Electrical Rules Check ) processor checks the design for conformity to basic electrical rules. ERC scans the design and checks the sheets for unused inputs and invalid connections. ��� �Press the ERC button shown at left to execute ERC without going through the  ERC dialog box.��When you select Place | ERC, the ERC dialog box displays as shown below:

�

Figure 2-37: The ERC dialog box.

¨	Output File. Specifies the new ERC file name. If the output file name is not specified, the default netlist file name is <current sheet name>.ERC.�xe ".ERC extension"�

¨	Search. Opens the file selection.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

¨	Descend Hierarchy�xe "Descend Hierarchy"�. Processes the current worksheet and its associated subsheets.  If unselected, the ERC processes ONLY the current sheet. Refer to the Index for topics about Hierarchy and Flat Files.

(�NOTE: The ERC accepts the link command ONLY if all the schematic flatsheets do not contain hierarchy. ��¨	Decision Matrix�xe "Decision Matrix"�. Shows the sheet ports (nets), module ports, powers and pins. A connection is represented by intersection of a row and a column. 

Each selection of the decision matrix can be toggled into 3 settings:

�  E (Error) indicates that the selected conditions will be detected as an error. 

�  W (Warning) indicates a warning.

�  Blank indicates a valid connection.

Click on a selection with the left mouse button to toggle between E, W and blank.

Click on Execute to run the ERC. After the process, ERC generates an ASCII report file containing the errors, warnings and unconnected pins. On the schematic, the errors and the warnings are marked by a lightning symbol.

(�NOTE: If an electrical rule violation has been detected, a netlist cannot be generated.���To erase the ERC markers use the Cleanup command.��Statistics

The Statistics� XE "Statistics" � dialog box contains data such as the pin count on all open WinDraft sheets and other useful information.  

�

Figure 2-38: The Statistics dialog box.



The Total Number of Pins� XE "Pin Capacity" \t "See Statistics" � indicates the number of pins used in all open WinDraft sheets.  If this number is over the pin capacity you are using, the program will not save, print, or generate reports.  

The WinDraft pin count� XE "Statistics:pin count" � includes each pin on a part including power pins.   For example:  a resistor has two pins, most transistors have 3 pins.  

Pin count with multiple parts per package.  If you place a 7400 (TTL1 library) this part has 5 pins (3 + 2 power).  If you place two 7400 parts on a sheet, the pin count will be 10 pins (5+5).  However, when you annotate the part, the pin count will drop to 8.  This is because it is now 1 part with 6 pins plus 2 power pins.

Archive Library�xe "Archive Library"�

The Archive Library scans the complete design and generates a single binary library file containing all the parts used in the design.

When you select Archive Library, the Archive Library dialog box displays :

�

Figure 2-39: The Archive Library dialog box.

¨	Output File. Specifies the binary library file name containing all  the parts used in the design. If the output file name is not specified, the default Archive Library file name is <current sheet name>.CLB.�xe ".CLB extension"�

¨	Search. Opens the file selection.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

¨	Descend Hierarchy�xe "Descend Hierarchy"�. Processes the current worksheet and its associated subsheets. If unselected, Archive Library processes ONLY the current sheet. Refer to the Index for topics about Hierarchy and Flat Files.

(�NOTE: The Archive Library accepts the link command ONLY if all the schematic flatsheets do not contain hierarchy. ��Click on Execute. During execution, WinDraft generates a log file and an binary library file. The log file contains all the process steps. Restore this file to check if WinDraft has generated any warning or error messages during the process.

Converters�xe "Converters"�

Use this processor to convert OrCAD/SDT 16 or 32 bit binary schematic files and libraries. 

When you select Converters, the ORCAD Converter�xe "ORCAD Converter"� dialog box displays:

�

Figure 2-40: The OrCAD Converter dialog box.

Use Library. Specifies a WinDraft component library file (*.CLB) that will be used to import symbols into the converted sheet file if the Convert Library option is not selected.�xe ".CLB extension"�

Schema specifies the Orcad schematic file to convert.

Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

Descend Hierarchy. Processes the current OrCAD/SDT worksheet and its associated subsheets. Refer to the Index for topics about Hierarchy and Flat Files.

(�NOTE: All the subsheet files MUST be in the same directory as the root sheet. ��¨	Convert Library. The convert processor automatically converts the ASCII OrCAD/SDT 386 library files before converting the schematic file. Refer to OrCAD/SDT Reference Guide for ASCII conversion of the library files.  Use the source format .SRC (not the format .lib).  You must Decompile the SDT library file using Orcad’s decomp program for this to work.

(�NOTE: The library file name prefix must be the same as the root file name prefix.��(�NOTE: The OrCAD/SDT ASCII library file SHOULD NOT contain bitmap definitions or sheet path parts.  Only vector definition are supported by the converter--most OrCAD parts are vector based. Refer to the OrCAD/SDT Reference Guide for more explanation on bitmap and vector definitions.��After conversion, the library file is placed in a library directory specified in the WinDraft configuration setup. Default Ivex\WINDRAFT\LIBRARY, with a .CLB extension. This new converted library is used for the schematic conversion.

¨	Open For Edit. If selected, the schematic will be automatically loaded into WinDraft after the conversion.

Click on Execute in the OrCAD Converter dialog box. During execution, WinDraft generates a log file and converts the OrCAD sheet file into its equivalent WinDraft sheet file. If the Convert Library option is selected, the OrCAD library files will also be converted. 

The log file contains all the process steps. Restore this file to check if WinDraft has generated any warning or error messages during the process.

Decompile Sheet�xe "Decompile Sheet"�

The Decompile Sheet decompiles the loaded WinDraft binary sheet file into the equivalent ASCII file. Refer to Appendix C for the ASCII file syntax. This will allow a database exchange to other systems.  When you select Decompile Sheet, the dialog box displays :

�

Figure 2-41: The Decompile Sheet dialog box.

¨	Output File. Specifies the ASCII sheet file name. If the output file name is not specified, the default ASCII sheet file name is <current sheet name>.ASC.�xe ".ASC extension"�

¨	Search. Opens the file selection.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

¨	Descend Hierarchy. Processes the current worksheet and its associated subsheets.  If unselected, Decompile Sheet processes ONLY the current sheet. Refer to the Index for topics about Hierarchy and Flat Files.

(�NOTE: The Decompile Sheet accepts the link command ONLY if all the schematic flatsheets do not contain hierarchy. ��Click on Execute. During execution, WinDraft generates a log file and an equivalent ASCII file. The log file contains all the process steps. Restore this file to check if WinDraft has generated any warning or error messages during the process.

Compile Sheet

The Compile Sheet compiles a WinDraft ASCII sheet file into the equivalent binary file. This will allow a database exchange to other systems.

When you select Compile Sheet, the dialog box displays :

¨	Output File. Specifies the binary sheet file name. 

¨	Search. Opens the file selection.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

Click on Execute in the Compile Sheet dialog box. WinDraft will prompt you for an ASCII file name representing the schematic to be compiled. During execution, WinDraft generates a log file and converts the ASCII sheet file into its equivalent binary sheet file. 

The log file contains all the process steps. Restore this file to check if WinDraft has generated any warning or error messages during the process.

Properties�xe "Properties menu"�

��The Properties menu is used to define system settings. This menu contains the menu selections shown in the pull-down menu at left.

Setup��The Setup command allows you to set the WinDraft parameters and user options. 



��Select Setup in the Properties menu or click on the Setup button shown at left.  The Setup dialog box displays.��You can change settings in the following areas from the setup dialog box:

File Locations

Visible at Scale

Drawing Selections

Attribute Names

Selection Filter

Text Properties

Object Properties

Misc. Preferences



�

Figure 2-42: Tabs in the Setup dialog box.



These selections are represented by eight (8) tabs in the dialog box.  Click on a tab to view and modify the selections for the tab heading.

The buttons on the bottom of the dialog box are always visible and perform as follows:

Use the OK button to accept the selections and close the dialog box.

Use Cancel to close the dialog box without making any changes to the selections.

Use Apply to accept the selections and apply them to the sheet without closing the dialog box.

Use Help to launch on-line help for the current topic.

�File Locations�xe "Environment"�

The File Locations� XE "File Locations" � selection tab allows you to specify the directory path for WinDraft projects and libraries.

	�

		Figure 2-43: The File Locations dialog box.



Current Project Path

The Project directories� XE "File Locations:Project directories" � are used to store your schematic, ERC, BOM, netlist and other reports generated by WinDraft. It is designed so that you can specify multiple directories and easily switch directories for various projects.

The default directory is c:\ivex\demo. WinDraft will look in this directory when you load or open a sheet.

Current Library Path

The Current Library Path� XE "File Locations:Library Path" � works in the same manner as the Current Project Path described above, only it sets the path for the WinDraft library files. The default directory is c:\ivex\windraft\library.  The directory is used to store your WinDraft library files (*.clb).  WinDraft will look in this directory when you load a library or part.

�

Figure 2-44: The Current Project Path.



How to Add a Path

Enter the path for the desired project or library directory in the text entry box.  If you are entering a new directory path, press the Add button next to the text entry box after you enter the new project path.    

You can add several directories and they will display in the box directly under the text entry box.  In the Figure 2-44, there are 5 project directories (demo, proj1, proj2, proj3 and proj4).  

How to Change a Path

To change the current project path, click on the desired entry in the list box.  The entry that is highlighted is the current project path.  It will display in the text entry box.

How to Delete a Path

Select the desired entry in the list of current projects (or libraries).  Your selection will be highlighted.  Press the Delete button next to the list box (Project or Library) that you are deleting from.



��Use the Add button to add an entry to the Project Files box or the Library Files box.����Use the Delete button to delete an entry from the Project Files box or the Library Files box.��

Directories and Drives

Use the directories and drives section to help locate and select directory paths for projects and libraries.  This works similar to other Windows applications.  Select the drive first, and then use the Directories section to locate the path and name of the sub-directory you are looking for.

�

Figure 2-45: The Directories section.�xe ".LST extension"�

Visible at Scale

The Visible at Scale� XE "Visible at Scale" � Tab is used to select items which you may want to disable when the zoom level is lower than the zoom cut factor.  The more you zoom out on a design, the harder it is too read certain items such as small text, pin numbers, etc.  By reducing the items that are visible, the screen is less cluttered, it redraws faster, and is much easier to read.



�

	Figure 2-46:  The Visible at Scale dialog box.



Use the Zoom Cut Factor radio buttons to select the zoom level to “cut out” un-desired objects.  For example, select 50% and only items checked will be visible at zoom scales at or below 50%.

We suggest starting with a Zoom Cut Factor� XE "Zoom Cut Factor" � of 50% or 100% for most applications.

��Use the Select All button to mark all the check boxes.����Use the De-Select All button to un-mark all the check boxes.��Drawing

Use the Drawing� XE "Drawing" � Tab to change the Grid, Junction, Multi-Wires, and Repeat Increment.  The following dialog box displays:

	�

		Figure 2-47:  The Drawing Selection dialog box.

Grid

Use Grid� XE "Grid" � to change the visible grid Style and Size. 

Select the grid Style, either Line or Dot.

Use the Size to select Coarse grid, Medium grid, or a Fine grid.

(�NOTE: To change the grid color or visibility, use the Object Properties Tab.��(�NOTE: Using a Fine grid on slower machines such as 486 will slow down redraw.  For faster redraw, use Medium or Coarse settings..��



Keep cursor in work area 

Use to keep the cursor within the worksheet boundary.  If you de-select this box, you will be able to place objects outside the worksheet area.

Junctions� XE "Junctions" �

Use Junctions to change the Style and Size of junctions.

(�NOTE: To change the junction color or visibility, use the Object Properties Tab.��Junction Style sets the default type of the junctions. All shapes have an equivalent electrical property. Choose either: Circle, Square, or Diamond.

Junction Size sets the default size of the junctions. Choose either:  Small, Medium, or Large.



Multi Wires

Use Multi Wires� XE "Multi Wires" � to change the number of wires, buses or lines to be drawn simultaneously and their spacing.

Spacing sets the spacing between consecutive objects that will be drawn simultaneously.  One pin grid (1/10 of an inch) is represented by the number 1000.  There are 10000 units per inch.

Number determines how many objects (wires or buses) will be simultaneously drawn during a wire or bus Place command.  

+-�Hot Keys: The “+” key on the 10 key pad is also used to increase the number and the “-” key is used to decrease the number of simultaneously drawn wires.��For more information on the Multi-Wire feature, please refer to Placing Wires earlier in this chapter.



Repeat Increments� XE "Repeat Increments" �

The Repeat Increments are used to determine the value used for the Repeat Command.

Use Delta X to determine the distance in the X direction to repeat.

Use Delta Y to determine the distance in the Y direction to repeat. The default value is 1000 units, this should correspond to the pin spacing on most parts.

Use Label Increment to select the number to increment.  When adding text labels, an increment of 2 will increment the label as: A2, A4, A6, A8, etc.

For more information on the Repeat command and placing text labels, please refer to Text earlier in this chapter.



Attribute Names

Select Attribute Names� XE "Attribute Names" � to change the name of the field attributes. This may be used to select packaging such as module footprint assignment or part inventory numbers.  The Attributes Names dialog box displays.

�

Figure 2-48:  The Attributes Names dialog box.



What is an Attribute

These field attributes can be used to store any useful information in a part like: module footprint, part number, price, vendor name and tolerance.  These field attributes can be used by WinDraft processors.



How to Add an Attribute

To add an Attribute, enter the name in the text entry box next to Attribute Name.   Press the Add button to add the attribute and it will be added to the list below.

� EMBED CorelDRAW.Graphic.6  ����CAUTION: Do not use delimiters such as quotes, double quotes, commas, or parenthesis.��How to Delete an Attribute

Click on the name of the attribute to remove in the list so it is highlighted. Press the Delete button to remove the attribute from the list.



How to Edit an Attribute

To edit an Attribute name, click on the name of the attribute in the list so it is highlighted.  Enter the new name in the Attribute Name text entry box.  Press the Edit button to change the name of the attribute.

� EMBED CorelDRAW.Graphic.6  ����CAUTION:  Be very careful when you Delete or Edit an Attribute.   If the attribute is used in an existing design or library, changing its name may cause serious problems.  For example, if the Module Name attribute was removed, the package information would be missing for PCB layout!��Selection Filter

Use the Selection Filter� XE "Selection Filter" � to determine which objects are selected when you draw a marquee around a group of objects.  Only the objects checked in this box are selected.  This is useful to only edit a certain group of objects without selecting unwanted objects.  

For example, if you want to remove all No Connect symbols from a section of a design without selecting or removing any other objects, then follow these steps:

Press the De-Select button to de-select all check boxes. 

Check the box for No Connect.  Press OK.

Draw a marquee around a group of objects that contain No Connect symbols.  It will only select the No Connect symbols.

Press the Delete key to remove the No Connect symbols.



�

		 		Figure 2-49: The Select Filter dialog box

Use Select All to check all boxes.  

Use De-Select All to uncheck all boxes.  Remember, if no boxes are checked and you try to select something on the sheet, it will not select anything.

Text Properties

Use the Text Prop. (Properties)� XE "Text Properties" � Tab to change the characteristics of text such as: font, color and visibility.  This dialog box has four columns as follows:

Object:  This is the name of the text object.

Object Properties:  This indicates the current property selection for the font such as typeface, point size, and font style.

Color� XE "Text:color" �:  This indicates the color selection for the object.

Visible� XE "Text:visible" �:  This indicates the visibility status.  Yes means the text object is visible on the sheet, No means it is not visible, N/A indicates this selection is not applicable or can not be turned off individually.

�

Figure 2-50:  The Text Prop. dialog box

Change a setting

To change a setting, click on the text object you want to change.  This will highlight the selection.  Then, follow these steps:

To change the Font, press the Font button.  This will open the Font Dialog box and you can change the font type, point size, and font style.

To change the Color, press the Color button.  This opens the Color dialog box. Select a new color and press the OK button to accept the change.

To change the visible status, click on the down arrow and select either Yes or No from the pull-down list.  If there is an N/A in the Visible status column, then this selection is not available.

�

Figure 2-51: Pull-down menu for Visible.

Object Properties

The Object Properties� XE "Object Properties" � dialog box is used to select the Color, Size and Visibility of WinDraft graphical Objects other than text. 

�

Figure 2-52:  The Object Props.  dialog box

Visible:� XE "Object Properties:visible" �  It is possible to change the visibility status on most objects.  Check the box in the Visible column to have the object display on the screen.  If the box is not checked, it will not display.

Color� XE "Object Properties:color" �:  The current color selection displays in the box under the color column for each object.  To change the color, just click on the color box next to the object.  This will open the color dialog box.  Make the desired change and press OK.

Size:  It is possible to change the point size of most of the graphical objects.  Click on the arrow in the Size column for the object you want to change.  Select the new point size from the pull-down list.

Misc. Preferences� XE "Misc. Preferences" �

Use this dialog box to select the miscellaneous configuration options and display options of WinDraft.

�

Figure 2-53:  The Misc. Preferences dialog box



Miscellaneous

Show ERC Warnings� XE "ERC:Show ERC Warnings" �: �xe "Backup File"�When selected, the ERC warning symbol which resembles a downward pointing arrow (lighting bolt) will display next to the error.

Auto Clean Up�xe "Auto Clean Up"�: When selected, the Cleanup processor is always active. It continuously checks for wires, buses, junctions and other objects that are placed on top of each other and removes the overlaps. Additionally, it removes lines, bus and wire segments overlapping part pins, module ports and power symbols.

Show Field Associations displays a line from Part Reference and Part Value (or any user-definable Attribute) to the part body it belongs to.

Show Items Filled�xe "Show Items Filled"� displays the polygons in a filled mode. The selection slows down the drawing speed.

Autopan� XE "Autopan" �:  Check this box to have the program automatically autopan.  De-select this box will disable the autopan feature.  When WinDraft is in the automatic autopan mode, you can still disable autopan by holding down on the Ctrl (Control) key on the keyboard.

Sheet Size� XE "Sheet Size" �

Use the Sheet Size setting to change the workarea size at any time. Use a pre-configured sheet size, or enter new Width and Height settings for a custom worksheet size.

Type: click on the arrow for a pull-down list of sheet sizes.  The selections are A to E and A4 to A0.  Click on the desired Type and the size of the sheet will change to the new selection.

Width: This is the horizontal dimension of a sheet.  The numbers in this box correspond to the sheet size selected in the Type pull-down list.   Enter a numeric value in this box for a custom sheet size in mils.  1,000 mils equals one inch.

Height:  This is the vertical dimension of the sheet, 1000 mils equals one inch. The numbers in this box will correspond to the sheet size selected in the Type pull-down list.   Enter a numeric value in this box for a custom sheet size in mils.  



Auto Backup� XE "Auto Backup" �

Check the box Create Backup Files� XE "Backup Files" � to have WinDraft generate automatic backup files. WinDraft will generate a backup file �xe "Preferences"�called <original file name> .001, .002, .003, etc.  It is saved in the directory path as specified in the File Locations dialog box.

Use Nb. Backups to select the number of backup files. When the selected number of backups is reached, WinDraft will start at the first backup file and cycle through the selected number of backups, sequentially overwriting the oldest copy of the file.  

Use the Every Minutes selection to determine the time interval between backups.  You may select from the pull-down menu a number from 1 to 30.  A selection of 10 will generate a backup file every 10 minutes.



� EMBED CorelDRAW.Graphic.6  ����CAUTION: Select a reasonable time interval and number of backups. Be very careful not to walk away from the computer with the program open for a long time interval, it will eventually cycle through all the backup files.  You should exit the program if it is not being used.��

Log File

The Log File is used by WinDraft to store all the messages during a processor execution.  The default log file name is WINDRAFT.LOG�xe "WINDRAFT.LOG"�.  The log file is located in the project (part) directory.

Use Append to existing Log File�xe "Clear Before Output"� to open the existing log file and append the new messages.  If not selected, WinDraft overwrites the existing log file every time a processor is run.

Use the text entry box to change the name of the log file. Enter the new filename in the Log File entry box.  

The Browse button may be used to open the standard Windows File Open dialog box.  You can search for an existing filename or create a new one.



Toolbar on/off�xe "Show Toolbar"�

Many of WinDraft menu commands can be accessed from the main toolbar below the pull-down menus. The toolbar buttons can speed the editing process.

The main toolbar can be displayed or hidden by clicking on the Toolbar On/Off command in the Properties menu. 

To increase the size of the working area, switch off the main toolbar. 

The main toolbar can not be re-positioned by the user.

The secondary toolbar can not be switched off.

Part Palette On/Off

��Use this to select the Parts Palette.  A check indicates that the Palette is displayed� XE "Parts Palette:display" �.  You may also use the icon shown at left to select or de-select the Parts Palette.��Floating Tools On/Off�xe "Show Icons Menu"�

The icon menu includes tools for creating graphical objects, like wires, lines, and text.  The icon bar can be displayed or hidden by clicking on Show Icons Menu in the Properties menu. 

This toolbar can be repositioned by the user just like any Windows dialog box. The position coordinates are saved in the WinDraft configuration file.

Scroll Bars On/Off�xe "Show Icons Menu"�

The scroll bars may be displayed or hidden by clicking on the Scrollbar On/Off command in the Properties menu.  Turn the Scrollbars off to increase the workarea size. 



Window�xe "Window menu"�

��Window contains the menu selections shown in the Window pull-down menu at left.

This menu works similarly to the Window pull-down menu in other Windows-based applications.  Files that are currently open are displayed at the bottom of this menu.��Help�xe "Help menu"�

��Help contains the menu selections shown in the Help pull-down menu at left.  This menu works similarly to the Help pull-down menu in other Windows-based applications.

Use Registration to enter your password registration number to enable capacity.  Refer to Registration in the Getting Started Guide.

Use About to check the version, registration number, and capacity. ��ShortCuts�xe "ShortCuts"� 

The ShortCuts dialog box lists keyboard shortcuts.  Use this for a handy on-line reference. 

	�

	 Figure 2-54:  The ShortCuts box.



The  ShortCuts dialog box will list the keyboard short cuts for the mode you are in.  For example:  if you are in the wire mode, hold down the Ctrl key (to prevent scrolling) and click on Help | ShortCuts or press Alt | H | S.  The dialog box will reflect shortcuts pertaining to wiring.

Use Show All Keys�xe "Show All Keys"� to list the combined list of Main Mode and Selected Mode shortcut keys.

Use Show Selected States�xe "Show Selected States"� to list only the shortcut keys in the selected mode.

Tips� XE "Tips" �

Use Tips to display the Tip of the Day dialog box.  

�

Figure 2-55:  The Tips of the Day box.

Check Show Tips� XE "Tips:show tips" � at start up to display the Tips dialog box each time you open WinDraft.

Scroll through each tip by pressing the Next Tip button.  Each time you press this button a new tip is displayed.

Registration

Use Registration� XE "Registration" � to enter the password registration number.  This is used to enable the program and to increase capacity.  For details, Refer to Registration in the Getting Started Guide.

About

Use About� XE "About" � to inquire about the product version number you are using and to verify the password registration number.

�Toolbars�xe "Toolbars menu"�

�

�

WinDraft’s main and second toolbar



�EMBED HJPRO  \* MERGEFORMAT \s����WinDraft's two toolbars are shown above.  In addition to the toolbars, WinDraft uses a Floating Tool Menu�xe "Floating Icon Menu"� as shown at left.  The Floating menu may be moved the same as other Windows floating menus by holding the mouse button down and dragging the Title bar.  This Floating menu contains icons used for wiring and drawing.



The main toolbar, as shown above, runs across the WinDraft window below the menu bar. You can switch the main toolbar on/off by selecting the Properties | Toolbar On/Off command.��The second toolbar is below the first.  It is composed of buttons used to manipulate the view of the current sheet file, zoom scale selection, grid, pin count for the current sheet and it includes an X,Y coordinate display�xe "X,Y coordinate display"�.  This is also known as the Window Tool Bar because it is always attached to the sheet.

The tools are listed in alphabetical order, by tool name in the table below for reference.  A picture of the button is shown to the left of each button.

��Block Cut�xe "Block Cut"����Block Copy�xe "Block Copy"�����Block Paste�xe "Block Paste"���EMBED HJPRO  \* MERGEFORMAT \s����Bus�xe "Bus"�����Circle�xe "Circle"����ERC Run�xe "ERC Run"�����File Open�xe "File Open"����File Save�xe "File Save"�����Find Text�xe "Find Text"����Geometry�xe "Geometry"�����Ground�xe "Ground"����Help�xe "Help"�����Junction�xe "Junction"����Line�xe "Line"�����Module Port�xe "Module Port"����No Connect�xe "No Connect"�����Part�xe "Part"����Part Palette����Power�xe "Power"����Print�xe "Print"�����Setup�xe "Setup"����Sheet Net�xe "Sheet"�����Rectangle�xe "Rectangle"����Repeat�xe "Repeat"�����Text�xe "Text"����Undo�xe "Undo"�����Wire�xe "Wire"�����

The zoom tools�xe "zoom tools"� are listed in alphabetical order, by tool name in the table below for reference.  



��Center Screen�xe "Center Screen"����Refresh Screen�xe "Refresh Screen"�����Zoom in�xe "Zoom in"����Zoom to Fit�xe "Zoom Fit"���� �EMBED HJPRO  \* MERGEFORMAT \s� ��Zoom out�xe "Zoom out"����Zoom Window�xe "Zoom Window"��� Zoom Scale and Grid List Boxes�xe "Scale and Grid List Boxes"�

�

��The Zoom Scale and Grid� XE "Grid" � Displacement�xe "Displacement"� list boxes located in the middle of the second toolbar are used to set the drawing scale and the pointer displacement.

To change the zoom scale� XE "Zoom:zoom scale" � or the grid displacement, click with the left mouse button on the scroll arrow to the right of the zoom or grid list box. A pull-down list displays. Select the option by clicking on it.

In the scale pull-down list, use Best to fit the sheet into the screen workarea.

���

��The Grid displacement can be set to Pin, Small or Free.

Use Pin�xe "Pin"� to place wires on the pin grid (1/10 of an inch).  It will start placing at the nearest grid point.

Use Small�xe "Small"� to wire at one tenth of a pin grid (1/100 of an inch).  Use this for drawing or library part creation.  

Use Free�xe "Free"� to wire at one hundredth of a pin grid�xe "grid"� (off grid or 1/1000 of an inch).  This is useful for making mechanical drawings using circles, lines and rectangles.��

� EMBED CorelDRAW.Graphic.6  ����CAUTION:  The Small and Free settings should not be used for part placement and wiring.  If they are, be careful because if parts are placed off grid, the wires may not line up when wiring. If wires do not line up, they will not make an electrical connection.��

��The Pin Count� XE "Pin Count" � indicator is located between the Grid box and the X, Y coordinates on the second toolbar.  This displays the number of pins used on the current worksheet.  ��



�Chapter 3:  Editing Features�xe "Editing Features"�

This chapter explains how to select, edit, rotate and move objects. 

Selecting Objects�xe "Selecting Objects"�

This section explains how to select objects. The methods for selecting objects of any types are :

¨	Individual objects.

¨	Blocks of objects.

¨	Groups of objects (Selection Filter).

Selecting Individual Objects

An object can be a part, module port, title block, junction, text, etc. 

How to select individual objects:

1.	To select an object, click the left mouse button on the object. WinDraft highlights the object. 

2.	Select more objects along with the one you have already selected by holding down the Ctrl key while clicking with the left mouse button on each object.

3.	To unselect selected object, click with the left mouse button on a blank (or empty) portion of the worksheet.

Selecting Individual Objects from a Group

When you make a selecton, there may actually be several objects selected together, such as wires and junctions.  Therefore, several objects may be selected with a single click.

(�Use the Tab key to selected the desired single object.  Continually pressing the Tab key will toggle through all of the selected items.��� � �

Three examples of using the Tab key to select from a group of items.

In the examples above, three wire segments are electrically connected with a junction.  In example one, all items are selected.  In example two, the Tab key is used to toggle through the selected items and the lower wire segment is selected as indicated by the gray wire.  In example three, the Tab key is used to toggle to the junction and it is the only item selected indicated by the gray circle.  Continually pressing the TAB key will cycle through all selectable objects in the current selection.

Selecting Window Blocks of Objects

How to select a window block of objects:

1.	Place the pointer at one corner of the area you need to select.

2.	Press and hold the left mouse button while dragging the pointer to the opposite corner of the area to be selected. WinDraft draws a “marquee” box around the area that is selected.

3.	Release the left mouse button to complete the selection process. Objects within the rectangle marquee are now selected. 

�EMBED Paint.Picture  \* MERGEFORMAT \s����When you release the mouse button and whenever the pointer touches the area surrounded by the rectangle, the pointer looks like a pointing hand�xe "pointing hand"�.��

��To cut�xe "cut"� or copy�xe "copy"� the block of selected objects, simply select a block and click on the Cut or the Copy buttons.��To move a block of selected objects, simply place the pointing hand anywhere in the block and hold down the left mouse button while dragging the block. 

Selecting Groups of Objects

Use the Selection Filter to determine which objects are selected when you draw a marquee around a group of objects.  Only the objects checked in this box are selected.  This is useful to only edit a certain class of object without selecting unwanted objects.  

For example, if you want to remove all No Connect symbols from a section of a design without selecting or removing any other objects, then follow these steps:

Select Properties | Setup | Select Filter.

Press the De-Select All button to de-select all check boxes. 

Check the box for No Connect.  Press the OK button.

Draw a marquee around a group of objects that contain No Connect symbols.  It will only select the No Connect symbols.

Press the Delete key to remove the No Connect symbols.



�

		 		Figure 3-1: The Select Filter dialog box



��Use Select All to check all boxes.��

��Use De-Select All to uncheck all boxes.  ��(�NOTE: Remember, if no boxes are checked and you try to select something on the sheet, it will not select anything.��Moving�xe "Moving objects"�, Rotating�xe "Rotating objects"� and Mirroring�xe "Mirroring objects"� Objects

Moving, Rotating and Mirroring Single Objects

This section explains how to move, rotate and mirror all objects other than wires and buses. For information about moving and editing wires and buses, refer to Editing Wires, Lines and Buses below.

To move, rotate or mirror any object, start by selecting the object as outlined in the previous section Selecting Objects.

�EMBED Paint.Picture  \* MERGEFORMAT \s����Notice that as you move the pointer near the selected object, the pointer changes to look like a pointing hand. This pointer indicates that WinDraft has entered the mode for moving objects.��How to move the selected object:�xe "Moving objects"�

Click on the object you want to move.

Press and hold the left mouse button and drag the object to its new location.

Just release the mouse button and the object unselects.

How to rotate the selected object:�xe "Rotating objects"�

Click on the object you want to rotate.

Rotate the symbol by pressing the left or right  arrow key, or use the arrow keys on the 10 key pad with Num Lock Off.

Click with the left mouse button on a blank (or empty) portion of the worksheet to unselect the symbol. 

How to mirror the selected object:�xe "Mirroring objects"�

Click on the object you want to mirror.

To mirror the symbol around the X axis, press the down arrow key. To mirror the symbol around the Y axis, press on the up arrow key.  Also use the up or down arrow keys on the 10 key pad with Num Lock Off.

Click with the left mouse button on on a blank (or empty) portion of the worksheet to unselect the symbol.

Moving a Block of Objects

How to move a block of objects:�xe "Moving objects"�

Select the desired block of objects. 

Place the tip of the pointer finger somewhere within the selected block of objects.

Press and hold the left mouse button.

Drag the block to its new location and release the mouse button. The block of objects unselects itself.

Editing Wires, Lines and Buses�xe "Editing Wires, Lines and Buses"�

WinDraft provides powerful, flexible editing features that make it easy to move a whole wire or bus, drag vertices, delete vertices, or insert new vertices anywhere on the wire or bus. 

Changing wire, line and bus style

�EMBED Word.Picture.8���  �EMBED Word.Picture.8���

�  �EMBED Word.Picture.8����If you need to change the wire, line and bus style while in drawing mode, click on the Geometry style button. The Geometry style button changes appearance depending on the chosen style of drawing angle.  Notice the four different forms of this button at left, each one indicates the selected style.  ��x�The X key may also be used to toggle through Geometry styles when drawing.  Each time you press the X key the style will toggle to the next style of Geometry.  The four available Geometry styles are: 90 degree, 45 degree, Arc, or Any Angle.��Moving a wire segment

When moving a wire, you need to know how the wire move operation works. 

(�NOTE: If the wire you want to move begins and ends on a pin, power,  module port or bus, the beginning and ending point of the wire will remain on the symbol which retains net connectivity. However, all ending points that are not attached will move.��

�EMBED Paint.Picture  \* MERGEFORMAT \s����How to move an existing wire:

Click on the wire to select it.

Click and hold the CTRL key and move the cursor on the wire until you see the pointing hand.

Press down on the left mouse button and move the wire to the new location.

Release the left mouse button. The wire is no longer selected.��Adding a Vertex�xe "Vertex, adding and dragging"�

�EMBED Paint.Picture  \* MERGEFORMAT \s����Select the wire you want to move by clicking on the wire with the left mouse button. Notice that as you move the pointer toward the middle of a wire segment the pointer changes to look like scissors. The scissors are used to add a vertex to an existing wire.��To add a vertex, place the scissors at the location on a wire you want to add a vertex.

Click on the left mouse button to add the vertex. The cursor will change to an X as you move the new vertex.

Press and hold the left mouse button and drag the vertex to the new location.

Dragging a Vertex

X�A vertex is a corner point of a wire or bus.  A vertex may also be inserted into a wire segment as previously described and then you may drag the vertex to change the shape of a line, wire or bus.

Select the wire you want to move by clicking on the wire with the left mouse button. Move the cursor toward the vertex that you want to move.  When the cursor is over the vertex it will change to appear as an X. ��1.	Place the cursor on the vertex you want to move.

2.	Press and hold the left mouse button and drag the vertex to the new location. 

Deleting a segment from a wire 

On the wire from which you want to delete a segment do the following:  

Click on the wire segment to select it.   The segment is highlighted.  If too many wire segments become selected, press the TAB key to choose individual segments until only the one you want is highlighted.

Press the Del key. The segment is deleted.

Editing Objects�xe "Editing Objects"�

Editing Object Characteristics

Editing an object is easy.  Just double-click on the object (other than wires, buses and drawing objects) with the left mouse button and select the appropriate characteristics from the dialog box.

Cut, Copy and Paste Objects�xe "Cut, Copy and Paste Objects"�

To cut, copy or paste an object or group of objects, start by selecting the objects as described in the previous section Selecting Objects.

When objects or groups of objects are selected, notice that the pointer changes to look like a pointing hand and the Cut and the Copy buttons display as active buttons on the toolbar. 

How to cut (delete) objects:

��Select the objects.

Click on the Cut button (or press the Ctrl X keys). The selected objects are deleted.

��How to copy objects:

��Select the objects.

Click on the Copy button (or press the Ctrl C keys). The selected objects are copied to the Windows clipboard.��How to paste objects:

��Objects must have already been placed on the clipboard (with the Cut or Copy commands) :

Select the objects.

Click on the Paste button (or press the Ctrl V keys). The objects are pasted.��

XCV�Hotkeys:

Ctrl X to Cut,

Ctrl C to Copy,

Ctrl V to Paste.��Editing Parts 

To edit the characteristics of a part, double click on the part.  This will open the Edit Part dialog box.  

Edit the Part Attribute

The left side of this dialog box is used to edit the attributes associated with the part.  You may select each attribute from the pull down list. The default attributes include Part Reference, Part Value, and Module Name.  When you select an attribute from the pull down list the value associated with the attribute is displayed in the Value text entry box directly below the pull down list.

�� 

Figure 3-2: The Edit Part dialog box



Module Name

The Module Name attribute field is used to determine the footprint package to be used for PCB layout.  This name must conform to the name of the module footprint in the layout program you are using (such as WinBoard).

To edit the Module Name, first select Module Name from the pull down list of Attributes.  If an Attribute is not assigned for Module Name, then assign one in the Setup | Attribute dialog box.

Enter the Module Name in the Value text entry box directly below the pull down list.  In the example below, the WinBoard Module Name 14DIP300 is entered in the text box.



��

Figure 3-3: The Value text entry box.



(�NOTE: For more information on Module Names for PCB layout, refer the Netlists Chapter of the Getting Started Guide.��Edit Pin Names and Package

In right side of the Edit Part dialog box you can change the name of any given pin or the device within the Package (if the part has multiple parts per package).

Use the Visible Power check box to select to have the power pins visible for the selected part.

Use the Convert check box to view the DeMorgan representation of the part.

Edit Part Ref or Part Value

To edit the Part Value or Part Reference for a part, double click on the text.  This will open the Edit Field dialog box.  Enter the new text in the text entry box under Field Value.  Press the Change button to accept the new text value.  



�

Figure 3-4: The Edit Field dialog box

Part Value and Part Reference are Attributes that can also be changed in the Edit Part dialog box.  Double click on the part, and make the changes as described above for editing Module Name.



� EMBED CorelDRAW.Graphic.6  ����CAUTION:  Be careful to enter only valid text strings.  Refer to Appendix E: Things to know for a Table of Requirements.  Also check requirements for your PCB layout program.��(�NOTE:  To automatically number each Reference with a unique value, use the Annotation feature as described in Chapter 2.��Edit Objects

To edit other objects such as Module Ports, Sheets, Nets, or Power just double click on the object.  This will open an Add/Edit dialog box to make changes.

Undo�xe "Undo"�

��The Undo tool button is shown at left. When the Undo button is active, you can undo a command by clicking once on the button or by pressing Ctrl-Z . You can use Undo to:���symbol 183 \f "Symbol" \s 10 \h�	Undelete objects

�symbol 183 \f "Symbol" \s 10 \h�	Undo moves

Editing Quick Reference�xe "Editing Quick Reference"�

The following table summarizes the different pointers used for editing, the action required to produce each pointer, and the use of each pointer.



Editing�Symbol�Action Required to�Produce Symbol�Command Description���EMBED Paint.Picture  \* MERGEFORMAT \s����Move the pointer near the selected object.�Move objects: Place the pointing finger near the selected object. Click and hold the left mouse button while dragging the object to its new location. Release the mouse button.����Move the pointer near a straight segment of selected wire.�Insert a new vertex into the wire at the location of the scissors: Place the scissors on the wire segment where you want the new vertex.  Then click and hold the left mouse button and Drag the new vertex by moving the mouse.��X�Insert a vertex or place the cursor over an existing vertex.�Move a vertex of a wire at the location of the “X”: Click and hold the left mouse button and Drag the vertex by moving the mouse.��

�Chapter 4:  Guidelines for Designs

This chapter is intended to provide guidelines for creating a proper and functional schematic.  In order to obtain predictable results, there are rules that need to be followed.  When followed, these rules and guidelines will help you produce functional and useful results the first time  If you plan to generate a netlist and use any other tools such as PCB layout, adhering to these rules greatly simplifies the task of creating a valid netlist.

If these rules are not followed, the database that contains the connectivity of all of the components may contain incorrect connections.

Label names

You must use the label text when naming labels and buses.  If you intend to create a flat or hierarchical netlist, then you need to be aware of any naming restrictions imposed by your target netlist format.  For instance, WinBoard and other PCB layout programs do not allow spaces, parenthesis, brackets, quotations, or commas in any netnames, therefore they should not be used in any labels.

Wire labels

Labels are used to connect signals from one worksheet area to another without using wires or buses.  This is often referred to as connecting referentially.

For example, assume you have a signal labeled Clock in your worksheet and you would like to connect another object on the worksheet to the same signal.  Instead of drawing a wire from Clock on one side of the worksheet to the other object, you can identify each signal with a label, as shown below:

�

	Figure 4-1:  Using a label to connect signals.

You may make referential signal connections only within a single sheet.  To connect to sub-sheets in a hierarchy, you must use the Sheet Net connectors and Module Ports.  Refer to sections regarding hierarchy.

Bus labels

Labels are also used for naming buses and bus members. To create a proper netlist, both the bus and the wires branching from it must be labeled following a specific format.  The bus label form is:

	BUSNAME[X..Y]

The prefix of the label, indicated above by BUSNAME, represents the name of the bus.  The suffix of the label, indicated above by [X..Y], specifies a range of decimal integers representing the number of wires branching from the bus.  X represents the first wire number in the bus; Y represents the number of the last wire branching from the bus.  Y must be greater than X.  There are no spaces between the prefix and suffix.

Typical examples are:

ADDR[0..22]�(A 23 member bus.)��DATA[16..31]�(A 16 member bus.)��CONTROL[1..6]�(A 6 member bus.)��A[50..100]�(A 51 member bus.)��

�

Figure 4-2: An example of a properly labeled bus and its members.



A bus label may be placed anywhere on the bus, as long as the label’s hotpoint is touching the bus.  Refer to the Place | Text command section for a description and examples of the label hotpoint.

Wires branching from a bus must be labeled in a form corresponding to the bus.  In the example above, the bus is labeled as:

	PAR[0..7]

Then the wires branching from the bus must have labels of the form shown as busnamex, where X is a decimal integer in the range of 0 - 7.  Therefore, in the example above the wires are labeled as:

	PAR0, PAR1, PAR2, and so on.

	









Physical Connectors

Physical connectors are library objects such as the DB09 shown in the example below.  Since the physical pins of such a connector may be connected to multiple objects (parts) that are located at different locations on a worksheet, it could get very cluttered actually making these connections using wires.  Therefore, the desired method is to place a connector and use labels to connect referentially to other objects.

�

Figure 4-3:  Using a label to connect signals.



In the example above, labels are used to connect the DB09 to other parts on the worksheet.  The wires only stub out a short distance from the DB09 and do not actually continue any further.  

If this was a multiple sheet design, then the DB09 would only be placed on one sheet in the design, and then module ports would be used to connect signals to other sheets in the design.  module Ports are used to connect signals from one sheet to another and are not used to connect signals within a sheet as are labels.  

It is acceptable to have both a label and a module Port to connect a pin to a signal located on the same sheet as the DB09 and the same signal located on another worksheet in the design.





�Chapter 5 :  Hierarchy�xe "Hierarchy"�

The idea of using a subsheet is not only to store items that cannot fit on the main drawing sheet, but more importantly, to allow you to organize the schematic into logical blocks.

Creating a Root Sheet�xe "Root Sheet"�

An example of how you would use a hierarchy would be the design of a computer. Hierarchies allow you break the design down into smaller, manageable "chunks". In a computer's design, there might be the following pieces:



•	CPU

•	I/O (Serial ports, etc.)

•	Memory



A graphical example is shown below:



�



In the above diagram, captured from an actual hierarchy root sheet, there are three subsheets depicted, the CPU, Memory and Input/Output sheets. Notice that the major signal buses are connected between the subsheets by net connectors inside the sheets, and by bus lines between the sheets.



To place the subsheets on the root sheet, select the Place | Sheet command while editing the schematic. You will supply the sheet name as well as the file name in which to store the file. In our example above, the sheet name is CPU Diagram, and the sheet file is CPU.SCH. 

Once all the sheet markers have been placed on the root sheet, you can create net connectors on them by selecting the Place | Net command while editing the schematic. Again using the example above, you will supply a net name of ADDR[0..31], and select the style of Output for the CPU Diagram sheet, but use the Input style for the Memory and Input/Output sheets.  This indicates that the signal originates on CPU.SCH, and is only an input to MEMORY.SCH and IO.SCH.

Finally, you will place a label on the bus, to denote the proper naming of the signals in it by selecting the Place | Text command. Be sure to select label text�xe "label text"�, and not comment text. The proper nomenclature for describing buses is:



		NAME[0..maxsize]

A 32 member bus will have signals numbered from 0 to 31.



(�NOTE: You must enclose the range of bus signals in square-brackets, as shown above.��Creating Subsheets�xe "Subsheets"�

For each sheet marker placed on the root sheet, a corresponding subsheet must be created. In addition, each net connector, whether representing a bus or a wire, must have a corresponding module port�xe "module port"� present on the subsheet, as illustrated below:  





	�





Notice that each individual signal in the bus is labeled on the wire that connects to the bus. Generally, you will want to label the wires with the same base name as the bus. In other words,



	ADDR2

	ADDR3

	ADDR4		Each one is a part of ADDR[0..31]

	ADDR5

	etc.



	

(�NOTE:  It is not a good idea to use base names that end in a numeral because it can produce signal names that conflict:

For instance, SIG1[0..15] has signal names that could be duplicated or confused with other connections:

	SIG10

	SIG11

	  .

	  .

	SIG110

	SIG111	etc.��

Power�xe "Power"�

You do not need to specifically connect power signals such as VCC and GND on the hierarchical diagram. These are automatically connected globally throughout the design.

�Chapter 6:  Library Editor�xe "Library Editor"�

This chapter describes the WinDraft library editor menus. This editor is used to create component parts for WinDraft. 

Menus are listed in order they display when WinDraft is running and a library window is selected. 

WinDraft library editor uses eight pull-down menus: File, Edit, Place, Tools, Utilities, Properties, Window and Help. This section explains how each menu works.

File

��The File menu contains the menu selections shown in the File pull-down menu at left.

Use New to create a new library part as follows:��1.	Click with the left mouse button on File.  The File pull-down menu displays.

2.	Click with the left mouse button on New.  The New dialog box displays.

3.	Click once with the left mouse button on the Library radio button to create a new library part. 

�

		     	Figure 6-1: The New dialog box.

4.	Click in the Name text entry box and enter the name of the new library.  The filename is limited to twenty-one characters (use a maximum of eight characters for Windows 3.1)�xe "file name limitations"�.  Use the three character file extension. .CLB for all WinDraft library files.�xe ".CLB extension"�

5.	Select OK to close the dialog box and open the library editor.

Load

��Use File Load or the toolbar icon at left to open an existing library as follows:�xe "Parts, loading"��xe "Library, loading"���1.	Select Load to load an existing WinDraft library file.

�

	    Figure 6-2:  The File to Open dialog box.

2.	Select Library (*.CLB) in the List Files of Type list box: all the library file names display in the Filename list box. �xe ".CLB extension"�

3.	Select a library filename.

4.	Click on OK with the left mouse button to load the library file.

Part�xe "Part command"�

��Use this command to view the library contents, or to select a part and load it into WinDraft's library editor.

This command is available only if a library file has been loaded into WinDraft.



��To load a part follow these steps:

Click with the left mouse button on File.  The File pull-down menu displays.

Click with the left mouse button on Part.  The Get Part dialog box�xe "Get Part dialog box"� displays.

�

Figure 6-3: The Get Part dialog box.

Enter a part prefix (e.g. 74LS*) in the Filter entry box�xe "Filter entry box"� to display only the parts with name starting with the entered prefix.  Click on the Scan button�xe "Scan button"� to display these parts in the Parts list box�xe "Parts list box"�.

Highlight the part you want to load in the work-area by clicking on its name in the Parts list box. You can also directly enter the name of the part in the Selected Part entry box.

Click on the OK button to load the selected parts and close the  Get Part dialog box. 

Save�xe "Save"� 

��Select Save to save the WinDraft library which you have been working on. ��Save As�xe "Save As"�

Select Save As to give a WinDraft library file a new name while saving the library file. 

Print�xe "Print"�

��WinDraft uses the standard printer and plotter drivers available for Windows; unless you specify otherwise, WinDraft prints to the Windows default printer�xe "printer, Windows default"�.  Refer to Chapter 2 for detail on how to print.��Print Preview

Use Print Preview to view the  sheet before you print.  The sheet will display according to the paper size you have selected in you print driver dialog box. 

Exit�xe "Exit"�

Use Exit to leave WinDraft.

Edit�xe "Edit menu"�

��Edit contains the menu selections in the Edit pull-down menu shown at left.

For detail on how to use the items in the Edit Menu, refer to Chapter 2: Reference. and Chapter 3: Editing.

��Place�xe "Place menu"�

��Place contains the menu selections shown in the Place pull-down menu at left.

Body�xe "Body"�

Use Body to create the outline of the part body.  Part creation must start with body placement. 

If the part contains graphics (such as IEEE symbols, lines, circles, etc.) the part body outline will not be displayed on the schematic.  If the part does not contain graphics, then the rectangular outline shape will be displayed as the part body on the schematic.

If you want the part body outline to display for parts with graphics, then you must physically draw the outline using the Place | Box command.

���

Figure 6-4: The 7400 on the left contains graphics therefore no body outline, the 1400 on the right does not contain graphics therefore the body outline displays.

To place a body, follow these steps:

1.	Select Body in the Place menu. The Place Body dialog box displays. 

�

Figure 6-5: The Place Body dialog box.

2.	Select the number of devices you need to define by selecting the Device per Pack�xe "Device per Pack"� pull-down list box.  This is used when there are more than one identical device in a single physical package.  For instance there are four identical NAND gates in a single 7400 TTL package.

3.	Select the Convert Form�xe "Convert Form"� check box if the part has a converted form for the part (such as a De Morgan equivalent�xe "De Morgan equivalent"� symbol of the part).

4.	Click on Place. Move the pointer to increase or decrease the part size. Point on the desired location for the body, and click on the left mouse button.

The X,Y display on the toolbar uses 10,000 units per inch.  The upper left corner of the new part body is always at (10000, 10000).  To create a part whose body is one inch square, move the pointer to (20000, 20000) to create the body.

���

Figure 6-6: A one inch part body.

Once you have defined the part body, use the Place menu commands to place items inside the body. No objects can be placed outside the body.  The pins will be allowed to be placed only on the body periphery.

(�NOTE: In case of more than one device in a part, when placing an item inside one body, the same item will be automatically placed inside all the other bodies.

If the part has a converted form (displayed on the right column), you can place different items inside the original body and inside its converted form.��(�NOTE: To change the name of a part that is loaded in the work-area, select the Place-Names command and enter a new name in the Name entry box.��How to resize an existing body�xe "resizing an existing body"�

1.	Position the pointer on the body edge and click on the left mouse button, the body is highlighted. 

2.	Move the pointer to resize the body.  You may resize the right and lower edge of the body.   The left and top edges are fixed.

3.	Click on the left mouse button to set the size.

� EMBED CorelDRAW.Graphic.6  ����CAUTION: Resizing a body that contains objects to a smaller size can have undesirable results.  Be careful when you resize to make sure that there is enough room for all objects within the new part size.

��If a part does not contain a line, circle, arc, polygon, text or IEEE symbol, it will be considered as a Block, otherwise it is a Graphic part�xe "Graphic part"�.  A Block part�xe "Block part"� is one whose body is a rectangle.  For example, the Intel 80386 is a block part; you do not need to draw lines around the body to display it as a Block. A Graphic part needs to have its edges defined.  For example, the AND gate is a graphical part, the same as for parts that comply with the ANSI�xe "ANSI"�/IEEE�xe "IEEE"� standard. Windraft will automatically convert the part into a Graphic part if lines or text is added within the limits of the body.

Creating parts without pin numbers

Parts can be created without pin numbers by selecting “0” (zero) Devices per Pack (Parts per Package) when you create the part body.  References (pin numbers) will not be used on the pins.  Only pin names will be used.  This is useful for creating parts like resistors that do not have pin numbers.

Line�xe "Line"�

��The Line command is used to draw a line inside the body.  A line may be drawn only if you have a part loaded or created on the work-area.��How to place a new line �xe "Line:placing on library part"�

1.	Select Line in the Place menu.

2.	Place the cursor at the location you want the line to begin. Click on the left mouse button. 

3.	Move the cursor to where you want the next vertex.



�EMBED Word.Picture.8������EMBED Word.Picture.8����EMBED Word.Picture.8����During wiring, you can change the wire geometry by selecting Geometry�xe "Geometry"� from the Place menu, or by pressing x key�xe "x key"� to toggle between :��¨	45 Deg.

¨	90 Deg.

¨	Arc 

¨	Any (angle)

You can also change the style of the line by selecting Place | Style to toggle between 

¨	Dashed 

¨	Solid

4.	When the pointer is located on the first end point of the line, click on the left mouse button to place the line.

5.	Continue placing the line as in the above step until you come to the location where you want the line to end. 

6.	Click once on the right mouse button (or press the Esc key) to end the line.

WinDraft remains in the Add Vector mode�xe "Add Vector Mode"� (as displayed on the Status Bar) so you can continue placing lines.  To exit Add Vector mode, press Esc or click on the right mouse button. �xe "Line:editing in library part"�

Refer to Chapter 3 : Editing Features , section Editing Wires, Lines and Buses for more details on how to edit, add vertex or cut a line.

Circle�xe "Circle"�

��The Circle command is used to place a circle inside the current body.  A circle can be drawn only if you have loaded a part or created a body on the work-area. ��How to place a new circle�xe "Circle:placing on library part"�

1.	Select Circle in the Place menu.

2.	Place the cursor at the location you want the center of the circle to be. Click on the left mouse button. 

3.	Move the pointer to size the circle. During drawing, you can change the style of the circle by selecting Place | Style to toggle between 

¨	Dashed 

¨	Solid

4.	Click on the left mouse button to place the circle. 

5.	Continue placing more circles having the same center as the previous ones by proceeding as in the above step

6.	Click once the right mouse button to end placing circles with the same center. 

WinDraft remains in the Add Circle mode�xe "Add Circle Mode"� (as displayed on the Status Bar) so you can continue placing more circles.  To exit Add Circle mode, press on Esc or click on the right mouse button. 

How to move an existing circle�xe "Circle:resizing in library part"�

1.	Point on the circle circumference,  click and hold down to select the circle. 

2.	Move the pointer to move the circle.

3.	Release the left mouse button.

Arc Center�xe "Arc Center"�

The Arc Center command is used to place an Arc with radius re-sizing during placement.

How to place an arc�xe "Arc:placing on library part"�

1.	Select Arc Center in the Place menu.

2.	Place the cursor at the location you want the arc to start.  Click on the left mouse button. 

3.	Move the pointer to scale the arc diameter. Click on the left mouse button to fix the arc diameter.  

4.	Move the mouse (right and left or up and down) to decrease and increase the arc angle, then click on the left mouse button to fix the arc.

5.	To continue placing more arcs having the starting coordinates at the ending coordinates of previous arc, click the left mouse button, then  proceed  as in the above step.

6.	Click once on the right mouse button to end placing arcs having the same beginning and ending points.

WinDraft remains in the Add Arc mode�xe "Add Arc Mode"� (as displayed on the Status Bar) so you can continue placing more arcs.  To exit Add Arc mode, press on Esc or click on the right mouse button. 

Keyboard commands when editing

¨	Change the arc quadrant�xe "arc quadrant"� by pressing Space bar.

¨	Backspace�xe "Backspace"� by pressing the Backspace key while in the Add Arc mode.  This will remove the previously placed arc.

Arc End Point�xe "Arc End Point"�

The Arc End Point  command is used to place an Arc with circumference re-sizing during placement.

How to place a new arc�xe "Arc:placing on library part"�

Select Arc End Point in the Place menu.

Place the cursor at the location you want the arc to start.  Click on the left mouse button. 

Move the mouse to position the locus of the arc.  The arc will always remain a 45 degree angle, and the starting point will remain fixed while moving the arc locus. Click on the left mouse button to fix the angle. 



Continue placing more arcs having the starting coordinates at the ending coordinates of previous arc, click the left mouse button then  proceed  as in the above step.

Click once on the right mouse button to end placing arcs having the same beginning and ending points.

WinDraft remains in the Add Arc mode�xe "Add Arc Mode"� (as displayed on the Status Bar) so you can continue placing more arcs.  To exit Add Arc mode, press on Esc or click on the right mouse button. 

(�NOTE: For finer drawing detail, change the grid setting to Small.  This will allow greater detail for drawing. Be sure to change back to a Pin grid before placing pins on the part.��Keyboard commands when editing

¨	Select 45 degree or 270 degree arc by�xe "arc quadrant"� pressing Space bar.

¨	Backspace�xe "Backspace"� by pressing the Backspace key while in the Add mode will remove the previously placed arc.

Text�xe "Text"�

�EMBED MSDraw  \* MERGEFORMAT����Text is used to include information inside the body of the part.  The Text command is not used for pin numbers, pin names, part values or reference designators.   It is only for placing user-defined arbitrary comment text on the part.

A text can be placed only if you have loaded a part or created a body on the work-area.  For information on how to place text, refer to Chapter 3:  Reference. Using Schematic Editor.��Pin�xe "Pin"�

Use the Pin command to add pins on a part.

How to add a new pin on the part�xe "Pins:adding on a library part"�

Select Pin in the Place menu to display the Add/Edit Pin dialog box.

�

Figure 6-7: The Add/Edit Pin dialog box.

Enter the pin name in the Name entry box.	�To enter a name with a bar (indicating negation�xe "negation"�), type \ after the string of characters. For example:

�Use this syntax:�To define the name:��Example 1:�I\N\P\U\T\�______

INPUT��Example 2:�RD/W\R\�       ___

RD/WR��Type the pin number in the Reference(s) entry box.



(�NOTE: In case of more than one device per package, you need to define more than one pin separated by a comma in the Reference(s) entry box, one pin for each device within the package.��To specify the shape of a pin, select one of the options in the Shape pull-down list box :

Shape�Example�Description�Length

(inches)��Line���A normal pin with a long line�3/10��Short���A pin with a short line�1/10��Clock���A clock symbol with a long line�3/10��Dot���indicates inversion with a long line�3/10��Dot Clock���represents an inverted clock symbol with a long line�3/10���xe "Pin shape:short"�

5.	Select one these options to select the type of the pin :

¨	In represents an input pin.�xe "Pin type:in"�

¨	Out represents an output pin.�xe "Pin type:out"�

¨	Input/Output indicates a bi-directional pin. It is either an input or output. For example, a bus transceiver is a bi-directional pin.�xe "Pin type:bidir"�

¨	Power represents a power pin.  A power pin will automatically connect to all other power pins on the schematic that have the same name (example VCC).�xe "Pin type:power"�

¨	Passive is a passive pin connected to a passive device. For example connectors have passive pins (not active).�xe "Pin type:passive"�

¨	3 States represents a 3 state pin that has three states:  low, high and high impedance.�xe "Pin type:3 states"�

¨	Open Col. represents an open collector pin.�xe "Pin type:open collector"�

¨	Open Emit. represents an open emitter pin.�xe "Pin type:open emitter"�



(�NOTE: In case of more than one device in a part, when placing a pin on one body, a pin with same name and other specifications but different reference will be placed automatically on the other bodies.

If the part has a converted form (displayed on the right column), you can place different pins on the original body and on its converted form.��6.	Click on Add to close the dialog box. Select one of the bodies and click on the left mouse button.  Then move the pointer around the periphery of the body, choose a location and click on the left mouse button to place the pin.�xe "Pins:placing on library part"�

7.	Click on the right mouse button to return in the Add/Edit Pin dialog box, proceed as above to place more pins.  Or click on Cancel to quit the Place Pin session.

How to modify an existing pin�xe "Pins:modifying on library part"�

1.	Double-click on the selected pin.  The Add/Edit Pin dialog box displays. 

2.	Modify the pin specifications and click on Change to accept the modifications.

Names�xe "Names"�

Use this command to assign a name to a part or to edit an existing name.  A part may have more than one name. Each part must have at least one name.

�

Figure 6-8: The Part Names dialog box.



��To add a new name to the part, click in the Name entry box, type in the new name and click on the Add button.  The name is added to the Names list box.����To remove a name from the Names list box, select the name in the list and click on the Delete button.����To modify an existing name, select the name in the Names list box. Edit the name in the Name entry box and click on the Modify button.��(�NOTE: To create a new part while a device is loaded in the work-area, select the Place | Names command and enter a new name in the Name entry box then click on Add.

��� EMBED CorelDRAW.Graphic.6  ����CAUTION: Deleting all names from the part will remove the part from the library.��Reference

This command is used to define or edit the part reference designator�xe "reference designator"�. 

1.	Select Reference in the Place menu to display the Part Reference Prefix�xe "Reference Prefix"� dialog box.

2.	Enter the part reference designator in the Reference Prefix entry box.  There is no need to add a “?” following the Reference Prefix, WinDraft will do this for you.  The annotate processor in the schematic editor will replace the "?" with the number indicating the instance of the part in the schematic.

(�NOTE: In case of multiple devices per part, WinDraft  automatically adds an alphabetic character suffix to the reference designator (e.g. A, B...).��3.	Click on Apply to assign the part reference designator to the part.

Field�xe "Field"�

This command is used to fill out the user defined Part Attributes�xe "Attributes, Part"� when defining or editing a library part.  By adding these part attributes you can pre-assign module names, stock numbers, or other information.  Assigning module�xe "module names"� names (also known as footprints�xe "footprints"� or packages�xe "packages"�) is extremely useful for PCB layout.  Programs such as WinBoard will read this information from the schematic and the module package is already pre-assigned.  For more information on Part Attributes, see Attr. Names.



To define the part attribute, Select Field in the Place menu.  This will open the User Part Field dialog box.



	�

	    Figure 6-9: The User Part Fields  dialog box.



Use the Field Attribute text box to select the attribute name you want to assign.  

Use the Value text box to enter or change the value of the attribute.



To assign a module footprint to a part, follow these steps :

Open the User Part Fields dialog box.

Select Module Name in the Fields text box.

Type in the module value in the Value text box, such as 14dip300.

Press OK.

(�NOTE: When you assign an attribute value to a part, all parts with the same name will use this information.  This is not always a good idea.  For example : if you assign CK05 to the part CAP, then all CAP parts will carry the CK05 module name.  You can always change this information on the schematic when the part is placed, however be aware of what information you assign a part in the library editor.��Filled Circle�xe "Filled Circle"�

The Filled Circle command is used to place a filled circle on the current part.  A filled circle can be placed only if you have loaded a part or created a body on the work-area.  

How to place a filled circle�xe "Filled Circle:placing"�

1.	Select Filled Circle in the Place menu.

2.	Place the cursor at the location you want the center of the filled circle to be. Click on the left mouse button. 

3.	Move the cursor to size the filled circle, then click on the right mouse button. 

WinDraft remains in the Add Circle mode�xe "Add Circle Mode"� (as displayed on the Status Bar) so you can continue placing more circles.  To exit Add Circle mode, press on Esc or click on the right mouse button. 

Filled Polygon�xe "Filled Polygon"�

The Filled Polygon command is used to place a filled polygon on the current part. A filled polygon can be placed only if you have loaded a part or created a body on the work-area.

How to place a filled polygon�xe "Filled Polygon:placing"�

1.	Select Filled Polygon in the Place menu.

2.	Place the cursor at the location you want the polygon to begin. Click on the left mouse button. 

3.	Move the cursor to where you want the next vertex, then click on the mouse button. 

4.	Continue drawing the polygon as in the above step until you come back to the starting location. 

5.	Click once on the right mouse button to fill the polygon.  Then click on the right mouse button to complete the polygon.  If the polygon is not closed properly, WinDraft will close it automatically.

WinDraft remains in the Add Polygon mode�xe "Add Vector Mode"� (as displayed on the Status Bar) so you can continue placing lines. To exit Add Polygon mode, press on Esc or click on the right mouse button. 

�EMBED Word.Picture.8������EMBED Word.Picture.8����EMBED Word.Picture.8����During wiring, you can change the wire geometry by selecting Geometry�xe "Geometry"� from the Place menu, or by pressing x key�xe "x key"� to toggle between : 45 degree, 90 degree, Arc, or Any Angle.��Get Vector Def.�xe "Get Vector Def."�

Use this command to import graphical shapes�xe "import graphical shapes"� from an existing part in the library. This graphical entity can be imported :

¨	From the normal form of the part in the library to the normal or converted (De Morgan) form of the new part displayed in the work-area.

¨	From the converted form of the part in the library to the normal or converted (De Morgan) form of the new part displayed in the work-area.

How to import a vector definition

1.	Select Get Vector Def. in the Place menu. The Get Vector Definition dialog box displays.

�

Figure 6-10: The Get Vector Definition dialog box.

2.	Select a library in the Libraries list box then select a part in the Part list box. If the part has no vector definition, WinDraft displays the following message :

This part has no vector definition

meaning that the selected part is a block part (it does not contain a graphical definition that can be imported). 

3.	If the part contains a vector definition, the Get Vector Definition Option dialog box displays.  Select one of the options in the Normal Vectors�xe "Normal Vectors"� list box: 

¨	Not Transferred does not import the vector definition.

¨	Transf. on Normal�xe "Transf. on Normal"� to import from the normal form�xe "normal form"� of the part in the library to the normal form of the new part displayed in the work-area.

¨	Transf. on Convert�xe "Transf. on Convert"� to import from the normal form of the part in the library to the converted (De Morgan) form�xe "converted form"� of the new part displayed in the work-area.

4.	You can access the Convert Vectors list box ONLY if the part displayed in the work-area has a converted form. Select one of these options : 

¨	Not Transferred does not import the vector definition.

¨	Transf. on Normal�xe "Transf. on Normal"� to import from the converted (De Morgan) form of the part in the library to the normal form�xe "normal form"� of the new part displayed in the work-area.

¨	Transf. on Convert�xe "Transf. on Convert"� to import from the converted (De Morgan) form�xe "converted form"� of the part in the library to the converted form of the new part displayed in the work-area.

IEEE�xe "IEEE"�

Use the IEEE command to place IEEE symbols that comply with the ANSI/IEEE standard. Most symbols must be placed inside the body in order to conform to the IEEE standard.

How to place a new IEEE symbol�xe "IEEE symbols:placing on library part"�

Select IEEE in the Place menu to display the Place/Edit IEEE Symbols dialog box. 

�

Figure 6-11: The Place/Edit IEEE Symbols dialog box.

2.	Select the symbol of your choice by clicking in the corresponding radio button.

3.	Set the width and height of the symbol respectively in the X Size and Y Size entry boxes.  The units used are 1/10,000 of an inch.�xe "IEEE Symbols:sizes"�

4.	Click on the Place button to close the dialog box. Move the pointer to the location you want to place the IEEE symbol then click on the left mouse button to place the symbol. 	�You can place the same symbol as many times as needed. 

5.	Click on the right mouse button to return to the dialog box. Click on the Cancel button to leave the IEEE command.

How to change an existing IEEE symbol�xe "IEEE Symbols:editing"�

1.	Double-click onto the selected IEEE symbol. The Place/Edit IEEE Symbols displays. 

2.	Select a new symbol specifications and click on Change to accept the modifications.

Book Mark�xe "Book Mark"�

�The bookmarks set locations on the library. You can specify up to five different bookmarks on a part. 

These locations are only for your convenience while creating or editing a part or sheet.  They allow you to quickly jump to a particular location without having to scroll with the mouse.  See Edit | Jump.��How to set a book mark:�xe "Book Mark:setting on library part"�

1.	Select Book Mark from the Place menu. The cascading bookmarks menu displays.

2.	Select one of the bookmarks from the list. Position the cursor to the desired location and click on the left mouse button to place the bookmark. The Set BookMark Name dialog box displays.

3.	To change the name of the bookmark, enter a string of character in the Bookmark Name entry box.  Then click on OK to close the dialog box.�xe "Book Mark:changing the name"�

4.	Use the Jump command from the Edit menu when you want to jump to this bookmark location. �xe "Book Mark:jump to"�

Select Clear from the Book Mark command to reset all the specified bookmarks.�xe "Book Mark:clearing"�

Geometry�xe "Geometry"�

�EMBED Word.Picture.8������EMBED Word.Picture.8����EMBED Word.Picture.8����While drawing line or polygon, you can change the wire geometry by selecting Geometry from the Place menu, then select either 45 degree, 90 degree, Arc or Any angle.��

x�Hotkeys: Use the X key�xe "X key"� at any time while you place wires to toggle between: 45 Degree, 90 Degree, Arc, Any (angle)..�xe "+ key"��xe "- key"���Style�xe "Style"�

During line, arc or circle drawing, you can change their style by selecting Style from the Place menu, then select either Dashed or Solid.

Utilities�xe "Utilities"�

��The Utilities menu contains the menu selections shown in the pull-down menu at left. 

WinDraft Utilities menu includes the five following processors ��¨	Decompile Library�xe "Decompile Library"� decompiles the loaded WinDraft binary library file into the equivalent ASCII file.

¨	Compile Library�xe "Compile Library"� compiles a WinDraft ASCII library file�xe "ASCII library file"� into the equivalent binary file.

¨	List Library�xe "List Library"� lists the names of the parts in the loaded library in an ASCII text file.

¨	Report Pinout�xe "Report Pinout"� allows you to list, edit or modify the all the part's pins specifications in a single step. 

¨	Part Info�xe "Part Info"� lists the current part specifications : part name and dimensions, number of packages per pack, etc.

Statistics

This reports statistics for all open worksheets and editors in WinDraft.  It is useful to see the number of total pins used in a design.

Decompile Library�xe "Decompile Library"�

The Decompile Library processor decompiles the loaded WinDraft binary library file into the equivalent ASCII file.   Refer to   Appendix C for the ASCII file syntax. This will allow the exchange of libraries with other systems.

When you select Decompile Library, the dialog box displays :

¨	Output File. Specifies the ASCII library file name. If the output file name is not specified, the default ASCII library file name is <current library name>.SLB (Source LiBrary).�xe ".SLB extension"�

¨	Search. Opens the file selection dialog box.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

Click on Execute. During execution, WinDraft generates a log file and an equivalent ASCII  file. 

The log file contains all the process steps. Restore this window to check if WinDraft has generated any warning or error messages during the process.

Compile Library�xe "Compile Library"�

The Compile Library processor compiles a WinDraft ASCII library file into the equivalent binary file. Refer to Appendix C for the ASCII file syntax. This will allow the exchange of libraries with other systems.

1.	When you select Compile Library, the dialog box displays :

¨	Output File. Specifies the binary library file name. If the output file name is not specified, the default binary library file name is <current library name>.CLB (Compiled LiBrary).�xe ".CLB extension"�

¨	Search. Opens the file selection dialog box.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

2.	Click on Execute in the Compile Library dialog box. The Source Library dialog box displays. 

3.	Select the ASCII library file and click on OK. During execution, WinDraft generates a log file and converts the ASCII library file into its equivalent binary library file. 

The log file contains all the process steps. Restore this window to check if WinDraft has generated any warning or error messages during the process.

List Library�xe "List Library"�

The List Library command lists the names of the parts in the loaded library. The list is saved in an ASCII text file you can view or edit with any text editor. An example of the AMD.CLB library listing is :

Library 'windraft' -- No prefixes for these parts	�	�53RA1681	53RS1681	53RS881	53S281		53S3281�53S881		57401		57402		57413A		57C401�57C4013	57C402		57C4023	57C4033	63RA1681�63RS1681	63RS881	63S281		63S3281	63S881

Another example is a listing of TTL1.CLB library :

Library 'TTL1' -- Prefixes series #1	��	74LS	74S	74ALS	74AS	74HCTLS	74HCT	74HC�00	**	**	**	**	**	**	**�01	**	**	**	..	**	..	**�02	**	**	**	**	**	**	**�03	**	**	**	..	**	**	**�04	**	**	**	**	**	**	**�08	**	**	**	**	**	**	**

The two asterisks indicate that the part exists in the library. The two periods indicate that the part is not in the library.

Select List Library in the Utilities menu to display the List Library dialog box. Then set the following options :

¨	Output File. Specifies the new list file name. �xe ".LST extension"�

¨	Search. Opens the file selection dialog box.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

When List Library has been completely configured, click on Execute to launch the list library process.

During execution, WinDraft generates a log file that contains all the process steps. Restore this window to check if WinDraft has generated any warning or error messages during the process.

Report Pinout�xe "Report Pinout"� 

This processor allows you to list, edit or modify all the part's pin specifications in a single step. 

1.	Select Report Pinout in the Utilities menu. The View/Edit Pinout dialog box displays. The Pins box dislays all the part's pin specifications:  pin number, pin name, pin type and pin shape.



�

Figure 6-12: The View/Edit Pinout dialog box.

¨	If the component has a converted form, activate the Converted Pins�xe "Converted Pins"� check box to list the converted form pin specifications. Unselect to activate the normal form pin specifications. The Converted Pins check box is not accessible if the part does not have a converted form.

2.	Highlight a line in the Pins list box. The Ref, Name, Type and Shape entry boxes are updated with the corresponding values.

¨	Ref contains the pin reference numbers for each instance of the device within the package. Select this entry box to modify any of the pin numbers. Each pin reference number must be separated by a comma.�xe "Pin:ref"�

¨	Name contains the pin name.  Select this entry box to modify the pin name. Each pin must have ONLY ONE name. 

	To enter a name with a bar (indicating negation�xe "negation"�), type \ after each character in the string. For example, type :�xe "Pin:name"�

	�	I\N\P\U\T\ 	



	to define the name:

		______

	INPUT

Type contains the pin electrical specification. Select the pin type in the pull-down list box.  For a list and description of these, refer to Pin earlier in this chapter.�xe "Pin:type"�

¨	Shape contains the pin shape. Select the pin shape in the pull-down list box.   For a list and description of Shapes, refer to the section earlier in this chapter on Pin.�xe "Pin:shape"��xe "Pin:shape:short"�

3.	After each line modification, click on Apply to accept the changes. 

4.	Click on Cancel to close the dialog box.  (Changes you made will not be stored to disk until you select File | Save or File | Save As.)

Part Info�xe "Part Info"�

The Part Info command is used to list the current part specifications�xe "part specifications"�: part name, dimensions, number of devices per pack, etc.

Select Part Info to display the Part Info dialog box.

�

Figure 6-13: The Part Info dialog box.

¨	Part Name�xe "Part Info:part name"� 

¨	Device Dimensions�xe "Part Info:device dimensions"�

¨	Device per Package�xe "Part Info:devices per package"�

¨	Number of Pins (Normal): the normal form. Defines the number of pins per device which includes the number of power pins.

¨	Number of Pins (Convert): the converted (DeMorgan) form. Defines the number of pins per device. 

¨	Number of Name(s) attached represents the number of names assigned to the current part displayed on the screen. Use the Place | Name command to list the attached names.�xe "Part Info:number of names attached"�

�xe "Part Info:number of vector definitions attached"�

(�NOTE: Modifying or editing a graphical representation will change all the  parts assigned to this graphical representation.��� EMBED CorelDRAW.Graphic.6  ����CAUTION: Use CAUTION when editing a graphical representation that is attached to more than one vector definition as all part will be changed.��Click on Cancel to close the dialog box and to return into the work-area.

Properties�xe "Properties"�

��The Properties menu is used to define system setting values. This menu contains the menu selections shown in the pull-down menu at left.

For information on using these items, refer to Properties in Chapter 2.���

Chapter 7:  Title Block Editor�xe "Title Block Editor"�

This chapter describes the WinDraft title block editor.  A title block is a special graphical entity that contains user defined parameters.  These parameters include: user name, company name, sheet size or sheet file name.  

In this chapter, menus are listed in the order they display when you are editing a title block.  The WinDraft title block editor uses seven pull-down menus : File, Edit, Place, Utilities, Properties, Window and Help.

File�xe "File menu"�

��When you are opening a new title block file and no other window is open, File contains the menu selections shown in the pull-down menu at left. 

New��How to create a title block file�xe "Title Block:creating"�

1.	Click with the left mouse button on File.  The File pull-down menu displays.

2.	Click with the left mouse button on New.  The New dialog box displays.

3.	Click once with the left mouse button on the Title Block radio button to create a new Title Block. 

		�

		Figure 7-1: The New dialog box.



4.	Click in the Name text entry box and enter the name of the new title block file. The file name is limited to twenty-one characters (use a maximum of eight characters for Windows 3.1)�xe "file name limitations"�. Use the three character file extension. .TBL for all WinDraft title blocks.�xe ".TBL extension"�

5.	Select OK to close the dialog box and open the title block editor.

Load�xe "Load title block file"�

��How to load an existing title block file�xe "Title Block:loading"���1.	Click on the Load button shown above or select File | Load from the main menu to load an existing WinDraft title block file.

2.	Select Title Block (*.TBL) in the List Files of Type list box: all the title block file names display in the Filename list box. 

3.	Select a title block filename.

4.	Click on OK with the left mouse button to load the title block file.

Save �xe "Save"��xe "Title Block:saving"�

��Select Save to save the WinDraft title block that you have been editing.  Save works similarly to the Save option in other Windows-based applications.

��Save As�xe "Save As"��xe "Title Block:Save As"�

Select Save As to give a WinDraft title block file a new name while saving the title block file.  Save As works similarly to the Save As option in other Windows-based applications.

Print�xe "Print"��xe "Title Block:printing"�

�

�WinDraft uses the standard printer and plotter drivers available for Windows. Unless you specify otherwise, WinDraft prints to the currently selected printer.  For information on the Print command, refer to Chapter 2.��Exit�xe "Exit"�

Use Exit to leave WinDraft.

Most Recently Used Files List�xe "Most Recently Used Files List"�

The files listed at the end of the File menu represent the most recently used files. This list provides quick access to recently used files without requiring the user to navigate through a set of menus and dialog boxes to specify the location of the files. 

The maximum number of files in the list is five.

Edit�xe "Edit menu"�

��Edit contains the menu selections in the Edit pull-down menu shown at left.

For detail on how to use the items in the Edit Menu, refer to Chapter 2: Reference. and Chapter 3: Editing.

��Place�xe "Place menu"�

��Place contains the menu selections shown in the Place pull-down menu at left.  These are the main drawing items used to create or edit a title block.  

Most of these items is explained in previous chapters. For unreviewed portions of this section please refer to Chapter 6:  Library Editor.

��Text

The Text command is used to include information on the title block.  Details relating to placing comment text and selecting fonts are discussed in Chapter 2.

Controls�xe "Controls"�

Once a title block has been added to a sheet, the controls items will be updated automatically by WinDraft (creation date�xe "creation date"��xe "Title Block:creation date"�, modification date�xe "modification date"��xe "Title Block:modification date"�, schematic filename�xe "schematic filename"��xe "Title Block:schematic filename"�, sheet size�xe "sheet size"��xe "Title Block:sheet size"�) to reflect the current sheet description. 

The other control items (organization name�xe "organization name"��xe "Title Block:organization name"�, addresses�xe "addresses"��xe "Title Block:addresses"�, documentation number�xe "documentation number"��xe "Title Block:documentation number"�, revision code�xe "revision code"��xe "Title Block:revision code"�, number of folio�xe "number of folio"��xe "Title Block:number of folio"� and user extension�xe "user extension"��xe "Title Block:user extension"�) will be updated from a "delimited" description ASCII file previously created with a text editor or generated by database.  Refer to the Appendix A of this manual for more information regarding this syntax of the controls ASCII file.

How to place a control item on the current title block�xe "Controls:placing on a title block"��xe "Title Block:placing controls"�

1.	Select Place-Controls. The Add/Edit Control dialog box displays.



�

Figure 7-2:  The Add/Edit Control dialog box.

2.	Select the control in the Controls list. 

3.	You can set the horizontal and vertical sizes of the text using X Size and Y Size entry boxes.�xe "Title Block:setting text sizes"��xe "Text:setting size in title block"�

4.	Select the orientation of the text by clicking on the corresponding Orientation arrow.�xe "Title Block:setting orientation of text"��xe "Text:setting orientation in title block"�

5.	The text can be X or Y mirrored by selecting the options:�xe "Title Block:mirroring text"��xe "Text:mirroring in title block"�

	¨	X Mirror 

	¨	Y Mirror

6.	The control can be enclosed into a frame. Click on the Boxed check box before clicking on Place.�xe "Title Block:placing boxed text in"��xe "Text:boxing in title block"�

7.	Make sure the Auto Scale option is not selected. Click on Place and position the pointer on the desired location and click on the left mouse button.�xe "Title Block:auto-scaling text"��xe "Text:auto-scaling in title block"�

8.	You can place the same control as many times as needed. Click on the right mouse button to return in the Add/Edit Controls dialog box. 

9.	Click on Cancel to quit the Place Mode.

If Auto Scale is selected, the control can be sized directly during its placement. In that case, you do not need to enter the X and Y sizes :

1.	Select the control in the Controls list box.

2.	Select Auto Scale and click on Place to close the dialog box.

3.	Position the pointer on the desired location and click the left mouse button to anchor the control.  Move the mouse up or down to change the Y size, move right or left to change the X size.  Click on the right mouse and reposition the control.  Click twice on the left mouse button.

Keyboard commands when editing control item

¨	Rotate or mirror the control item by using the arrow keys�xe "arrow keys"�.

¨	Box the control item in a frame by pressing B key�xe "B key"�.

¨	Enlarging the size of the control item by pressing + key�xe "+ key"�.

¨	Shrink the control item size by pressing - key�xe "- key"�.

Book Mark�xe "Book Mark"�

The bookmarks set locations on the title block.  You can specify five different bookmarks on the title block window.

How to place a book mark�xe "Book Mark:placing in title block"��xe "Title Block:placing book mark"�

1.	Select Book Mark from the Place menu.  The cascading bookmarks menu displays.

2.	Select one of the bookmarks from the list. Position the cursor to the desired location and click on the left mouse button to place the bookmark.  The Set BookMark Name dialog box displays.

3.	To change the name of the bookmark, enter a string of character in the Bookmark Name entry box. Then click on OK to close the dialog box.  �xe "Book Mark:changing name in title block"��xe "Title Block:changing name of book mark"�

4.	Use the Jump command from the Edit menu when you want to jump to this bookmark location.�xe "Book Mark:jumping to in title block"��xe "Title Block:jumping to bookmark"�



Select Clear from the Book Mark command to reset all the specified bookmarks.�xe "Book Mark:clearing in title block"��xe "Title Block:clearing bookmarks"�

Geometry�xe "Geometry"��xe "Geometry:setting in title block"��xe "Title Block:setting geometry"�

�EMBED Word.Picture.8������EMBED Word.Picture.8����EMBED Word.Picture.8����While drawing, you can change the wire geometry by selecting Geometry�xe "Geometry"� from the Place menu, or by pressing x key�xe "x key"� to toggle between : 45 degree, 90 degree, Arc, or Any Angle.��Style�xe "Style"��xe "Title Block:setting the style"��xe "Style:setting in title block"�

During line, arc or circle drawing, you can change the style by selecting Style from the Place menu, then choosing either Dashed or Solid.

Utilities�xe "Edit menu"�

��Utilities contains the menu selections in the Utility pull-down menu shown at left.

��Statistics

This reports statistics for all open worksheets and editors in WinDraft.  It is useful to see the number of total pins used in a design.

Decompile Title Block

The Decompile Title Block processor decompiles the loaded WinDraft title block file into the equivalent ASCII file.   Refer to   Appendix C for the ASCII file syntax. 

When you select Decompile Title Block, the dialog box displays :

�

Figure 7-3:  The Add/Edit Control dialog box.



¨	Output File. Specifies the ASCII file name. If the output file name is not specified, the default ASCII file name is <current name> 

¨	Search. Opens the file selection dialog box.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

Click on Execute. During execution, WinDraft generates a log file and an equivalent ASCII  file. 

The log file contains all the process steps. Restore this window to check if WinDraft has generated any warning or error messages during the process.

Compile Title Block

The Compile Title Block processor compiles a WinDraft ASCII file into the equivalent binary file. Refer to Appendix C for the ASCII file syntax. 

�

Figure 7-4:  The Add/Edit Control dialog box.

1.	When you select Compile, the dialog box displays :

¨	Output File. Specifies the binary file name. If the output file name is not specified, the default binary file name is <current name>

¨	Search. Opens the file selection dialog box.

¨	Verbose Mode. Select this option to have a complete report, otherwise WinDraft will generate a report on errors and warnings only.

2.	Click on Execute in the Compile Title Block dialog box. The Source dialog box displays. 

3.	Select the ASCII file and click on OK. During execution, WinDraft generates a log file and converts the ASCII library file into its equivalent binary file. 

The log file contains all the process steps. Restore this window to check if WinDraft has generated any warning or error messages during the process.















�Appendix A:  Keyboard Commands�xe "Keyboard Commands"�

There are some commands you may enter simply by pressing one key on the keyboard.  These commands are listed in the tables below.  

Wiring and Drawing Key Commands

Key�Command Description��A�Again:  Does the same command again at the "cursor location".  Use to place a wire again starting at the cursor.��B�xe "B key"��Text mode:  use the B key to Box text�xe "Box text"��xe "Text:boxed"� during placement.  Pressing the key will toggle the box setting on and off.  Wire Mode:  use the B key to Begin�xe "Begin"�.��D�xe "D key"��Toggles through Grid displacement:  Small, Free, and Pin.�xe "Cursor toggle"���I�xe "I key"��Change the geometry type.  Toggles through Line, Circle or Box.�xe "Geometry toggle"���J�xe "J key"��Use the J key to add a Junction�xe "Junction"� while in wiring mode.��M�xe "M key"��Set Target Mode while in wiring mode.��N�xe "N key"��Use the N key to End�xe "End"� while in wiring or line drawing mode.��R�xe "A key"��Repeat command�xe "Again command"�, repeats previous command such as placing a wire or label text.��S�xe "S key"��Snap to pin�xe "Snap to pin"�.��U�xe "U key"��Unselect Target Mode�xe "Unselect Target Mode"�.��X�xe "X key"��Toggle through style settings for the selection.  For Drawing objects, wires, and buses use the X key to toggle geometry: 45(�xe "45"�, 90(�xe "90"�, Arc�xe "arc"�, and Any Angle�xe "any angle"�.  Also, toggles through styles for:  Junctions�xe "Junctions"�, Module Port�xe "Module Port"�, Net type�xe "Net type"�, and Part type�xe "Part type"�.��Z�xe "Z key"��Refresh the screen with the current pointer location as the center of the screen.�xe "Screen refresh"���Function Key Commands

Key�Command Description��F1�xe "F1 key"��Press F1 for on-line Help�xe "on-line Help"�.��F2�xe "F2 key"��Zoom in�xe "Zoom in"� with the current pointer location as the center of the screen.��F3�xe "F3 key"��Zoom out�xe "Zoom out"� with the current pointer location as the center of the screen.��F4�xe "F4 key"��Screen Refresh�xe "Screen Refresh"�.��F5�xe "F5 key"��Center�xe "Center"� the Screen at the cursor location.�xe "Screen center"���F9�xe "F9 key"��Best Fit�xe "Best Fit"�.��Zoom Key Commands

Key�Command Description��Home�xe "Home key"��Zoom in�xe "Zoom in"� with the current pointer location as the center of the screen.��End�xe "End key"��Zoom out�xe "Zoom out"� with the current pointer location as the center of the screen.��Z�xe "Z key"��Refresh the screen with the current pointer location as the center of the screen.�xe "Screen refresh"���Object Manipulation and Misc. Key Commands

Key�Command Description��+ or -�xe "+ key"��xe "- key"��Use the + or - keys on the 10 key pad to increase or decrease (scale) settings.  For example:  scale a part larger or smaller during placement or scale the junction size.�xe "Scale settings"���Ctrl�xe "Ctrl key"��Use the Ctrl key to prevent auto pan�xe "auto pan"�.  When drawing, WinDraft enters an auto pan mode.  To prevent auto pan, press the Ctrl key while moving the mouse to the toolbar, etc.��Back space�xe "Backspace key"��Backspace and Backtrack�xe "Backtrack"�.  Backtrack or undo a segment�xe "undo a segment"� while placing a wire, bus, or line. ��( or (�xe "Up arrow key"��xe "Down arrow key"��Use the arrow cursor keys to mirror�xe "mirror"� in the  X or Y direction.  De-select the Num Lock key to use these on the 10 key pad.��( or (�xe "Left arrow key"��xe "Right arrow key"��Use the arrow cursor keys to rotate�xe "rotate"� an object clockwise or counter-clockwise.  De-select the Num Lock key to use these on the 10 key pad.��

�Numeric Key Pad Commands

The numeric key pad�xe "numeric key pad"� can be used to issue commands to WinDraft. 

The Num Lock�xe "Num Lock"� must be off for the numeric key pad to function as indicated below. The numeric key pad is shown in the figure below with the command each key is used for.

�



The Num Lock�xe "Num Lock"� must be on for the numeric key pad to function as indicated below. The numeric key pad is shown in the figure below with the command each key is used for.

�

�Appendix B :  Title Block Control�xe "Title Block Control Items"�

This Appendix lists the control placeholder items used on a title block. 

Controls�xe "Title Block:Controls"��xe "Controls"�



<Title> :  �Document title��<Organization> : �Company Name��<Address #1> : �Organization address #1 ��<Address #2> : �Organization address #2 ��<Address #3> : �Organization address #3��<Address #4> : �Organization address #4 ��<Address #5> : �Organization address #5��<Creation Date> : �Schematic creation date��<Modification Date> :�Schematic last modification date��<Schematic File Name> : �Schematic file name��<Sheet Size> :�Schematic sheet size��<User Name #1> :  �User's first name��<User Name #2> : �User's last name��<Document #> : �Document number��<Rev.> : �Revision code��<Nb Folio> : �Number of folios��<Folio> : �Folio number��<User Ext.#1> : �User's extension field #1��<User Ext.#2> : �User's extension field #2��<User Ext.#3> : �User's extension field #3��<User Ext.#4> : �User's extension field #4��<User Ext.#5> : �User's extension field #5��<User Ext.#6> : �User's extension field #6��<User Ext.#7> : �User's extension field #7��<User Ext.#8> : �User's extension field #8��<User Ext.#9> : �User's extension field #9��<User Ext.#10> : �User's extension field #10��

The italic control fields are automatically modified by WinDraft :

¨	<Sheet size> is updated when Sheet size in the Properties | Setup | Sizes dialog box has been modified.

¨	<Creation date> set the schematic "creation date" when the schematic is saved for the first time on the disk.

¨	<Modification date> set the schematic "modification date" every time the sheet has been edited and saved to the disk.

¨	<Schematic file name> is updated when the Save as command is used.

Import/Export Data Format�xe "Title Block:Import/Export Data Format"�

WinDraft can import and export title blocks to and from external data files in a delimited ASCII format (this format is the most commonly used file format). When viewed with a text editor, title block data is saved in the delimited ASCII format displayed as follows :



"7 Segments", "IVEX Design International", "15232 NW Greenbrier Parkway", "Beaverton, Oregon 97006", "USA", "Tel: (503) 531-3555", "Fax: (503) 629-4907", "XILINX (c)", "", "12011994", "1.0", "2", "1", "", "", "", "", "", "", "", "", "", ""



Each field in the file is surrounded by a delimiter�xe "Title Block:import/export file delimiter"�, which is the double-quote character. Adjacent fields are separated by a field separator�xe "Title Block:import/export file field separator"�, which is a comma.  Carriage returns and line feeds cannot be embedded within the data.



When the field is blank, that field's position in the record should contain empty quotes, as shown in the last records above. In the delimited ASCII format, fields are referenced by their position in the record, for instance, in the example above: title, organization name, address #1, address #2, etc.



The field positions in the delimited ASCII file are detailed in the following table:



Field position �Field name��1  �<Title>  ��2�<Organization> ��3�<Address #1> ��4�<Address #2> ��5�<Address #3> ��6�<Address #4> ��7�<Address #5> ��8�<User Name #1>  ��9�<User Name #2>��10�<Document #> ��11�<Rev.> ��12�<Nb Folio> ��13�<Folio> ��14�<User Ext.#1> ��15�<User Ext.#2> ��16�<User Ext.#3> ��17�<User Ext.#4> ��18�<User Ext.#5> ��19�<User Ext.#6> ��20�<User Ext.#7> ��21�<User Ext.#8> ��22�<User Ext.#9> ��23�<User Ext.#10> ��



Following is an example of an ASCII database:



Title: 	     "Sample 1",

Organization:   "Ivex Design International",

Address1:       "15232 NW Greenbrier Pkwy",

Address2:       "Beaverton, OR 97006",

Address3:       " ",

Address4:       " ",

Address5:       " ",

User Name1:     "Joe Engineer",

User Name2:     "Mike Engineer",

Document:       "2-78",

Revision:       "28",

Total Pages:    "7",

Page No.:       "1",

Users Ext1:     "Rev 19. 3/24/1997 BG",

Users Ext2:     "Rev 20. 3/29/1997 GM",

Users Ext3:     "Rev 21. 4/01/1997 JP",

Users Ext4:     "Rev 22. 4/02/1997 GM",

Users Ext5:     "Rev 23. 4/04/1997 DM",

Users Ext6:     "Rev 24. 4/07/1997 BG",

Users Ext7:     "Rev 25. 4/07/1997 TR",

Users Ext8:     "Rev 26. 4/10/1997 SM",

Users Ext9:     "Rev 27. 4/29/1997 BG",

Users Ext10:    "Rev 28. 4/30/1997 PL"�Appendix C�xe "Appendix C"�: ASCII File Description�xe "ASCII File Description"�

Introduction

Three sets of commands allow WinDraft to communicate with others programs:



Decompile / Compile Sheet

Decompile / Compile Library

Decompile / Compile Title Block



Generated Files are ASCII Files and their descriptions are given in this document.

The entire Grammar and an example of ASCII Sheet is given at the end of the document. 

This grammar (slightly modified to make it more readable) is exactly the one implemented in WinDraft using LEX (Lexical Analyzer Generator) and YACC (Yet Another Compiler-Compiler) to generate the corresponding code.

 

ASCII Description of Title Block or Active Library in ASCII Sheet are exactly the same as the standalone one.

Description 

In the following descriptions, line feeds are not necessary but they make the document more readable.

Spaces are necessary only to separate Language Key Words (TITLEBLOCK, LIB, ...) and individuals token (integers, ...)

All the coordinates and dimensions appears in Tenth of Mils (1/10000 Inch)

Title Block ASCII File Description

An ASCII Title Block File have the following structure:



(TITLEBLOCK

  (IDENTIFICATION

    (SHEETSIZE  'B' )

    (COMPANYNAME 'Ivex' )

    ............

  )

  (CONTROLS

    (TEXT 0 (POS 3456 1234) (SIZE 1000 1500) 'Ivex' TBLOCK COMPANYNAME )

    ...................

  )

  (VECTOR

    (LINE DRAW DASHED (POS 20000 35000) (POS 20000 40000) )

    .................... (all possible ITEMS are listed below)

  )

)





IDENTIFICATION section must appear even if there are no particular identifications. Identifications are for instance, company name, user first name, creation date and so on. It gives the value of each defined control. Different values of identifications are given by the grammar rule "identify"



CONTROLS and VECTOR sections are optional.



CONTROLS section contains only TEXT items with attribute TBLOCK xxxxx

where xxxxx is the name of the control selected like USER4 for instance ("tmpl_idx" rule in grammar). It gives the attributes of the control (rotate, mirror, position, value and size). If corresponding control appears in IDENTIFICATION section, its value must be the same.



VECTOR section contains items that define the title block form and topology.

Library ASCII File Description

An ASCII Library File has the following structure:



(LIB 'Library name'

  (PFXS

    (PFX '74LS' = 'LS' )

    (PFX '74' )

    ............

  )

  (PARTS

    (LPART

      (PART

        (COMMON

          (TYPE STANDARD 1 )

          (SIZE 8000 12000 )

          (SHEETPATH 'qsdf' )

          (REFERENCE 'U?' )

        )

        (NORMAL

          (PINS

            (PIN 'az' IO RIGHT (POS 0 5000)

              '3'

            )

            ..............

          )

          (VECTOR

            (LINE (POS 20000 35000) (POS 20000 40000) )

            .................... (all possible ITEMS are listed below)

          )

        )

        (CONVERT

          (PINS

            (PIN 'az' IO RIGHT (POS 0 5000)

              '9'

            )

            ..............

          )

          (VECTOR

            (LINE (POS 20000 35000) (POS 20000 40000) )

            ....................

          )

        )

      )

      (ALIAS

        (NAME 'azerty'

          (ATTRIBUTE 'attr' VIS SET (POS 10000 15000) )

          ....................

        )

      )

    )

    ...................

  )

)



LIB string is necessary and define the library name



PFXS section is optional and define the prefixes list



PFX section is optional and define a prefix with, eventually the equal sign and the prefix shortcut



LPART section is optional and defines a PART with all its names (ALIAS)



PART section is optional and defines a physical symbol with these COMMON, NORMAL and eventually CONVERT sections.



COMMON section is necessary. It defines TYPE, SIZE, REFERENCE and SHEETPATH section of the symbol.



SHEETPATH not used for now.

SIZE defines the body size.

REFERENCE define the initial reference

TYPE is STANDARD , IEEE , GRID_ARRAY and is followed by the number of part(s) per package

GRID_ARRAY not used.



NORMAL and CONVERT sections are identical. CONVERT defines the converted DeMorgan form of the symbol and is optional.

They give PINS and VECTOR definitions.



PIN defines name, type, orientation and position of a pin. It also defines all the references of this pin for all the devices (There are as many references as part per package defined).

ALIAS Section is optional and define for each name of the symbols attribute (field) list.



ATTRIBUTE has the form:      (ATTRIBUTE 'name' VIS SET (POS x y) )

VIS optionally tells that field is visible

SET optionally tells that the given position is to be taken in account (field position is calculated otherwise)



Schematic ASCII File Description

An ASCII Schematic File has the following structure:



(SCHEMATIC

  (PORTS

    (PORT LEFT OUTPUT (POS 30000 40000 ) 'Port1' )

    ............ (only Ports)

  )

  (SHEET

    (LINE BUS (POS 20000 35000) (POS 20000 40000) )

    .................... (all possible SCHITEMS are listed below)

  )

  (TITLEBLOCK

    ................. (already defined)

  )

  (ERCLIST

    (ERCERR 1 (POS 22000 10000 ) )

    .......................

  )

  (LIB

    ................. (already defined)

  )

  (FONTS

    (FONT 12 350 (13 others numerical values) 'typeface' )

    .......................

  )

)



Ports, Sheet, Title Block, ERC List, Fonts optional

ERCERR (optional) is followed by a value and a position

If the value is more than 10000, it is a warning mark, else it is an error



FONT (optional) is followed by numerical identification used in the TEXT section for texts that use this font and an other number that is the point size of the font (in 1/10 points).

the 13 following values and the Type Face are the Microsoft LOGFONT Structure for fonts



LIB is the active library whose name is '$ACTIVE$'



Items ASCII File Description

The following specifies the ITEMS that may be used for Title Block, PART Vector descriptions and Schematic description, these are:



(LINE busdraw dashed (POS x y) (POS x y) )

busdraw is empty for wire, BUS for Bus or DRAW for line

dashed is empty or DASHED

The first coordinate is the initial position, the second is the last one.



(ARC busdraw dashed (POS x y) (POS x y) (POS x y) orient )

The first coordinate is the initial position, the second is the end position and the last one is the center position.

orient is CW (ClockWise) or CCW (CounterClockWise)



(CIRCLE busdraw dashed filled (POS x y) (POS x y) )

filled may be FILLED or empty

The first coordinate is the initial position, the second is the center one.



(RECT busdraw dashed (POS x y) (POS x y) )

The first coordinate is the top left corner position, the second is the bottom right one.



(FILL (POS x y) ITEMS )

ITEMS is a list of items (except TEXT) defining the edge to fill

The Given Position is not used

The user does not have to close the fill area



(TEXT font (POS x y) (SIZE l h) value flags ttype )

font is the font used for this text, 0 if internal font, 1 if IEEE or >10 if Microsoft Font. In this case, SIZE is not used

flags may be one or more of the following:

MX(mirror x),MY,NO_ROT,ROT_45,ROT_90,ROT_135,ROT_180,

ROT_225,ROT_270,ROT_315 or nothing

type may be empty, LABEL for labels, and TBLOCK for title block control. In this last case, TBLOCK is followed by a name that specifies the control

All the possible control names are given by the "tmpl_idx" grammar rule below

value may be a string (the text itself) or an IEEE identifier

All the possible IEEE name are given by the "valeur" grammar rule below



SCHITEMS ASCII File Description

The following specifies the SCHITEMS that may be used for Schematic description.

A SCHITEM may be an ITEM or the following:



(PORT orient ptype (POS x y) 'name' )

orient is LEFT or RIGHT

ptype is INPUT, OUTPUT, BIDIR or UNSPEC



(NETPROP (POS x y) 'name' (7 integers) )

'name' is not used for now

the 7 integers are respectively

track width, isolation, via size, via drill, slayer, dlayer, net_type

slayer and dlayer are

	0 = any layers

	1 = component

	2 = solder

	3 = above solder

	4 = below comp.

net_ttype is

	0 = tree

	1 = chain



(JUNCTION (POS x y) size shape )

size is LARGE, MEDIUM or SMALL

shape is CIRCULAR, DIAMOND or RECTANGLE



(NOCONNECT (POS x y) )



(POWER 'name' flags shape (POS x y) )

flags are the same as TEXT

shape is CIRCL, BAR, WAVE, ARROW, GND1, GND2, EARTH or BIGARR



(SUBSHEET timestamp (POS x y) (SIZE l h) 'name' 'file' PORTS)

timestamp is an hexadecimal value that begins with 0x

PORTS is a Ports list. Ports positions are relative to the SubSheet



(PARTLIB 'name' timestamp scale pwr flags conv device (POS x y) sheetpath �		fieldlist )

'name' is the part name in the active library

scale is 0.1, 0.2, 0.3, 0.5, 1, 1.5, 2.0 or 3.0

pwr is POWERON or POWEROFF (visible or not)

flags are the same as TEXT

conv is NORMAL_PART or CONVERT_PART

device is the device number (if multiple part per package)

sheetpath is not used for now

fieldlist is a field list (same definition as in LIBRARY for part)

Grammar

integer         is an integer value

hexint          is an hexadecimal value begining with "0x"

float           is a real value

string          is a character string enclosed with single-quote character (')

equal           is the character '='

eol             is the character ')'



All the Uppercase words appear as is in the parsed file



library:	(LIB string prefixes parts eol

prefixes:	/* empty */ | (PFXS prefix_list eol

prefix_list:	/* empty */ | prefix_list prefix

prefix:		(PFX string raccourci eol

raccourci:	/* empty */ | equal string

parts:		/* empty */ | (PARTS parts_list eol

parts_list:	/* empty */ | parts_list lpart

lpart:		(LPART part_def alias_def eol

part_def:	/* empty */ | (PART  blocs_part eol

blocs_part:	/* empty */ | blocs_part common_bloc | blocs_part 					normal_bloc | blocs_part 	convert_bloc

common_bloc:	(COMMON com_blocs eol

com_blocs:	/* empty */ | com_blocs size | com_blocs (REFERENCE 					string eol |  com_blocs (SHEETPATH string eol | com_blocs 				(TYPE type_part integer eol

type_part:	STANDARD | IEEE | GRID_ARRAY

normal_bloc:	(NORMAL pin_vec eol

convert_bloc:	(CONVERT pin_vec eol

pin_vec:	/* empty */ | pin_vec vector | pin_vec pins

vector:		(VECTOR items  eol | (NORMALVECTOROF string eol | 					(CONVERTVECTOROF string eol

pins:		(PINS liste_pin eol 

liste_pin:	/* empty */ | liste_pin une_pin

une_pin:	(PIN string type_shape where_part coord numeros eol

type_shape:	/* empty */ | type_shape DOT | type_shape CLOCK | 					type_shape SHORT | type_shape IN | type_shape OUT | 					type_shape IO | type_shape OC | 	type_shape OE | 						type_shape PWR | type_shape PAS | type_shape HIZ

where_part:	TOP | BOTTOM | LEFT | RIGHT

numeros:	/* empty */ | numeros string

alias_def:	/* empty */ | (ALIAS alias_list eol

alias_list:	/* empty */ | alias_list alias

alias:		(NAME string attribute_list eol



titleblock:	(TITLEBLOCK identify controls tmplvect eol

identify:		(IDENTIFICATION identify_list eol

identify_list:	/* empty */ | identify_list identify

identify:		(SHEETSIZE string eol | (FILENAME string eol | 						(CREATDATE string eol | (MODIFDATE string eol | 					(DOCNUMBER string eol | (REVCODE string eol | 					(NBFOLIO string eol | (FOLIO string eol | (TITLE string eol | 				COMPANYNAME string eol | (COMPANYADDR1 string 				eol | (COMPANYADDR2 string eol | (COMPANYADDR3 string eol | 			(COMPANYADDR4 string eol | 	COMPANYADDR5 string eol | 				(FIRSTNAME string eol | (LASTNAME string eol | (USER1 string eol | 			(USER2 string eol | (USER3 string eol | (USER4 string eol | 				(USER5 string eol | (USER6 string eol | (USER7 string eol | 				(USER8 string eol | (USER9 string eol | (USER10 string eol

controls:	/* empty */ | (CONTROLS control_list eol

control_list:	/* empty */ | control_list control

control:		text

tmplvect:	/* empty */ | (VECTOR  items eol



schema:		(SCHEMATIC ports sheet titleblock ercs library fonts eol

ports:		/* empty */ | (PORTS  ports_list eol

ports_list:	/* empty */ | ports_list port

port:		(PORT  porient ptype coord string eol

porient:		LEFT | RIGHT

ptype:		INPUT | OUTPUT | BIDIR | UNSPEC

ercs:		/* empty */ | (ERCLIST erc_list eol

erc_list:		/* empty */ | erc_list erc

erc:		(ERCERR integer coord eol

fonts:		/* empty */ | (FONTS font_list eol

font_list:	/* empty */ | font_list font

font:		(FONT integer integer integer integer integer integer integer 				integer  integer integer integer integer integer integer integer 				string eol

sheet:		/* empty */ | (SHEET  schitem_list eol

schitem_list:	/* empty */ | schitem_list schitem

schitem:		item | port | partlib | junction | noconnect | power | subsheet | netprop

netprop:		(NETPROP coord string integer integer integer integer integer integer integer 		eol

junction:	(JUNCTION  coord jsize jshape eol

jsize:		LARGE | MEDIUM | SMALL

jshape:		CIRCULAR | DIAMOND | RECTANGLE

noconnect:	(NOCON coord eol

power:		(POWER  string flags pshape coord eol

pshape:		CIRCL | BAR | WAVE | ARROW | GND1 | GND2 | EARTH | BIGARR

subsheet:	(SUBSHEET timestamp coord size string string ports eol

partlib:		(PARTLIB string timestamp float spwr flags conv device coord sheetpath 			attribute_list eol 

conv:		NORMALPART | CONVERTPART

spwr:		POWEROFF | POWERON

device:		DEVICE integer 

sheetpath:	/* empty */ | SHEETPATH string 

timestamp:	hexint



		

coord:		(POS integer integer eol

size:		(SIZE integer integer eol

items:		/* empty */ | items item

item:		line | arc | circle | boite | fill | text

line:		(LINE  flags1 coord coord eol

arc:		(ARC  flags1 coord coord coord sens eol

sens:		CW | CCW

circle:		(CIRCLE  flags1 filled coord coord eol

filled:		/* empty */ | FILLED

boite:		(BOX  flags1 coord coord eol

fill:		(FILL coord items eol

text:		(TEXT  integer coord size valeur flags ttype eol

flags1:		busdraw dash

busdraw:	/* empty */ | BUS | DRAW

dash:		/* empty */ | DASHED

flags:		boxed mirror rotate

boxed:		/* empty */ | BOXED

mirror:		/* empty */ | MX | MY

rotate:		/* empty */ | NO_ROT | ROT_90 | ROT_180 | ROT_270 | ROT_45 | 			ROT_135 | ROT_225 | ROT_315

ttype:         	 /* empty */ | LABEL | TBLOCK tmpl_idx

tmpl_idx:      	SHEETSIZE | FILENAME | CREATDATE | MODIFDATE | 				DOCNUMBER	| REVCODE | NBFOLIO | FOLIO | TITLE | 				COMPANYNAME | COMPANYADDR1 | COMPANYADDR2 | 				COMPANYADDR3 | COMPANYADDR4 | COMPANYADDR5 | 				FIRSTNAME | LASTNAME | USER1 | USER2 | USER3 | USER4 | USER5 | 		USER6 | USER7 | USER8 | USER9 | USER10 

valeur:         	string | ACTIVE_LOW_L | ACTIVE_LOW_R | AMP_L | AMP_R | 			ANALOG | ARROW_R | ARROW_L | BIDIRECTIONAL | DYNAMIC_L | 		DYNAMIC_R |	GENERATOR | HYSTERESIS | NON_LOGIC | OPEN_O | 		OPEN_L | OPEN_H | POSTPONED | PULL_UP | PULL_DOWN | SHIFT_L 		| SHIFT_R | THREE_STATE | NEGATION

attribute_list:	/* empty */ | attribute_list attribute

attribute:	(ATTRIBUTE string attr_vis attr_set flags coord eol

attr_vis:		/* empty */ | VIS

attr_set:		/* empty */ | SET



Example

 (SCHEMATIC

  (PORTS

    (PORT LEFT INPUT (POS 8000 26000 ) 'Port1' )

    (PORT RIGHT OUTPUT (POS 84000 30000 ) 'Port2' )

  )

  (SHEET

    (PARTLIB 'ttl1.clb/74C00' 0x621BDBD8 1.000000 POWERON 

      NO_ROT NORMAL_PART DEVICE 0 (POS 22000 23000 ) 

      (ATTRIBUTE '?' VIS SET (POS 24500 22550 )  )

      (ATTRIBUTE '74C00' VIS SET (POS 24500 28350 )  )

    )

    (PARTLIB 'maxim.clb/DG201A' 0x621F2874 1.000000 POWERON 

      NO_ROT NORMAL_PART DEVICE 0 (POS 54000 19000 ) 

      (ATTRIBUTE '?' VIS SET (POS 58000 18550 )  )

      (ATTRIBUTE 'DG201A' VIS SET (POS 58000 32350 )  )

    )

    (SUBSHEET 0x62203FC0 (POS 33000 45000 ) (SIZE 10000 8000 ) 'theSheet' 'sheet.sch' 

      (PORTS

        (PORT RIGHT BIDIR (POS 10000 6000 ) 'The Net' )

        (PORT LEFT BIDIR (POS 0 3000 ) 'Net1' )

      )

    )

    (LINE BUS (POS 45000 37000 ) (POS 45000 51000 )  )

    (LINE BUS (POS 45000 51000 ) (POS 43000 51000 )  )

    (LINE (POS 30000 25000 ) (POS 40000 25000 )  )

    (LINE (POS 40000 25000 ) (POS 40000 20000 )  )

    (LINE (POS 40000 20000 ) (POS 51000 20000 )  )

    (LINE (POS 51000 21000 ) (POS 40000 21000 )  )

    (JUNCTION (POS 40000 21000 ) SMALL RECTANGLE  )

    (LINE (POS 51000 27000 ) (POS 49000 27000 )  )

    (LINE (POS 49000 27000 ) (POS 49000 42000 )  )

    (LINE (POS 49000 42000 ) (POS 46000 42000 )  )

    (LINE (POS 51000 26000 ) (POS 47000 26000 )  )

    (LINE (POS 47000 26000 ) (POS 47000 39000 )  )

    (LINE (POS 47000 39000 ) (POS 46000 39000 )  )

    (LINE (POS 46000 39000 ) (POS 45000 39000 )  )

    (LINE (POS 46000 42000 ) (POS 45000 42000 )  )

    (NOCON (POS 51000 24000 )  )

    (NOCON (POS 51000 25000 )  )

    (NOCON (POS 65000 25000 )  )

    (NOCON (POS 65000 27000 )  )

    (NOCON (POS 65000 28000 )  )

    (NOCON (POS 65000 30000 )  )

    (NOCON (POS 65000 26000 )  )

    (POWER 'Vcc' NO_ROT CIRCL (POS 71000 19000 )  )

    (TEXT 0 (POS 14000 11000 ) (SIZE 3000 2400 ) 'ESSAI' )

    (TEXT 0 (POS 33000 25000 ) (SIZE 1000 1800 ) 'label' LABEL )

    (NETPROP (POS 46000 20000 ) '' 100 80 250 50 0 0 0 )

    (RECT DRAW DASHED (POS 32000 12000 ) (POS 38000 5000 )  )

    (RECT DRAW DASHED (POS 38000 5000 ) (POS 35000 8000 )  )

    (CIRCLE DRAW DASHED (POS 35000 7000 ) (POS 36000 6000 )  )

    (LINE (POS 8000 26000 ) (POS 19000 26000 )  )

    (LINE (POS 84000 30000 ) (POS 65000 30000 )  )

    (LINE (POS 71000 19000 ) (POS 71000 20000 )  )

    (LINE (POS 71000 20000 ) (POS 65000 20000 )  )

    (TEXT 12 (POS 10000 40000 ) (SIZE 2314 4927 ) 'FONTE TSM (35)' )

    (PARTLIB 'ttl1.clb/74C00' 0x620EAD14 1.000000 POWERON 

      MY ROT_180 NORMAL_PART DEVICE 0 (POS 11000 21000 ) 

      (ATTRIBUTE '?' VIS SET (POS 13500 21450 )  )

      (ATTRIBUTE '74C00' VIS SET (POS 13500 15650 )  )

    )

    (LINE (POS 19000 19000 ) (POS 26000 19000 )  )

    (LINE (POS 26000 19000 ) (POS 26000 21000 )  )

    (LINE (POS 26000 21000 ) (POS 32000 21000 )  )

    (LINE (POS 32000 21000 ) (POS 32000 25000 )  )

    (JUNCTION (POS 32000 25000 ) SMALL RECTANGLE  )

    (NOCON (POS 65000 23000 )  )

    (NOCON (POS 65000 22000 )  )

    (NOCON (POS 65000 21000 )  )

    (NOCON (POS 19000 24000 )  )

    (LINE DRAW (POS 30000 10000 ) (POS 41000 10000 )  )

  )

  (TITLEBLOCK 

    (IDENTIFICATION 

      (SHEETSIZE 'A ' )

      (FILENAME 'total.sch' )

      (CREATDATE '06/22/95' )

      (MODIFDATE '06/22/95' )

      (COMPANYADDR5 'xxxxxxxxxxx' )

    )

    (CONTROLS 

      (TEXT 0 (POS 67000 62000 ) (SIZE 1583 5000 ) 'xxxxxxxxxxx' BOXED TBLOCK COMPANYADDR5 )

    )

    (VECTOR 

      (RECT (POS 46050 46292 ) (POS 95050 70292 )  )

      (CIRCLE (POS 50050 53292 ) (POS 53050 50292 )  )

      (LINE DRAW (POS 61050 48292 ) (POS 72050 48292 )  )

      (LINE DRAW (POS 72050 48292 ) (POS 72050 49292 )  )

      (LINE DRAW DASHED (POS 61050 51292 ) (POS 72050 51292 )  )

      (LINE DRAW DASHED (POS 72050 51292 ) (POS 72050 53292 )  )

      (ARC (POS 76050 54291 ) (POS 81049 58391 ) (POS 81050 53292 ) CCW )

      (ARC (POS 81049 58391 ) (POS 86149 53292 ) (POS 81050 53292 ) CCW )

      (ARC (POS 86149 53292 ) (POS 86049 52292 ) (POS 81050 53292 ) CCW )

      (TEXT 0 (POS 48000 66000 ) (SIZE 3000 3000 ) 'text' BOXED )

      (CIRCLE FILLED (POS 88050 52292 ) (POS 91050 52292 )  )

      (FILL (POS 36050 35292 ) 

        (LINE (POS 87050 58292 ) (POS 87050 65292 )  )

        (LINE (POS 87050 65292 ) (POS 92050 65292 )  )

      )

    )

  )

  (ERCLIST 

    (ERCERR 1 (POS 16600 19000 )  )

    (ERCERR 10002 (POS 22000 23000 )  )

    (ERCERR 10003 (POS 62000 20000 )  )

  )

  (LIB '$ACTIVE$'

    (PFXS

    )

    (PARTS

      (LPART

        (PART 

          (COMMON

            (TYPE STANDARD 1)

            (SIZE 8000 12000 ) 

          )

          (NORMAL

            (PINS

              (PIN 'S1' IO RIGHT (POS 8000 6000 ) 

                '3' 

              )

              (PIN 'IN1' IN LEFT (POS 0 5000 ) 

                '1' 

              )

              (PIN 'S2' IO RIGHT (POS 8000 7000 ) 

                '14' 

              )

              (PIN 'IN2' IN LEFT (POS 0 6000 ) 

                '9' 

              )

              (PIN 'S3' IO RIGHT (POS 8000 8000 ) 

                '11' 

              )

              (PIN 'IN3' IN LEFT (POS 0 7000 ) 

                '9' 

              )

              (PIN 'S4' IO RIGHT (POS 8000 9000 ) 

                '6' 

              )

              (PIN 'IN4' IN LEFT (POS 0 8000 ) 

                '8' 

              )

              (PIN 'V+' PAS LEFT (POS 0 1000 ) 

                '13' 

              )

              (PIN 'V-' PAS LEFT (POS 0 2000 ) 

                '4' 

              )

              (PIN 'GND' PAS RIGHT (POS 8000 11000 ) 

                '5' 

              )

              (PIN 'D1' IO RIGHT (POS 8000 1000 ) 

                '2' 

              )

              (PIN 'D2' IO RIGHT (POS 8000 2000 ) 

                '15' 

              )

              (PIN 'D3' IO RIGHT (POS 8000 3000 ) 

                '10' 

              )

              (PIN 'D4' IO RIGHT (POS 8000 4000 ) 

                '7' 

              )

            )

          )

        )

        (ALIAS

          (NAME 'maxim.clb/DG201A'

          )

        )

      )

      (LPART

        (PART 

          (COMMON

            (TYPE STANDARD 4)

            (SIZE 5000 4000 ) 

          )

          (NORMAL

            (PINS

              (PIN 'A' IN LEFT (POS 0 1000 ) 

                '1' '4' '9' '12' 

              )

              (PIN 'B' IN LEFT (POS 0 3000 ) 

                '2' '5' '10' '13' 

              )

              (PIN 'Y' DOT OUT RIGHT (POS 5000 2000 ) 

                '3' '6' '8' '11' 

              )

              (PIN 'VCC' PWR TOP (POS 0 0 ) 

                '14' '14' '14' '14' 

              )

              (PIN 'GND' PWR BOTTOM (POS 0 4000 ) 

                '7' '7' '7' '7' 

              )

            )

            (VECTOR 

              (LINE (POS 0 0 ) (POS 0 4000 )  )

              (ARC (POS 3000 0 ) (POS 5000 2000 ) (POS 3000 2000 ) CW )

              (ARC (POS 5000 2000 ) (POS 3000 4000 ) (POS 3000 2000 ) CW )

              (LINE (POS 0 0 ) (POS 3000 0 )  )

              (LINE (POS 0 4000 ) (POS 3000 4000 )  )

            )

          )

          (CONVERT

            (PINS

              (PIN 'A' IN LEFT (POS 0 1000 ) 

                '1' '4' '9' '12' 

              )

              (PIN 'B' IN LEFT (POS 0 3000 ) 

                '2' '5' '10' '13' 

              )

              (PIN 'Y' OUT RIGHT (POS 5000 2000 ) 

                '3' '6' '8' '11' 

              )

              (PIN 'VCC' PWR TOP (POS 0 0 ) 

                '14' '14' '14' '14' 

              )

              (PIN 'GND' PWR BOTTOM (POS 0 4000 ) 

                '7' '7' '7' '7' 

              )

            )

            (VECTOR 

              (ARC (POS 0 0 ) (POS 800 2000 ) (POS -2000 2000 ) CW )

              (ARC (POS 800 2000 ) (POS 0 4000 ) (POS -2000 2000 ) CW )

              (CIRCLE (POS 0 3000 ) (POS 300 3000 )  )

              (CIRCLE (POS 0 1000 ) (POS 300 1000 )  )

              (ARC (POS 2100 0 ) (POS 4900 2000 ) (POS 2100 3000 ) CW )

              (ARC (POS 2100 4000 ) (POS 4900 2000 ) (POS 2100 1000 ) CCW )

              (LINE (POS 2100 0 ) (POS 0 0 )  )

              (LINE (POS 2100 4000 ) (POS 0 4000 )  )

            )

          )

        )

        (ALIAS

          (NAME 'ttl1.clb/74C00'

          )

        )

      )

    )

  )

  (FONTS 

    (FONT 12  351 46 0 0 0 700 0 0 0 -1 3 2 1 18 'Roman' )

  )

)



�Appendix D:  Netlist Converters

WinDraft’s netlist converts are command-line programs that must be executed from the command prompt under Windows. Generally, they simply translate a WinBoard netlist (created by WinDraft) into one of the target netlist formats.

As of the time of this writing, the following translators are available:

WB2ACCEL	Translates into the Accel EDA netlist format

WB2PADS	Translates into the PADS-2000 netlist format

WB2PCAD	Translates into the P-Cad netlist format

WB2PROTL	Translates into the Protel netlist format

WB2TANGO	Translates into the Tango netlist format



To use the translators, first create a netlist in the WinBoard format (Utilities | Netlist Output). Then start an MS-DOS prompt to run the program, which is invoked like this:

C:\> programname  sourcenetlist  targetnetlist

Example:

C:\> WB2TANGO wb.net tango.net

The WB2PADS translator is slightly different in that is requires a third parameter, the default net width. This is a unit-less value which is supplied to every net in the netlist which does not have a net width specifically identified for it:

C:\> WB2PADS  sourcenetlist  targetnetlist  defaultwidth

Example:

C:\> WB2PADS wb.net pads2000.net 25



This will create a netlist whose default net width is 25 mils. Nets that have other widths specified on the schematic will use the specific width called for in the schematic instead of this default.



After execution, the netlist translator will report how many nets and modules were found in the netlist. The target filename will now contain the netlist in the desired format.



(�NOTE: The netlist translators do not attempt netname character translation. This means that if the target netlist forbids certain characters from appearing in netnames, you will have to manually correct for this in the schematic. For instance, a few programs do not allow netnames which contain the plus “+” or minus “-” characters. Netnames such as “+5V” will be translated into the target netlist format, but will retain their original name (“+5V”). If your program forbids the use of the “+” character, you should change the netname on the schematic manually. In the example above, you may want to change the netname to “PLUS5V”.��Limitations:

Current versions of the translators are limited to 1000 netnames, each having a maximum of 40 characters.

Availability:

Currently these converters are available by downloading from the Ivex Internet Web site (www.ivex.com) and they are on the WinDraft CD installation.



�Appendix E:  Things to Know

WinDraft Table of Requirements

WinDraft  Item�Requirement to know:�����Net Names�Maximum length is 128 characters.

See WinBoard valid name delimiters.��Net Names to Specctra�Must not include “\”, “X”��Attribute names�Do not use delimiters such as spaces, quotes, double quotes, commas, or parenthesis.��Pin numbers�These are usually numbers, not names. 

They  must match the name/number used for the pad in the PCB module footprint.��Library parts�The part must have a starting reference letter such as “R” ��Module Name: �Use WinBoard or Ivex PCB module footprint name.��Part REF (reference)�Maximum length 8 characters. 

First character is usually a letter (not numeric).��Part VAL (value)�Maximum length 14 characters.

Do not use parenthesis “(“ or “)”  see WinBoard

valid name delimiters.���WinDraft File Extensions

Item:�Extension�Description:��Sheets�.SCH�WinDraft schematic file extension. Default is .SCH ��Compiled Libraries�.CLB�WinDraft binary library file extension. Default is .CLB (Compiled LiBrary).��Source Libraries�.SLB�WinDraft ASCII decompiled library file. Default is .SLB (Source LiBrary).��Log file�.LOG�File extension is .LOG��ASCII sheets�.ASC�File extension for the WinDraft ASCII decompiled sheets. Default is .ASC��Title Block�.TBL�WinDraft title block file extension. Default is .TBL��NetList�.NET�File extension for the netlist files used by the netlist processor. Default is .NET��ERC�.ERC�Text file extension generated by the ERC processor. Default is .ERC��BOM�.BOM�Text file extension generated by the BOM processor. Default is .BOM.��Annotate�.ANN�File extension is .ANN��Back Annotate�.BAN�File extension is .BAN��Library report�.LST�File extension of the ASCII  library reports. Default is .LST�����������xe ".ASC extension"�

�Glossary

Analog�xe "Active Layer" \b�

Circuitry where both voltage and frequency output vary continuously as a function of the input.

Analog Circuit�xe "Analog Circuit" \b�

A circuit made up mostly of discrete components such as resistors, capacitors, and transistors, which produces data represented by a physical variable such as voltage, resistance, or rotation.

Annotation�xe "Adhesive" \b�

Assigning reference designators to components in a schematic.

ASCII�xe "ASCII" \b�

An acronym for "American Standard Code for Information Interchange." A seven-bit code representing alphanumeric and other instructions from a computer keyboard, such as Enter, Backspace, and Delete.

ASIC�xe "ASIC" \b�

An acronym for "Application Specific Integrated Circuit."

Autopan�xe "Autopan" \b�

A mode that automatically moves the viewing window when the pointer comes up against the edge of the screen.

Block�xe "Block" \b�

A particular section of a file that is selected and manipulated as one entity.

BookMark�xe "BookMark" \b�

Book marks are used to mark specific locations on files enabling you to find them easily. You place a bookmark at a particular location on the file. Then when you are editing at a different location and want to move back to the location of the bookmark, you use the BookMark button on the toolbar to pan the screen back to the location of the bookmark.

Bulletin board system (BBS)�xe "Adhesive" \b�

A computer system for sending and receiving bulletins, messages, and files over telephone lines.

Bus�xe "Bus" \b�

A thick track or conductive metal strip on a PC board used to connect a series of smaller tracks together and distribute voltage, grounds, and so on.

Button�xe "Adhesive" \b�

A pushbutton-like image that you click with a mouse to initiate an action.

CAD�xe "CAD" \b�

An acronym for "Computer Aided Design."

CAE�xe "CAE" \b�

An acronym for "Computer Aided Engineering."

CAM�xe "CAM" \b�

An acronym for "Computer Aided Manufacturing."

CMOS�xe "CMOS" \b�

An acronym for "Complementary metal-oxide-semiconductor" integrated circuit.

Component Side�xe "Component Side" \b�

The top layer of the PC board on which most of the components are mounted. WinBoard always uses the highest numbered layer for the component side.

Conductor�xe "Conductor" \b�

One single conductive path.

Digital�xe "Adhesive" \b�

Circuitry where data in the form of digits are produced by binary on and off or positive and negative electronic signals.

DIP�xe "DIP" \b�

A component with two straight rows of pins or leads.

Download�xe "Download" \b�

The process of using a modem over a telephone line to copy a file from the bulletin board system.

Drag�xe "Drag" \b�

When you drag a selected object or block of objects, connectivity is maintained. When you drag a block of objects, the portions of track that are included in the block appear to stretch as you drag the block to its new location. This stretching is referred to as rubberbanding. When you place a block of objects, the track segments are extended to maintain their original connectivity.

Dual In-Line Package �xe "Dual In-Line Package" \b�(DIP�xe "DIP" \b�)

A component with two straight rows of pins or leads.

EDA�xe "EDA" \b�

An acronym for "Electronic Design Automation."

EDIF�xe "EDIF" \b�

An acronym for "Electronic Design Interchange Format." EDIF was established as a standard by ANSI for transferring electronic data, such as netlists and PC board layout files.

Entry Box�xe "Feed-Through Hole" \b�

A box indicating that something (text or numbers) should be entered using the keyboard.

Footprint�xe "Footprint" \b�

An outline of a device. A module consists of one or more pads, an outline, and at least two names. PC boards layouts are composed of groups of modules on a common surface with routes connecting the modules together.

Flat Design�xe "Grip Point" \b�

A schematic structure in which output lines of one sheet connect laterally to input lines of another sheet through graphical objects called module ports.

Hierarchical design

A schematic structure in which sheets are interconnected in a tree-like pattern vertically and laterally.  At least one sheet, the root sheet, contains symbols representing other sheets called subsheets.

HP-GL�xe "HP-GL" \b�

Hewlett-Packard Graphics Language. The plotter protocol used by Hewlett-Packard plotters and printers.

IC�xe "IC" \b�

An acronym for "Integrated Circuit."

Isolation�xe "Routing Guard" \b�

The clearance limits for the track to be routed in PCB layout.  The distance the track should be from other objects such as other tracks, pads, vias or mounting holes.

Layer�xe "Layer" \b�

PC boards are laid out in layers. When a PC board is manufactured, the layers are created by etching portions of the copper coating away from thin sheets of an insulating material, and then sandwiching the layers of insulating material and copper together to make one complete PC board.

Layout�xe "Layout" \b�

A drawing or representation of a PC board, its components, and circuitry.

Library�xe "Library" \b�

A collection of often-used part symbols stored on disk to make the design process faster and easier.

Megabyte�xe "Megabyte" \b�

Just over one million bytes: 220 (1,048,576) bytes.

Micron�xe "Micron" \b�

One millionth of a meter.

Mil�xe "Mil" \b�

One thousandth of an inch.	1 mil = 25.4 microns�	1 mil = .0254 mm

Module�xe "Module" \b�

A footprint of a device for PCB layout. A module consists of one or more pads, an outline, and at least two names. PC board layouts are composed of groups of modules on a common surface with routes connecting the modules together. Also known as a "part decal."

Module Port� XE "Module Port" �

Graphical objects that conduct signals betwwen schematic worksheets.

Net�xe "Net" \b�

A collection of electrical signals that connect together to produce one collective signal.

Netlist�xe "Netlist" \b�

An ASCII file that lists the interconnections of a schematic diagram by names of the signals, modules, and pins connected together on a PCB.  The nodes in a circuit.  A list of all connections for each net on a PC board file.

Net Name�xe "Net Name" \b�

The name used to identify a collection of electrical signals that connect together to produce one collective signal, or net.

Pad�xe "Pad" \b�

A copper-plated area on the front or back of a PC board that is used to make a connection between an electronic part, the PC board, and routes in the PC board.

Part field

A slot for holding text or data to be associated with a part.  Each part must have at least two part fields: one for part value and one for part reference.

PCB�xe "PCB" \b�

An acronym for "Printed Circuit Board."

PC Board�xe "PC Board" \b�

Printed Circuit Board.

Photo plotting�xe "Photo plotting" \b�

The process of producing photographic masters, or negatives, for the production of a printed circuit board.

Pin�xe "Pin" \b�

The metal portion of an electronic component where an electrical connection can be made.

Place�xe "Place" \b�

The process of putting part symbols on a sheet.

Pointer�xe "Pointer" \b�

An arrow or other graphical representation on the screen that moves as you move the mouse.

Prompt�xe "Prompt" \b�

A question or statement from a computer program requesting that you enter specific information or perform a specific task.

Radial Lead�xe "Radial Lead" \b�

A lead or wire extending from the side of a radial component such as a transistor.

Radio button

A small round button.  These are used in lists of mutually exclusive options:  only one button can be active at a time.

Ratsnest�xe "Ratsnest" \b�

A line connecting two or more pads in a PC board file that are part of the same net, but not yet physically connected.

Reference�xe "Reference" \b�

A unique name given to a module on a PC Board file, such as U2, to distinguish each unique module from the other modules.

Root

The worksheet at the top of a hierarchical design.  A design has only one root sheet.

Route�xe "Route" \b�

The process of placing copper traces, known as routes, between common electrical signals (composed of nets) on a PC board. 

Rubberband�xe "Rubberband" \b�

The way connectivity is maintained when you drag a selected object or block of objects. As you drag a block of objects, the ends of wires that are included in the block appear to stretch as you drag the block to its new location. This stretching is referred to as rubberbanding. When you place a block of objects, the wire segments are extended to maintain their original connectivity.

Segment�xe "Segment" \b�

A single portion of a route without vertices.

Schematic

A graphical representation of a circuit using a standard set of electronic symbols.

Sheet net

The point at which a signal from a “higher” sheet to  a module port on a “lower” sheet in a hierarchy.

Silk Screen�xe "Silk Screen" \b�

The text and outlines of modules used on a PC board. Silk screen is made with non-conductive ink and used on PC boards for component placement and identification. 

SMD�xe "SMD" \b�

An acronym for "Surface Mount Device." An SMD is a component that is attached to an outside surface of a PC board as opposed to a component that has leads that fit into through plated holes in the PC board and are soldered into those holes. Through plated holes are holes that are plated with copper and connect to other layers of the PC board.

SMT�xe "SMT" \b�

An acronym for "Surface Mount Technology."

Solder Side�xe "Solder Side" \b�

The outside layer of a PC board which is opposite the component side. WinBoard always uses layer one for the solder side.

Through pad�xe "Through pad" \b�

A hole that goes through a PC board and connects with both the top and bottom layers. The hole itself is coated with copper. The connection with the layers both inside and outside of the board is accomplished with copper on the layers connecting to the through hole.

Time Stamp�xe "Time Stamp" \b�

A unique reference indicating the date and time a module was placed on the schematic.

TTL�xe "Tool File" \b�

An acronym for transistor transistor logic.

Trace�xe "Trace" \b�

A copper track or route in a PC board layout file that is used to route signals from one electrical connection to another.

Track�xe "Track" \b�

A copper trace in a PC board layout file that is used to route signals from one electrical connection to another.

Upload�xe "Upload" \b�

The process of using a modem over a telephone line to copy a file from your computer to the bulletin board system.

Vertex�xe "Vertex" \b�

A point where two segments of a wire or bus join.

Via�xe "Via" \b�

A via is a pathway between two or more layers of a PC board, also known as a feed-through hole, that is coated with copper. The via is used to connect signals (or tracks) between layers of a PC board.

A through via is a via that goes all the way through the PC board and has a copper pad on both the component and solder layers of the board.

A blind via is a via on a multi-layered PC board that only reaches one outside layer of the board and has a copper pad on that outside layer (usually the component side of the board).

A buried via is a via on a multi-layered PC board that does not reach either outside surface of the board.

Worksheet

Worksheets appear on the computer screen as a rectangular area in which you can place parts and draw wires to create a schematic.

Zoom�xe "Zoom" \b�

Changing the view on the screen by making objects display larger or smaller on the screen.
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- key, 31, 32, 38, 39, 50, 59, 145, 155, 161

.

.ASC extension, 81, 192

.BAN extension, 67

.BOM extension, 70

.CLB extension, 78, 79, 126, 146

.ERC extension, 76

.LST extension, 86, 147

.NET extension, 74

.SCH extension, 14

.SLB extension, 146

.TBL extension, 54, 152

+

+ key, 31, 32, 38, 39, 50, 59, 145, 155, 161

4

45, 8, 160

9

90, 8, 160

A

A key, 159

About, 100

Active Layer, 193

Add Arc Mode, 134, 135

Add Circle Mode, 133, 141

Add Vector Mode, 132, 141

addresses, 154

Adhesive, 193, 194, 195

Again command, 159

Again mode, 36

Analog Circuit, 193

Annotate, 60

unconditional, 62

using attributes, 63

without update, 62

ANSI, 131

any angle, 8, 160

Appendix C, 168

arc, 8, 160

placing on library part, 134

Arc Center, 133

Arc End Point, 134

arc quadrant, 134, 135

Archive Library, 78

arrow keys, 155

ASCII, 193

ASCII File Description, 168

ASCII library file, 145

ASIC, 193

Attribute Names, 90

Attributes, Part, 139

Auto Backup, 96

Auto Clean Up, 95

Auto Inc., 46, 47

auto pan, 161

Autopan, 96, 193

B

B key, 155, 159

Back Annotate, 67

Backspace, 134, 135

Backspace key, 161

Backtrack, 161

Backup File, 95

Backup Files, 96

Begin, 159

Best Fit, 160

Bill of Material, 69

Block, 193

Block Copy, 101

Block Cut, 101

Block part, 131

Block Paste, 101

BMP graphic, 59

Body, 129

BOM, 69

attribute fields, 72

descriptive information, 72

using Merge File, 70

Book Mark, 57, 144, 155

change name, 58

changing name in title block, 156

changing the name, 144

clearing, 145

clearing in title block, 156

jump to, 58, 144

jumping to in title block, 156

placing, 57

placing in title block, 156

setting on library part, 144

BookMark, 194

Bookmark, jump to, 22

Box, 58

Box text, 159

Bus, 37, 101, 194

Bus Drawing Mode, 38

C

CAD, 194

CAE, 194

CAM, 194

Center, 160

Center Screen, 102

Circle, 58, 101, 133

placing on library part, 133

resizing in library part, 133

Cleanup, 68

Clear Before Output, 97

CMOS, 194

Comments, 46

Compile Library, 145, 146

Component Side, 194

Conductor, 194

Connections across sheet boundries, 43

Controls, 154, 163

placing on a title block, 154

Convert Form, 130

converted form, 143

Converted Pins, 148

Converters, 79

Coordinates, jump to, 22

Copy, 20, 106

Copying an object, 20

creation date, 154

Ctrl key, 20, 161

Cursor toggle, 159

Cut, 20, 106

Cut, Copy and Paste Objects, 112

D

D key, 159

De Morgan equivalent, 130

Decision Matrix, 76

Decompile Library, 145, 146

Decompile Sheet, 81

DEL Key, 20

Delete an object, 20

Descend Hierarchy, 62, 67, 70, 74, 76, 78

Descend into Hierarchy, 18

Device per Pack, 130

DIP, 195

Displacement, 103

documentation number, 154

Down arrow key, 161

Download, 195

Drag, 195

Drawing, 87

Dual In-Line Package, 195

E

EDA, 195

EDIF, 195

Edit menu, 19, 128, 153, 156

Editing Features, 105

Editing Objects, 111

Editing Quick Reference, 116

Editing Wires, Lines and Buses, 109

electrical connections, 37

Electrical Rules Check, 75

End, 159

End key, 160

Environment, 84

ERC, 75

Show ERC Warnings, 95

ERC Run, 101

Exit, 18, 128, 153

F

F1 key, 160

F2 key, 160

F3 key, 160

F4 key, 160

F5 key, 160

F9 key, 160

Feed-Through Hole, 195

Field, 139

Fields Combine, 63

File Locations, 84

Library Path, 84

Project directories, 84

File menu, 13, 151

file name limitations, 14, 126, 152

File Open, 101

File Save, 101

Filled Circle, 140

placing, 141

Filled Polygon, 141

placing, 141

Filter entry box, 127

Find, 21

Find Text, 101

flat design, 46

Flat Designs, 10

Floating Icon Menu, 101

Font, 48

Footprint, 195

footprints, 139

Free, 103

G

Geometry, 32, 38, 59, 101, 132, 141, 145, 156

setting in title block, 156

Geometry toggle, 159

Get Part dialog box, 127

Get Vector Def., 142

GND button, 41

Graphic part, 131

Grid, 88, 103

Grip Point, 196

Ground, 102

H

Help, 102

Help menu, 99

hierarchy, 11, 51, 121

Home key, 160

HP-GL, 196

I

I key, 159

IC, 196

IEEE, 131, 143

IEEE symbols

editing, 144

placing on library part, 143

sizes, 144

Image, 59

import graphical shapes, 142

Installation, 1

Isolation, 56

J

J key, 39, 159

Jump, 22

Junction, 38, 102, 159

Junctions, 8, 89, 160

K

Keep Device, 62

Keyboard Commands, 8, 159

L

label increment, 47

label text, 122

Layer, 196

Layout, 196

Left arrow key, 161

Library, 196

Library Editor, 125

Library, loading, 126

Line, 58, 102, 132

editing in library part, 132

placing on library part, 132

link statement, 46

List Library, 145, 147

Load title block file, 152

M

M key, 159

Megabyte, 196

Micron, 197

Mil, 197

mirror, 161

Mirroring objects, 108, 109

Misc. Preferences, 95

modification date, 154

Module, 197

module names, 139

Module Port, 8, 102, 122, 160, 197

Most Recently Used Files, 19

Most Recently Used Files List, 153

Moving objects, 108, 109

Multi Wires, 89

mutli-wires, 31

N

N key, 159

Name, port, 44

Names, 138

negation, 136, 149

Net, 41, 197

Net Name, 197

Net Properties, 56

Net type, 8, 56, 160

Netlist, 197

Netlist format, 74

Netlist Formatter, 74

Netlist Output, 73

New library file, 14

New schematic file, 13

New title block file, 14

Next, 22

No Connect, 53, 102

No Connect, placing, 53

normal form, 143

Normal Vectors, 142

Num Lock, 162

number of folio, 154

numeric key pad, 162

O

Object Properties, 94

color, 94

visible, 94

on-line Help, 160

Open Subsheet, 16

ORCAD Converter, 79

organization name, 154

Orientation, port, 44

Orientation, power, 41

origin, 22

Origin, jump to, 22

overlapping part pins, 68

P

packages, 139

Pad, 197

Part, 23, 102

DeMorgan, 26

editing, 28

Find Part, 27

Mirror, 25

palette, 28

Rotate, 25

Scale, 25

Search, 27

Visable Power, 26

Wildcards, 27

Part command, 126

Part Info, 146, 149

device dimensions, 150

devices per package, 150

number of names attached, 150

number of vector definitions attached, 150

part name, 150

Part Palette, 23

part specifications, 149

Part type, 8, 160

Parts list box, 127

Parts Palette

display, 98

Parts, loading, 126

Paste, 21

Pasting an object, 21

PC Board, 198

PCB, 198

Photo plotting, 198

Pin, 103, 135, 198

name, 149

ref, 148

shape, 149

short, 149

type, 149

pin capacity, 1. See Statistics

Pin Count, 103

Pin shape

short, 137

Pin type

3 states, 137

bidir, 137

in, 137

open collector, 137

open emitter, 137

out, 137

passive, 137

power, 137

Pins

adding on a library part, 136

modifying on library part, 138

placing on library part, 138

Place, 198

Place Junction Mode, 39

Place menu, 23, 129, 153

Placing a geometric symbol, 58

Placing parts, 23

Pointer, 198

pointing hand, 106

Port, 43

Power, 40, 102, 124

Preferences, 96

Previous, 22

Print, 16, 102, 128, 152

printer, Windows default, 128

Printing, scale, 17

Project, 46

Prompt, 198

Properties, 150

Properties menu, 82

R

Radial Lead, 198

Ratsnest, 198

Rectangle, 102

Reference, 199

reference designator, 139

Reference Prefix, 139

Refresh Screen, 102

Registration, 1, 100

Repeat, 50, 102

Repeat Increments, 89

Repeat mode, 36

Report Pinout, 145, 148

resizing an existing body, 131

revision code, 154

Right arrow key, 161

root sheet, 46, 121

rotate, 161

Rotating objects, 108

Route, 199

Routing Guard, 196

Rubberband, 199

S

S key, 159

Save, 16, 128, 152

Save As, 16, 128, 152

Scale and Grid List Boxes, 103

Scale settings, 161

Scan button, 127

schematic filename, 154

Screen center, 160

Screen refresh, 160

Segment, 199

Selecting Objects, 105

Selection Filter, 91

Setup, 102

Sheet, 102

Sheet Net, 41

Sheet Size, 96, 154

Sheets Symbols, 51

ShortCuts, 99

Show All Keys, 99

Show Icons Menu, 98

Show Items Filled, 96

Show Selected States, 99

Show Toolbar, 97

Silk Screen, 199

Small, 103

SMD, 200

SMT, 200

Snap to pin, 159

Solder Side, 200

Statistics, 77

pin count, 78

Style, 60, 145, 156

setting in title block, 60, 156

Style, port, 44

Styles, net, 42

Styles, power, 40

Subsheet, placing, 51

Subsheets, 122

T

Target Mode, 33

technical support, 1

Text, 45, 102, 135

Auto scale, 47

auto-scaling in title block, 155

Boxed, 47, 159

boxing in title block, 155

color, 93

Comment, 46

Label, 47

mirroring in title block, 154

Orientation, 47

Repeat, 50

setting orientation in title block, 154

setting size in title block, 154

settings, 47

True Type Fonts, 48

Type, 46

visible, 93

Text Properties, 92

Through pad, 200

Time Stamp, 200

Tips, 100

show tips, 100

Title Block, 54

addresses, 154

auto-scaling text, 155

changing name of book mark, 156

clearing bookmarks, 156

Controls, 163

creating, 151

creation date, 154

documentation number, 154

editing, 54

Import/Export Data Format, 164

import/export file delimiter, 165

import/export file field separator, 165

jumping to bookmark, 156

Load ASCII text, 55

loading, 152

mirroring text, 154

modification date, 154

number of folio, 154

organization name, 154

placing, 54

placing book mark, 156

placing boxed text in, 155

placing controls, 154

printing, 152

revision code, 154

Save As, 152

Save ASCII text, 55

saving, 152

schematic filename, 154

setting geometry, 156

setting orientation of text, 154

setting text sizes, 154

setting the style, 60, 156

sheet size, 154

user extension, 154

Title Block Control Items, 163

Title Block Editor, 151

Tool File, 200

Toolbars menu, 101

Tools menu, 60

Trace, 200

Track, 200

Track Width, 56

Transf. on Convert, 143

Transf. on Normal, 143

True Type Fonts, 48

Tutorial, 1

U

U key, 159

Undo, 19, 102, 115

undo a segment, 161

Unselect Target Mode, 159

Up arrow key, 161

Upload, 200

user extension, 154

Using Schematic Editor, 13

Utilities, 145

Utilities menu, 68

V

Vertex, 201

Vertex, adding and dragging, 110

Via, 201

Via Size, 56

View. See Zoom

Visable Power, 26

Visible at Scale, 86

W

wildcards, 27

Window menu, 98

WINDRAFT.LOG, 97

Wire, 31, 102

Again mode, 36

electrical connections, 37

geometry, 32

grid, 31

Hotkeys, 31

Multi-wire, 31

Repeat mode, 36

Target Mode, 33

Wiring Mode, 32

X

X key, 32, 38, 39, 42, 44, 50, 59, 132, 141, 145, 156, 160

X,Y coordinate display, 101

Z

Z key, 160

Zoom, 8, 201

zoom scale, 103

Zoom Cut Factor, 87

Zoom Fit, 102

Zoom in, 8, 102, 160

Zoom out, 102, 160

zoom tools, 102

Zoom Window, 102
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Select Attribute to edit from the pull down list: Part Ref, Part Value, Module Name, etc.



Enter the Name of the Module for PCB layout in the Value text entry box.
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